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Safety
Introduction
This section provides safety information and instructions for the hardware and 
accessories of the system. It includes the following topics:

• Safety Terminology on page 3
• Chemical and Biological Safety on page 5
• Electrical Safety on page 5
• Moving Parts on page 6
• Cleaning on page 6
• Disposal and Recycling on page 6
• Maintenance on page 7
• Warnings and Cautions Found in this User Guide on page 7

Safety Terminology
The symbols displayed below and on the instrument should remind you to read 
and understand all safety instructions before attempting installation, 
operation, maintenance, or repair to this instrument.

CAUTION! Paragraphs marked by “CAUTION” indicate that there is a potential 
danger of equipment damage.

CAUTION! Paragraphs marked by “CAUTION” contain information about a 
possible software program failure, draw attention to a specific software setting 
or point out that a loss of data may occur if information stated within the 
paragraph is not adhered to or if procedures are executed incorrectly.

The symbols displayed below and on the instrument are reminders that all 
safety instructions should be read and understood before installation, 
operation, maintenance, or repair to this instrument is attempted.

WARNING! Paragraphs marked by “WARNING” alert you of a 
potential hazard to your personal safety if you do not adhere to the 
information stated within the paragraph.

Note: Paragraphs marked by “Note” contain supplemental or explanatory 
information concerning the current topic or procedural step.

WARNING! When present, this symbol indicates that a potential 
hazard to your personal safety exists if information stated within the 
“WARNING” paragraph is not adhered to or procedures are executed 
incorrectly.
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Safety
WARNING! This icon accompanies text and/or other symbols dealing 
with potential damage to equipment. When present, it indicates that 
there is a potential danger of equipment damage, software program 
failure, or that a loss of data may occur if information stated within 
the “CAUTION” paragraph is not adhered to or procedures are 
executed incorrectly.

WARNING! HIGH VOLTAGE Paragraphs marked by this symbol 
indicate that a potential hazard to your personal safety exists from a 
high voltage source.

WARNING! BIOHAZARD Paragraphs marked by this symbol indicate 
that a potential hazard to your personal safety exists from a 
biological source.

WARNING! LASER LIGHT Paragraphs marked by this symbol indicate 
that a potential hazard to your personal safety exists from a laser 
source.

WARNING! SHARP OBJECTS Paragraphs marked by this symbol 
indicate that a potential hazard to your personal safety exists from 
unblunted corners or other appendages on the outside or inside of 
the equipment.

WARNING! HOT SURFACE Paragraphs marked by this symbol indicate 
that a potential hazard to your personal safety exists from heated 
surfaces or other appendages on the outside or inside of the 
equipment.

WARNING! PROTECTIVE EARTH OR GROUND TERMINAL This symbol 
identifies the location of the protective earth or ground terminal lug 
on the equipment.

OFF POSITION OF PRINCIPAL POWER SWITCH This symbol graphically represents the 
equipment main power push-button switch when it is in the off position.

ON POSITION OF PRINCIPAL POWER SWITCH This symbol graphically represents the 
equipment main power push-button switch when it is in the on position.
4 5008530 A 



Multi-Mode Analysis Software User Guide
Chemical and Biological Safety
Normal operation of the FilterMax 3 and FilterMax 5 Multi-Mode Microplate 
Readers and the SpectraMax Paradigm Multi-Mode Detection Platform may 
involve the use of materials that are toxic, flammable, or otherwise biologically 
harmful. When using such materials, observe the following precautions:

• Handle infectious samples according to good laboratory procedures and 
methods to prevent the spread of disease.

• Observe all cautionary information printed on the original solutions 
containers prior to their use.

• Dispose of all waste solutions according to your facility's waste disposal 
procedures.

• Operate the FilterMax 3 and FilterMax 5 Multi-Mode Microplate Reader, 
and the SpectraMax Paradigm Multi-Mode Detection Platform in 
accordance with the instructions outlined in this user guide, and take all 
the necessary precautions when using pathological, toxic, or radioactive 
materials.

• Splashing of liquids may occur; therefore, take appropriate safety 
precautions, such as using safety glasses and wearing protective 
clothing, when working with potentially hazardous liquids.

• Use an appropriately contained environment when using hazardous 
materials.

• Observe the appropriate cautionary procedures as defined by your 
safety officer when using flammable solvents in or near a powered-up 
instrument.

• Observe the appropriate cautionary procedures as defined by your 
safety officer when using toxic, pathological, or radioactive materials.

Electrical Safety
To prevent electrically related injuries and property damage, properly inspect 
all electrical equipment prior to use and immediately report any electrical 
deficiencies. Contact a Molecular Devices Service Engineer for any servicing of 
equipment requiring the removal of covers or panels.
To reduce risk of electrical shock, all devices employ a three-wire electrical 
cable and plug to connect the equipment to earth ground.

• Ensure that the wall outlet receptacle is properly wired and earth 
grounded.

• DO NOT use a three-to-two wire plug adapter.
• DO NOT use a two-wire extension cord or a two-wire multiple-outlet 

power strip.
• Disconnect power to the system before performing maintenance.
• DO NOT remove any panels; panels should be removed only by 

qualified service personnel.

Note: Observe all warnings and cautions listed for any external devices 
attached or used during operation of the FilterMax 3 and FilterMax 5 Multi-
Mode Microplate Readers and the SpectraMax Paradigm Multi-Mode Detection 
Platform. Refer to applicable external device user guides for operating 
procedures of that device.
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Moving Parts
To avoid injury due to moving parts, observe the following:

• Never attempt to exchange labware, reagents, or tools while the 
instrument is operating.

• Never attempt to physically restrict any of the moving components of 
the Multi-Mode Analysis Software.

• Keep the Multi-Mode Analysis Software work area clear to prevent 
obstruction of the movement.

Cleaning
Observe the cleaning procedures outlined in this user guide for the Multi-Mode 
Analysis Software. Prior to cleaning equipment that has been exposed to 
hazardous material:

• Appropriate Chemical and Biological Safety personnel should be 
contacted.

• The Chemical and Biological Safety information contained in this user 
guide should be reviewed.

Disposal and Recycling

The symbol of a crossed-out wheeled bin on the product is required in 
accordance with the Waste Electrical and Electronic Equipment (WEEE) 
Directive of the European Union. The presence of this marking on the product 
indicates that the device:

• Was put on the European Market after August 13, 2005.
• Is not to be disposed via the municipal waste collection system of any 

member state of the European Union.
For products under the requirement of WEEE directive, please contact your 
dealer or local Molecular Devices office for the proper decontamination 
information and take-back program, which will facilitate the proper collection, 
treatment, recovery, recycling, and safe disposal of the device.

WARNING! This symbol indicates the potential of an electrical shock 
hazard existing from a high voltage source and that all safety 
instructions should be read and understood before proceeding with 
the installation, maintenance, and servicing of all modules.

Do not remove system covers. To avoid electrical shock, use supplied 
power cords only and connect to properly grounded (three-holed) 
wall outlets. Use only multiplug power strips provided by the 
manufacturer.

WARNING! It is important to understand and follow all laws 
regarding the safe and proper disposal of electrical instrumentation.
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Maintenance
Perform only the maintenance described in this user guide. Maintenance other 
than that specified in this user guide should be performed only by service 
engineers.

Warnings and Cautions Found in this User Guide
Please read and observe all cautions and instructions. Remember, the most 
important key to safety is to operate the FilterMax 3 and FilterMax 5 
Multi-Mode Microplate Reader and the SpectraMax Paradigm Multi-Mode 
Detection Platform with care.
The WARNINGs and CAUTIONs found within this document are listed below.

CAUTION! Settings that vary from the recommended Power Options Properties 
may introduce a risk of data transfer interruption and a loss of data.

CAUTION! In any situation (such as when operating the instrument with 
integrated systems) where automatic loading and ejection of the cartridge 
carrier may cause a potential equipment collision, we recommend disabling the 
Automatically load/eject cartridge carrier when running the Validation Plate 
feature, and to load and eject the cartridge carrier manually.

CAUTION! Shake low density plates, such as 6-well or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause liquid in 
wells to spill.

CAUTION! The plate height configured must not be less than that of the actual 
plate. Doing so may cause the FilterMax Multi-Mode Microplate Readers to 
collide with the plate during a Read Height Optimization. The SpectraMax 
Paradigm Multi-Mode Detection Platform has an auto-detection to prevent 
collision, if an incorrect plate height is entered for the SpectraMax Paradigm 
Multi-Mode Detection Platform an error message appears while running 
protocols using the defined labware.

CAUTION! Luminescence light levels visible to the human eye may cause 
damage to the detection system.

WARNING! It is your responsibility to decontaminate components of 
the Multi-Mode Analysis Software before requesting service by a 
Molecular Devices Service Engineer or returning parts to Molecular 
Devices for repair. Molecular Devices will NOT accept any items which 
have not been decontaminated where it is appropriate to do so. If any 
parts are retuned, they must be enclosed in a sealed bag stating that 
the contents are safe to handle and are not contaminated.

WARNING! If the equipment is used in a manner not specified by 
Molecular Devices, the protection provided by the equipment may be 
impaired.
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1
Overview
Introduction
Multi-Mode Analysis Software configures and controls all measurement 
protocols and actions performed by the FilterMax Multi-Mode Microplate 
Readers and the SpectraMax Paradigm Multi-Mode Detection Platform. The 
software supports detection for absorbance, glow luminescence, fluorescence 
intensity, fluorescence polarization, and time-resolved fluorescence (TRF) 
measurements including HTRF. The measurement methods available to users 
depend on the capabilities of the instrument being controlled. Measurement 
results can be viewed in the Multi-Mode Analysis Software or easily exported 
to compatible applications such as Microsoft Excel.
Optional modules such as GxP Permissions lend support for electronic 
signature regulations such as 21 CFR Part 11.
This user guide covers the functionality supplied by the Multi-Mode Analysis 
Software and the Multi-Mode Analysis Software with GxP Permissions modules, 
including:

• Configuring and Controlling Instruments on page 51 
• Setting Up and Using GxP Permissions on page 73 
• Creating and Editing Detection Methods on page 87 
• Creating and Editing Labware on page 127 
• Creating and Running Protocols on page 145 
• Viewing Measurement Results on page 215 

Where to Begin
To correctly use the software it is important that initial configuration is done in 
a specific order.

1. Installing Multi-Mode Analysis Software on page 17.
2. Configuring Multi-Mode Analysis Software on page 32.
3. Configuring and Controlling Instruments on page 51.
4. Setting Up and Using GxP Permissions on page 73 (optional module).
5. Creating Detection Methods (FilterMax Multi-Mode Microplate Readers) 

on page 88 or Creating Detection Methods (SpectraMax Paradigm Multi-
Mode Detection Platform) on page 99. The measurement configuration 
parameters are stored in detection methods.

6. Creating and Editing Labware on page 127. Labware types must be 
configured and ready for use in protocols.

7. Creating Protocols on page 146 using the detection methods created in 
Step 5. A protocol stores all parameters required to perform a 
measurement, including technique types, detection methods, labware 
types, and preparation methods, such as shaking.

8. Running Protocols on page 197.
9. Viewing Measurement Results on page 215.
10. When required, create additional detection methods, labware, and 

protocols.
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2
Installing, Using, and Configuring 
the Software
Overview
This section introduces users to the software and gives the instructions for:

• Installing Multi-Mode Analysis Software on page 17
• Using Multi-Mode Analysis Software on page 24
• Configuring Multi-Mode Analysis Software on page 32
• Deleting and Restoring Items on page 48

Installing Multi-Mode Analysis Software
The Multi-Mode Analysis Software installer provides the ability to install the 
software onto a new system or update from a previous version of the software.
Installing the software requires:

• Preparing to Install Multi-Mode Analysis Software on page 17
• Meeting System Requirements on page 18
• Installing Multi-Mode Analysis Software on Windows XP on page 19

Preparing to Install Multi-Mode Analysis Software
Before installing Multi-Mode Analysis Software, confirm that the host computer 
meets the minimum system requirements listed in Meeting System 
Requirements on page 18.
If upgrading from previous versions of Multi-Mode Analysis Software, see 
Upgrading From Previous Versions of the Software on page 19 before 
installing. The information in this section helps to ensure the update is 
successful.
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Meeting System Requirements

To install and use the software successfully, the host computer must meet the 
minimum system requirements listed in Table 2-1. Where relevant, Table 2-1 
also lists recommended specifications.

Table2-1 Host Computer System Requirements

Component Minimum System Requirements

CPU Pentium III 600 Mhz

RAM 256 MB minimum
512 MB or more recommended

Hard Drive 600 MB free space

CD-ROM Drive 4X

Monitor 800x600 resolution

Keyboard 101 key

Mouse IBM compatible

Serial Port
USB Port

1 free serial port or 1 free USB port

Operating System Microsoft Windows XP (Service Pack 2)

Operating System 
Language

English (U.S.)

Database Microsoft SQL Server 2000 (Desktop Edition included on the 
installation CD)

Note: SQL Server 2000 Desktop Edition has a 2GB 
storage limit. Contact Molecular Devices Technical 
Support if this limit is reached.

Web Browser Microsoft Internet Explorer 6.0 or later (included on the 
installation CD)

Programs Microsoft Excel 2003 recommended

Power Options 
Properties

Turn off hard disks: Never
System standby: Never
System hibernates: Never

Note: System power options properties are set in Control 
Panel > Power Options.

CAUTION! Settings that vary from the recommended 
Power Options Properties can introduce a risk of data 
transfer interruption and a loss of data.
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Upgrading From Previous Versions of the Software

If upgrading from a previous Multi-Mode Analysis Software version, follow the 
steps in this section to make sure that the update is successful.
To update the software from a previous version:

1. Launch Multi-Mode Analysis Software and open Instrument Settings.
2. For FilterMax instruments: If the filter slides have been customized by 

installing new filters or moving existing filters to other slots, these 
settings need to be saved and later imported after software installation. 
In Instrument Settings, select the Filter Slides tab and select Export 
Slides before proceeding with installation. See Exporting and Importing 
All Filter Slide Configurations on page 61.

3. Install the software by following the steps in Installing Multi-Mode 
Analysis Software on page 17. 

4. When the installation is complete, launch Multi-Mode Analysis Software. 
The software automatically checks if any default detection methods, 
labware types, and protocols provided with the install have the same 
name as those imported to the database from the previous versions. 

Installing Multi-Mode Analysis Software on Windows XP
On a Windows XP system, the Multi-Mode Analysis Software installer uses a 
simple interface to guide the installation using the two CDs provided with your 
purchase. Installation proceeds in two phases:

• Installing Required Components and Multi-Mode Analysis Software on 
page 20

• Installing the Required Multi-Mode System Updater on page 22

Note: Installing a newer version of Multi-Mode Analysis Software 
replaces the previous version.

Note: If a prompt appears asking whether a detection method, labware 
type, or protocol should be overwritten, click Yes to overwrite the 
existing item or click No to keep the existing item in the database.

Note: SpectraMax Paradigm Multi-Mode Detection Platform: For each 
new detected cartridge, example Protocols and Methods are imported 
automatically. The automatic importing function may be disabled. To do 
this, go to the Multi-Mode Analysis Software main window. Then from 
the File menu click Settings > Properties > Allow Protocol Auto-Import.
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Installing Required Components and 
Multi-Mode Analysis Software

To install the components and software:
1. Exit all Windows programs before starting installation.
2. Ensure the current user account has Administrator privileges. Accounts 

with Standard or Restricted access are not allowed to run the setup 
program. Contact the site system administrator for more information 
about account privileges.

3. Insert the installation CD 1 into the CD drive and browse to the 
contents of the CD.

4. Double-click on Installer.exe. The Multi-Mode Analysis Software Installer 
appears Figure 2-1. All components required to successfully install the 
software are listed along with the current status of each component: 
 A check icon indicates the correct version of the component is 

already installed on the system.
 A caution icon indicates that an older version of the component is 

installed and must be updated before the software can be installed.
 An X icon indicates that the component must be installed before the 

Multi-Mode Analysis Software can be installed.

Figure 2-1 Starting the Installation

5. Select Update or Install for the first component indicated. The 
components are installed one at a time and must be installed in the 
order listed.

6. Follow the steps in the component installer until the component 
installation is complete. Restart the system as required. For example, a 
restart might required after the Microsoft SQL Server installation. 

Note: If a component installation requires restarting the system, 
restart before installing the next component listed. After the system 
restarts, browse to the contents of the installer CD and launch the 
installer again to continue installing components.
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7. Repeat Step 5 and Step 6 for each component required. 
When all components are installed correctly, the Install Multi-Mode 
Software button launches the Multi-Mode Analysis Software System 
Updater.

8. Click Install Multi-Mode Software to launch the Multi-Mode System 
Updater. 

Figure 2-2 System Updater Window

9. Follow the steps as described in Installing the Required Multi-Mode 
System Updater on page 22.

10. In the Multi-Mode Analysis Software Installer, click Finish.

CAUTION! Settings that vary from the recommended Power Options Properties 
may introduce a risk of data transfer interruption and a loss of data.

11. Open the Power Options Properties by selecting Start > Control Panel > 
Power Options.

12. Set Turn off Hard Disks to Never.
13. Set System standby to Never.
14. Set System hibernates to Never.

The software is ready for use.

Note: Some components can give the option to Repair or Remove the 
component. First click Remove to remove the component and then click 
Install to reinstall the component.
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Installing the Required Multi-Mode System Updater

Upon installing, reinstalling, or updating Multi-Mode Analysis Software from a 
previous version, running the System Updater will provide vital updates to 
firmware, detection cartridge files and other components specific to your 
instrument’s needs.

To run the System Updater:
1. If installing the Multi-Mode System Updater as a part of the Multi-Mode 

Analysis Software installation, remove installation CD 1 from the CD 
drive and insert CD 2 into the CD drive.
If installing the System Updater separately, exit all Windows programs 
before starting system update as shown in Installing the Required 
Multi-Mode System Updater on page 22. Insert CD 2 into the CD drive 
and browse to the contents of the CD. Double click installer.exe
The System Updater window appears Figure2.3. 

Figure 2-3 System Updater Window

Note: If new detection platform products are purchased (such as SpectraMax 
Paradigm detection cartridges), or you intend to update your Multi-Mode 
Analysis Software installation, it is recommended that you use the Multi-Mode 
System Updater CD Package to consistently update your system.

Note: SpectraMax Paradigm Multi-Mode Detection Platform: Ensure the 
instrument is turned on, not in the standby mode, and all your detection 
cartridges are installed.
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2. Click the Install or Update links to add components as required by the 
System Updater. 

3. When finished, the System updater window appears Figure 2-4. 

Figure 2-4 System Updater Window Showing Fully Updated Controller 
PC System

4. Upon completion of the entire update process, click Finish. The Multi-
Mode Software Installer window appears.

5. Click Finish. 

The software is ready for use.

Note: Depending on the host system’s firewall configuration, a 
Windows firewall message might request that you unblock Multi-Mode 
System Updater’s executable file, SystemUpdater.exe. If this message 
does show, allow unblocking.

Note: During the install/update process, the instrument might initialize 
and produce sounds while the System Updater runs.

Note: If the System Updater ran as a part of the Multi-Mode Analysis 
Software installation, click Finish to close that installation also.
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Repairing or Removing the Multi-Mode Analysis 
Software Installation
In the event required components are missing or damaged, or if the software 
does not open or does not run correctly, repair should be made by uninstalling 
the Multi-Mode Analysis Software from the controlling PC system.
To repair or remove the software:

1. Exit all open Windows programs.
2. Make sure the current user account has Administrator privileges. 

Accounts with Standard or Restricted access are not permitted to 
modify or remove software. Contact the site system administrator for 
more information about account privileges.

3. If repairing the installation, insert the Multi-Mode Analysis Software 
installation CD into the CD-ROM drive.

4. From the Start menu, click Settings > Control Panel. The Control Panel 
appears.

5. In Control Panel, double-click Add or Remove Programs. The Windows 
Add or Remove Programs dialog appears.

6. In the Add or Remove Programs dialog, select Multi-Mode Analysis 
Software. Repair and removal options for Multi-Mode Analysis Software 
appear.

7. Click Remove and follow the instructions until the removal process is 
completed. Proceed to step 8. 

8. When finished, reinstall Multi-Mode Analysis Software from the original 
installation CD.

Using Multi-Mode Analysis Software
The Multi-Mode Analysis Software uses a simple interface that divides the main 
window into four basic sections: navigation pane, tool bar, selection and 
configuration pane, and preview pane (Figure2.5). The interface provides 
access to the selection lists that enables system functionality and 
comprehensive, context-sensitive online help.
This section covers:

• Launching the Software on page 25
• Using the Software Interface on page 26
• Accessing Online Help on page 31

Note: When removing the software, only files installed during the initial 
installation are removed. The software database and files created after 
the installation, such as exported measurement results, remain.

Note: To correctly use the software it is important that the initial configuration 
is done in a particular order. Please see Where to Begin regarding important 
setup information.
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Launching the Software
To launch Multi-Mode Analysis Software:

• From the Windows Start menu, click Programs > Molecular Devices > 
Multi-Mode Analysis Software> Multi-Mode Analysis Software. The Multi-
Mode Analysis Software window appears (Figure 2-5).

Figure 2-5 Multi-Mode Analysis Software Main Window

Note: If the Multi-Mode Analysis Software is not found in the Start 
menu, the software may have been installed for a single user account 
on the system instead of all accounts. Check with the site system 
administrator or login to the user account with permission to access 
the software. See Installing Multi-Mode Analysis Software on Windows 
XP on page 19 for more information about installing the software for a 
single or multiple user accounts.

Note: The first time the software is launched, depending on the host 
system’s firewall configuration, a Windows firewall message might 
request that you unblock Multi-Mode Analysis Software’s executable 
file, Apex.exe. If this message does show, allow unblocking.
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Using the Software Interface
Multi-Mode Analysis Software uses a simple interface that is divided into four 
basic sections:

• Navigation Pane (See About the Navigation Pane on page 26)
• Tool Bar (See About the Tool Bar on page 27)
• Selection and Configuration Pane (See About the Selection and 

Configuration Pane on page 31)
• Preview Pane (See About the Preview Pane on page 31)

The navigation pane provides access to the selection lists that provide the 
majority of the functionality built into the software. Items selected in the 
selection list determine the options available in the tool bar and configuration 
pane.

About the Navigation Pane

The navigation pane is the narrow pane on the left of the Multi-Mode Analysis 
Software window (Figure 2-5). Use the navigation pane to switch between 
selection lists.

Table2-2 The Navigation Pane

Name Button Description

Protocols Contains the Protocols Selection List 
and provides the ability to define, 
run, edit, copy, delete, and print 
measurement protocols. See 
Creating and Running Protocols.
A protocol stores all parameters 
required to perform a measurement, 
including technique types, detection 
methods, labware types, and 
preparation methods such as 
shaking.

Detection Methods Contains the Detection Method 
Selection List and provides the ability 
to create, edit, copy, and delete 
detection methods. See Creating and 
Editing Detection Methods.
Measurement configuration 
parameters are stored in detection 
methods.

Results Contains the Results Selection List 
and provides the ability to view 
saved measurement results and 
modify data reduction parameters in 
the Result Viewer. Measurement 
results may be reevaluated using 
parameters different from those 
configured in the original protocol. 
See Viewing Measurement Results.
Measurement results from each 
protocol run are stored in the Multi-
Mode Analysis Software database 
and are accessed only from the 
Results Selection List.

Labware Contains the Labware Selection List 
and provides the ability to create, 
edit, optimize, copy, and delete 
labware types. See Creating and 
Editing Labware.
26 5008530 A 



Multi-Mode Analysis Software User Guide
About the Tool Bar

The tool bar provides easy access to common software actions. The module 
chosen in the navigation pane determines which actions are available on the 
tool bar; for example, Optimize Labware is only available when the Labware 
module is active. A description of each tool bar is included for each view:

• Protocols Selection List Tool Bar. See Table 2-3.
• Detection Method Selection List Tool Bar. See Table 2-4.
• Results Selection List Tool Bar. See Table 2-5.
• Labware Selection List Tool Bar. See Table 2-6.
• Instrument Selection List Tool Bar. See Table 2-7.
• Users Tool Bar. See Table 2-8.
• Trash Tool Bar. See Table 2-9.

The Protocols Selection List tool bar provides access for creating, editing, and 
running protocols. A protocol stores all parameters required to perform a 
measurement, including technique types, detection methods, labware types, 
and preparation methods, such as shaking.

Instruments Contains the Instrument Selection 
List and provides the ability to 
manually control instrument actions 
(such as shaking, or loading and 
ejecting the plate carrier) and 
configure instrument settings and 
filter slides or detection cartridges. 
See Configuring and Controlling 
Instruments. The active instrument 
is controlled using the Instrument 
Selection List.

Users Appears in the navigation pane only 
when the Multi-Mode Analysis 
Software with GxP Permissions 
module is installed and enabled on 
the system. GxP Permissions is an 
integrated set of features that help 
Multi-Mode Analysis Software users 
comply with electronic signature 
regulations, such as 21 CFR Part 11. 
See Performing GxP Permissions 
User Actions in Multi-Mode Analysis 
Software on page 80.

Trash Contains the Trash List containing 
labware, detection methods, and 
protocols pending deletion. This 
section provides the ability to restore 
or permanently delete items from 
the database. See Deleting and 
Restoring Items on page 48.

Table2-2 The Navigation Pane (cont’d)

Name Button Description
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The Detection Method Selection List tool bar provides access for creating and 
editing detection methods. Measurement configuration parameters are stored 
in detection methods.

Table2-3 Protocols Selection List Tool Bar

Button Description

Creates a new protocol, see Creating Protocols on page 146.

Runs the currently selected protocol, see Running Protocols on 
page 197.

Edits the currently selected protocol, see Editing Protocols on 
page 211.

Copies the currently selected protocol, see Copying Protocols on 
page 212.

Prints the configuration information for the currently selected protocol, 
see Printing Protocol Configuration Information on page 213.

Deletes the currently selected protocol, see Deleting Protocols on 
page 212.

Table2-4 Detection Method Selection List Tool Bar

Button Description

Creates a new detection method, see Creating Detection Methods 
(FilterMax Multi-Mode Microplate Readers) on page 88 or Creating 
Detection Methods (SpectraMax Paradigm Multi-Mode Detection 
Platform) on page 99.

Edits the currently selected detection method, see Editing Detection 
Methods on page 123.

Copies the currently selected detection method, see Copying Detection 
Methods on page 124.

Deletes the currently selected detection method, see Deleting 
Detection Methods on page 124.
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The Results Selection List tool bar provides access to viewing, printing, and 
deleting results. Measurement results from each protocol run are stored in the 
Multi-Mode Analysis Software database and are accessed only from the Results 
Selection List.

The Labware Selection List tool bar provides access to creating, copying, 
optimizing, and deleting labware.

Table2-5 Results Selection List Tool Bar

Button Description

Deletes all displayed results, see Deleting Measurement Results on 
page 239.

Deletes currently selected result, see Deleting Measurement Results 
on page 239.

Views the currently selected result, see Viewing Measurement Results 
in the Result Viewer on page 217.

Prints the currently selected result, see Printing Measurement Results 
on page 239

Table2-6 Labware Selection List Tool Bar

Button Description

Creates a new labware type, see Creating Labware on page 128.

Edits the currently selected labware type, see Editing Labware on 
page 133.

Copies the currently selected labware type, see Copying Labware on 
page 136.

Optimizes the currently selected labware type, see Optimizing Labware 
on page 137.

Deletes the currently selected labware type, see Deleting Labware on 
page 136.
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The Instrument Selection List tool bar provides access to adding, deleting, 
configuring, managing, and connecting to an instrument.

The Users tool bar provides access to logging out the current user, changing 
the password, viewing the audit log, and reactivating disabled message boxes.

Table2-7 Instrument Selection List Tool Bar

Button Description

Adds a new instrument to the instrument selection list, see Adding a 
New Instrument on page 52.

Deletes the currently selected instrument, see Deleting an 
Instrument on page 53.

Sets the currently selected instrument to the current instrument, see 
Configuring the Current Instrument on page 54.

Configures instrument settings, see Configuring the FilterMax Multi-
Mode Microplate Readers Instrument Settings on page 57 or 
Configuring SpectraMax Paradigm Multi-Mode Detection Platform 
System Information Settings on page 65.

Ejects the currently selected instrument’s plate carrier, see 
Connecting to the Instrument on page 55.

Loads the currently selected instrument’s plate carrier, see Loading 
the Plate Carrier on page 55.

Initialize the currently selected instrument, see Initializing the 
Instrument on page 56.

Connects to the currently selected instrument, see Enabling 
Simulation Mode on page 56.

Table2-8 Users Tool Bar

Button Description

Logs out the current user, see Logging On and Off the 
System on page 81.

Changes the password of the user currently logged in, 
see Changing the Current User Password on page 82.

Views the audit log for the Multi-Mode Analysis 
Software, see Viewing and Searching the Multi-Mode 
Analysis Software Audit Log on page 83.

Reactivates disabled message boxes for the current 
user, see Reactivating Disabled Message Boxes on 
page 83.
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The Trash tool bar provides access for permanently removing and restoring 
items pending deletion from the database.

About the Selection and Configuration Pane

The selection and configuration pane is the large pane to the right of the 
navigation pane. Options available in this pane change depending on which 
module is currently selected in the navigation pane. For example, when 
Protocols is selected, the Protocol Selection List is displayed, which provides 
access to configured protocols and functionality specific to the Protocols 
module.

About the Preview Pane

The preview pane appears below the selection and configuration pane. It 
contains additional information about the selected object in the Protocols, 
Detection Methods, Labware, or Instruments selection lists. For example, 
when an instrument is selected in the Instrument Selection List, the 
parameters of the instrument appear in the preview pane. To hide the preview 
pane click Hide Preview. To display the preview pane click Show Preview.

Accessing Online Help
The Multi-Mode Analysis Software contains detailed online help that covers 
defining and editing labware, detection methods, and protocols, performing 
measurements, and exporting measurement results. The online help is context 
sensitive, which provides instant access to help for the active screen.
To access online help:

• Press F1 at any time to display online help for the active screen.
• From the Help menu, select Help > Contents to display the table of 

contents.

Table2-9 Trash Tool Bar

Button Description

Restores currently selected item, see Deleting and Restoring 
Items on page 48.

Restores all items in trash, see Deleting and Restoring Items on 
page 48.

Permanently removes the selected item from the database, see 
Deleting and Restoring Items on page 48.

Permanently removes all items in trash from the database, see 
Deleting and Restoring Items on page 48.
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Configuring Multi-Mode Analysis Software
After installing the software, physically connecting the instrument to a serial 
port on the host computer and turning the instrument on, instrument and 
software settings must be configured.
Configuration activities include:

• Configuring Instrument Settings on page 33
• Configuring Software Settings on page 35

To set up Multi-Mode Analysis Software:
1. From the Windows Start menu, select Programs > Molecular Devices > 

Multi-Mode Analysis Software > Multi-Mode Analysis Software. The Multi-
Mode Analysis Software appears (Figure 2-6).

Figure 2-6 Multi-Mode Analysis Software Main Screen

2. If the Protocol Selection List (Figure 2-6) appears immediately, the 
instrument was automatically detected by the software. Proceed to 
Configuring Software Settings on page 35, to configure system 
settings.
OR
If a warning dialog appears (Figure 2-7), the instrument was not 
detected by the software. Click OK to work in simulation mode. 

Note: If Multi-Mode Analysis Software is not found from the Windows 
Start menu, the software may have been installed for a single user 
account on the system instead of for all accounts. Check with the site 
system administrator or log in to the user account with permission to 
access the software. See Using Multi-Mode Analysis Software on 
page 24 for more information about installing the software for a single 
or multiple user accounts.
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Figure 2-7 Warning Dialog Instrument Not Connected

Configuring Instrument Settings
Before an instrument is connected, a simulated instrument appears in the 
Instrument Selection List (Figure 2-8). When an actual instrument is detected 
by the software and has successfully connected, the simulated instrument is 
replaced in the list by the connected instrument.

Note: Upon establishing a physical connection from the controlling PC, in 
many cases Multi-Mode Analysis Software may automatically detect and 
initialize the instrument.

Note: If the instrument is not detected check to see that the instrument is 
turned on, the instrument is connected to the controlling PC on which the 
software is installed, and that the instrument LED is not flashing. After 
turning on or plugging in the instrument click Connect on the Instrument 
Selection List toolbar. If the instrument does not connect automatically 
contact your local Molecular Devices Field Service Representative.

Note: Upon software start up, the software will check if the instrument is 
locked, or is detected as a new instrument. If the software detects the 
instrument in either state, the unlock wizard will start up. Proceed to unlock 
the instrument before continuing.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Instrument Settings permission may configure instrument 
settings. See Configuring Roles for Multi-Mode Analysis Software User 
Accounts on page 76 for more information about roles and permissions.
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To configure instrument settings:
1. From the navigation pane, select Instruments. The Instrument Selection 

List appears (Figure 2-8).

Figure 2-8 Instrument Selection List with Simulated Instrument 
Selected

2. From the tool bar, select Settings.
OR
From the menu bar select Actions > Instrument Settings.

3. The Instrument Settings dialog appears (Figure 2-9).

Figure 2-9 SpectraMax Paradigm Multi-Mode Detection Platform 
Instrument Settings
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4. Select the System Information tab, if necessary.
5. In Instrument Name, modify the instrument’s name if desired.
6. Click OK to close the Instrument Settings dialog.

Configuring Software Settings
The Multi-Mode Analysis Software can be customized using the options 
available in Software Settings (Figure 2-10). Use the menu in Software 
Settings to configure print options, default simulated data files, and the 
directory where measurement results are stored.
To configure Software Settings:

1. Select File > Settings. The Software Settings window appears 
(Figure 2-10).

Figure 2-10 Software Settings Window

2. Configure the settings using the menus: 
 Selecting Simulated Data Files
 Selecting a Directory for Saving Exported Measurement Results
 Configuring Print Settings
 Configuring Properties
 Configuring the Data Format
 Configuring Database Settings

Selecting Simulated Data Files

Protocols may be run in simulation mode, which allows the protocol 
configuration to be tested using simulated data before performing the protocol 
on actual samples. In simulation mode, all features for the instrument type 
currently selected in the Instrument Selection List are available, but 
measurement results are either randomly generated by the software or read 
from a data file.
Use the Directories menu option to select the default data files for simulated 
absorbance, luminescence, and fluorescence measurements (Figure 2-11).
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Figure 2-11 Selecting the Simulated Data Files

To select different simulated data files:
1. Select the Directories menu. The Simulated Data window appears 

(Figure 2-11).
2. In the desired field, enter the full path to the new simulated data file.

For example: c:\detection software templates\DefaultSimulatedData.dat 
Any data file with a .dat extension may be selected, including prior 
measurement results. Proceed to step 3.
OR
Click the browse (...) button next to the desired measurement type. 
The Open dialog appears. 

3. In the Open dialog, browse to and select the desired data file. Any data 
file with a .dat extension may be selected, including prior measurement 
results.

4. Click the Open button to select the data file and return to the Software 
Settings tab.

5. Repeat steps 2 through 4 for each simulated data file, as desired.
6. Click OK to set the new default data files.

Note: Simulated data files are used when the number of measurement 
points in the simulated protocol run is the same as those present in the 
data file. When the number of measurement points is different, the 
software generates random data.
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Selecting a Directory for Saving Exported 
Measurement Results

Exported measurement results files, regardless of format, are saved into a 
single directory. The default storage directory is:
C:\Documents and Settings\All Users\Application Data\Multi-Mode\Detection 
Software\data 
Use the Directories menu (Figure 2-12) to change the storage directory, as 
desired.

Figure 2-12 Directories Window for Data Storage Locations

To select a different storage directory:
1. Select the Directories menu. The directories window appears 

(Figure 2-12).
2. In the Data Directory path field, enter the complete path of the desired 

storage directory; 
3. for example: C:\documents\Multi-Mode measurement results\MyResults\ 

OR
Click the browse (...) button for a directory and use the Open window 
to browse to and select the desired directory.

4. Click OK to set the new storage directory.

Note: All measurement results are also stored in the Multi-Mode Analysis 
Software database and may be accessed using the Result Viewer. See Viewing 
Measurement Results in the Result Viewer on page 217.
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Configuring Print Settings

Measurement results and protocol configurations may be printed. Printing 
parameters, such as headers and footers are configured in the Print Settings 
window (Figure 2-13).

Figure 2-13 Print Settings Window

To configure print settings:
1. Select the Print Settings menu. The Print Settings window appears 

(Figure 2-13).
2. In the Print Header section, enter text for each header line, as desired. 

Header lines may be left blank.
3. In the Footer section, enter text for the Footer and Comment, as 

desired. The comment will display on printed pages below the footer. 
The footer and comment may be left blank.

4. In the Print Options section, select Print Preview to preview the page 
layout each time a protocol configuration or measurement results are 
printed.

5. In the Print Options section, select Show printer settings to display 
printing options each time a protocol or measurement results are 
printed.

6. In the Print Options section, select the desired Font and Font Size for 
printed text.

7. Click OK to save the new print settings.
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Configuring Properties

Certain settings (described below) may be configured from the Properties 
window.

1. In the Software Settings window, select the Properties menu. The List 
View Settings and some other general settings appear (Figure 2-14).

Figure 2-14 Software Settings Window

2. Select Show all Methods and Protocols in list view to display all methods 
and protocols on the Protocol Selection List window. Those protocols 
not available will be grayed out (Figure 2-15). When deselected 
unavailable methods and protocols are not displayed at all 
(Figure 2-16).

3. Select Show enabled state icon in list view for methods and protocols to 
display an enabled column in the Detection Methods List view and the 
Protocols Selection list view (Figure 2-17 and Figure 2-18). This allows 
the user to easily view if the detection method or protocol is currently 
enabled.

4. Select Allow Protocol Auto-Import when new instrument or detection 
cartridge detected to allow import of new example protocols when a new 
instrument or detection cartridge is detected. 

5. Select Initialize Instrument on Connect to allow initialization of the 
instrument when the software automatically connects to the 
instrument, or after the user clicks the Connect button.

Note: New cartridge detection is available for the SpectraMax Paradigm 
Multi-Mode Detection Platform only.
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6. Select Automatically load/eject cartridge carrier when running a Validation 
Plate to allow automatic loading and ejection of the cartridge carrier at 
appropriate times within the Validation Plate process. 

CAUTION! In any situation (such as when operating the instrument with 
integrated systems) where automatic loading and ejection of the cartridge 
carrier may cause a potential equipment collision, we recommend disabling the 
Automatically load/eject cartridge carrier when running the Validation Plate 
feature, and to load and eject the cartridge carrier manually.

7. Select Disable all sample wells without sample ID to disable processing of 
sample wells not bearing a sample ID.

8. Select Show elapsed time during measurement to allow indication of the 
elapsed time while running protocols. By deselecting this feature, the 
remaining time indicator will show in its place.

9. Click OK to save the new settings.
The Show all Methods and Protocols in list view option displays all methods and 
protocols in black, and those not available are grayed out (Figure 2-15).When 
deselected, unavailable methods and protocols are not shown in the Protocol 
Selection List or Detection Method List (Figure 2-16).

Figure 2-15 Protocol Selection List with Show all Methods and Protocols in list 
view selected
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Figure 2-16 Protocol Selection List View with Show all Methods and Protocols in 
list view deselected

Note: Select multiple items by clicking them and holding down the SHIFT or 
CTRL keys.
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The Show enabled state icon in list view for methods and protocols option when 
selected displays an enabled column in the Detection Methods list view and the 
Protocols list view (Figure 2-17 and Figure 2-18). This allows the user to easily 
view if the detection method or protocol is currently enabled.

Figure 2-17 Protocol Selection List View with Show enabled state icon in list 
view for methods and protocols selected

Figure 2-18 Protocol Selection List View with Show enabled state icon in list 
view for methods and protocols deselected
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Configuring the Data Format

Measurement results may be saved in Excel or .dat (data) file formats. Data 
Format (Figure 2-19) provides options to specify how data files are formatted, 
such as the delimiter character in .dat files and how to display cycle data for 
kinetic measurements in Excel files.

Figure 2-19 Configuring Data Format

To configure data file formats:
1. In the Delimiter reading / writing data files field, select the character to 

use to separate each column when reading and writing .dat files. 
Available delimiters are: 
 Tab
 Comma ( , )
 Semicolon ( ; )
 Pipe ( | )

Note: When using Microsoft Excel 2002 or higher, the Multi-Mode Analysis 
Software will format the Excel worksheets with the appropriate column width 
and apply formatting to display the status of a measurement value (such as 
bold and colors).
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2. In the Export Excel format field, select the desired option: 
 List: Results from each cycle are displayed side-by-side adjacent to 

the well in a column layout (Well, Cycle1, Cycle2, Cycle3, etc.) on 
one Excel spreadsheet.

Figure 2-20 Excel Format - List

Note: Area Scan and Wavelength Scan (when the Wavelength Scan 
points exceeds 250) cannot be exported in List format due to column 
limitations in Excel.
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 All Cycles on one Sheet: Cycles are displayed in a plate layout format, 
with each subsequent cycle displayed below the data for the 
previous cycle.

Figure 2-21 Excel Format - All Cycles On One Sheet
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 One Sheet per Cycle: cycles are displayed in a plate layout format, 
with each cycle displayed separately on a new worksheet labeled 
with the cycle number.

Figure 2-22 Excel Format - One Sheet Per Cycle
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Configuring Database Settings

The current database size and audit log for the database can be viewed using 
the Database settings (Figure 2-23). Database settings also provides options 
for shrinking the database.

Figure 2-23 Configuring Database Settings

To configure database settings:
1. Select the Database menu. Database Settings appear (Figure 2-23).
2. To compress the size of the database containing labware types, 

detection methods, and protocols click Shrink for Size Database 
Definition. Once the database is compressed, click OK.

3. To compress the size of the database containing results click Shrink for 
Size Database Result. Once the database is compressed, click OK.

4. To view the audit log for the database click Show. The Audit Viewer 
appears the audit log for the database (Figure 2-24).

Note: Compressing a database does not affect items in the Trash Selection 
list.
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Figure 2-24 Database Audit Log

Deleting and Restoring Items
The Trash Selection List contains labware, detection methods and protocols 
that are pending permanently deletion from the database. Items may be 
restored for use or permanently removed from the database using this 
window.
To restore an item pending deletion:

1. From the navigation pane, select Trash. The Trash List appears.
2. Select the item to restore.

OR
Click Restore All Items to restore all items in the Trash List for use in the 
software. All items in the Trash List are restored.

3. Click Restore Item. The selected item in the Trash List is restored. 

Note: Select multiple items by clicking them and holding down the 
SHIFT or CTRL keys.
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To permanently remove an item from the database:
1. From the navigation pane, select Trash. The Trash List appears.
2. Select the item to permanently remove from the database.

OR
Click Delete All to permanently delete all items in the Trash List from the 
database. All items in the Trash List are permanently removed from the 
database.

3. Click Delete. The selected item in the Trash List is permanently removed 
from the database.

4. To compress the database after items are removed from the database 
see Configuring Database Settings on page 47.
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3
Configuring and Controlling Instruments
Overview
Before defining measurement protocols, detection methods, and labware, or 
running protocols on an instrument using Multi-Mode Analysis Software, the 
instrument must be configured.
The Instrument Selection List provides access for configuring instrument 
settings and performing common instrument actions, such as loading and 
ejecting the plate carrier, and for configuring instrument settings.
Use the Instrument Selection List for:

• Managing Instruments on page 52
• Controlling Instrument Actions on page 54
• Configuring the FilterMax Multi-Mode Microplate Readers Instrument 

Settings on page 57
• Configuring SpectraMax Paradigm Multi-Mode Detection Platform 

Instrument Settings on page 64
• Configuring SpectraMax Paradigm Multi-Mode Detection Platform 

System Information Settings on page 65
To configure and manually control instruments:

• From the navigation pane, select Instruments. The Instrument Selection 
List appears (Figure 3-1).

Figure 3-1 Instrument Selection List
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All instruments that have been connected to the host computer and configured 
in the software are displayed in the Instrument Selection List. When an 
instrument is not currently connected to the computer that is selected, the 
software automatically enters simulation mode. See Enabling Simulation Mode 
on page 56. This allows protocols, detection methods, and labware to be 
defined, edited, and tested for the selected instrument even though it is not 
physically connected to the host computer.

Managing Instruments

Adding a New Instrument
When an instrument is connected to the PC and turned on it is automatically 
installed and added to the Instrument Selection list for use.

Adding an instrument adds a new simulated instrument to the Instrument 
Selection list for use in building and creating methods, labware, and protocols. 
Two instruments of the same type may be added and are identified by their 
serial number and instrument name. Two simulated instruments of the same 
type may not be added.
To manually add an instrument:

1. From the tool bar, click Add a new Instrument to the list.
OR
From the menu bar select Actions > Add a new Instrument to the list.
OR
Right-click on the Instrument Selection list and select Add a new 
Instrument to the list from the menu that appears.

2. The Add Instrument Wizard dialog appears (Figure 3-2).

Note: Select the current instrument for the software. The labware, detection 
methods, protocols, and results are specific to each instrument. To 
configuring the current instrument see Configuring the Current Instrument on 
page 54.

Note: If a simulated instrument already exists in the Instrument Selection List 
and the actual instrument of the same type is connected to the PC and turned 
on, all detection methods and protocols for the simulated instrument will be 
associated with the connected instrument.
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Figure 3-2 Add Instrument Wizard Dialog

3. Using the Instrument Type field, select the instrument to be added.
4. Click the Install button.
5. The instrument is added to the instrument selection list. To configure 

the Instrument Settings, see Configuring the FilterMax Multi-Mode 
Microplate Readers Instrument Settings on page 57 or Configuring 
SpectraMax Paradigm Multi-Mode Detection Platform Instrument 
Settings on page 64.

Deleting an Instrument
Deleting an instrument removes the instrument from the Instrument Selection 
list and all associated methods and protocols are disabled. Protocols and 
methods from a deleted instrument are automatically associated with an 
instrument of the same type and configuration (detection cartridges or filter 
slides).

To delete an instrument:
1. Select the instrument to be deleted.
2. From the tool bar, click Delete the currently selected instrument.

OR
From the menu bar select Actions > Delete the currently selected 
instrument.
OR
Right-click on the instrument and select Delete the currently selected 
instrument from the menu that appears.

3. The Instrument Delete dialog appears, click Yes to delete the 
instrument.

4. The instrument is deleted from the Instrument Selection list, along with 
disabling all associated detection methods and protocols.

Note: If an instrument is connected and on, the instrument cannot be 
deleted. It will be temporarily removed from the Instrument Selection List, 
and when the list is refreshed the software will retrieve all defined and 
connected instruments. Only simulated instruments can be permanently 
removed from the Instrument Selection List.
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Configuring the Current Instrument
Configuring the current instrument readies the instrument for use. It displays 
the available detection methods and protocols for the instrument, and disables 
other instruments’ detection methods and protocols. Detection methods and 
protocols can only be created for the current instrument.
To configure the current instrument:

1. On the Multi-Mode Analysis Software main window, select the 
instrument for configuration.

2. From the tool bar, click the Set Current button.
OR
From the menu bar select Actions > Sets the selected Instrument to 
Current Instrument.
OR
Right-click on the instrument and from the menu that appears select 
Sets the selected Instrument to Current Instrument.

3. The instrument is now configured as the current instrument.

Controlling Instrument Actions
Instrument actions, such as ejecting or loading the plate carrier and initializing 
the instrument, can be performed directly from the Instrument Selection List 
using the buttons on the tool bar.
Actions that may be controlled include:

• Connecting to the Instrument on page 55
• Connecting to the Instrument on page 55
• Loading the Plate Carrier on page 55
• Initializing the Instrument on page 56
• Enabling Simulation Mode on page 56

Note: Before connecting to any instrument, ensure all connections are secure 
and that the instrument is unlocked and powered up.

Note: Only the current instrument can be controlled. Set the desired 
instrument to the current instrument. See Configuring the Current 
Instrument on page 54.
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Connecting to the Instrument
When started, the Multi-Mode Analysis Software automatically establishes 
communication with the instrument or enters simulation mode when no 
instrument is detected. A connection to an instrument may be established 
manually after physically connecting a different instrument to the computer, or 
when switching from simulation mode. See Enabling Simulation Mode on 
page 56.
To connect to the current instrument:

• From the tool bar, click the Connect button. The button remains 
depressed while the selected instrument is connected and not in 
simulation mode.
OR
From the menu bar select Actions > Connect to the instrument.
OR
Right-click on the instrument and from the menu that appears select 
Connect to the instrument.

Ejecting the Plate Carrier
Ejecting the plate carrier moves the plate carrier outside the instrument to 
allow access for placement or removal of a microplate.
To eject the plate carrier from the current instrument:

• From the tool bar, click the Eject button.
OR
From the menu bar select Actions > Eject the plate carrier.
OR
Right-click on the instrument and from the menu that appears select 
Eject the plate carrier.

Loading the Plate Carrier
Loading the plate carrier retracts the plate carrier and microplate back into the 
instrument in preparation of performing a measurement.
To load the plate carrier on the current instrument:

• From the tool bar, click the Load button.
OR
From the menu bar select Actions > Load the plate carrier.
OR
Right-click on the instrument and from the menu that appears select 
Load the plate carrier.
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Initializing the Instrument
Initializing the instrument moves the optics and microplate transports to home 
positions. The instrument is initialized automatically each time it turned on. If 
necessary, the instrument may be initialized manually; for example, after an 
emergency stop has been performed.

To manually initialize the current instrument:
• From the tool bar, click the Init button.

OR
From the menu bar select Actions > Initialize the instrument.
OR
Right-click on the instrument and from the menu that appears select 
Initialize the instrument.

Enabling Simulation Mode
The Multi-Mode Analysis Software can operate in simulation mode whether or 
not an instrument is connected. Simulation mode enables all features 
supported by the instrument currently selected in the Instrument Selection 
List, but measurement results are generated randomly or read from a file. See 
Selecting Simulated Data Files on page 35 for more information about 
selecting simulated data files.

To enable simulation mode:
• From the tool bar, click Simulate the current instrument. The button 

remains depressed while the instrument is in simulation mode.
OR
From the menu bar select Actions > Simulate the current instrument.
OR
Right-click on the current instrument and from the menu that appears 
select Simulate the current instrument.

To exit simulation mode, reconnect to the instrument. See Connecting to the 
Instrument on page 55.

Note: When a hardware error occurs, turning the instrument off and on is the 
recommended initialization method.

Note: Only the current instrument can be controlled, set the desired 
instrument to the current instrument. See Configuring the Current 
Instrument on page 54.

Note: If no instrument is connected to the controlling PC, then Multi-Mode 
Analysis Software may only run in simulation mode.
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Configuring the FilterMax Multi-Mode Microplate Readers 
Instrument Settings

Filter slides used by the FilterMax Multi-Mode Microplate Readers are 
configured in Instrument Settings. Configuring Instrument Settings informs 
Multi-Mode Analysis Software about the instrument and the configuration of 
filter slides and individual filters. Instrument activities – such as microplate 
shaking and the ejection or loading of filter slides – may also be controlled 
manually.

To configure current instrument settings:
1. From the tool bar, click the Settings button.

OR
From the menu bar select Actions > Instrument Settings.
OR
Right-click on the current instrument and select Instrument Settings 
from the menu that appears.

2. The Instrument Settings window appears.
3. Configure instrument settings on the three tabs as described in the 

following sections: 
 Configuring the FilterMax Multi-Mode Microplate Readers 

Instrument Settings on page 57
 Defining and Editing Filter Slides on page 58
 Manually Controlling the FilterMax Multi-Mode Microplate Readers 

on page 62

Note: To configure instrument settings for the SpectraMax Paradigm Multi-
Mode Detection Platform see Configuring SpectraMax Paradigm Multi-Mode 
Detection Platform Instrument Settings on page 64.

Note: Only the current instrument can be controlled. Set the desired 
instrument to the current instrument. See Configuring the Current 
Instrument on page 54.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role supported by the Instrument Settings permission may configure 
instrument settings. See Configuring Roles for Multi-Mode Analysis Software 
User Accounts on page 76 for more information about roles and permissions.
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Modifying and Viewing System Information
The System Information tab (Figure 3-3) contains information about the 
instrument.

Figure 3-3 FilterMax Multi-Mode Microplate Readers Instrument Settings

To configure basic instrument settings:
1. In the Instrument Settings window, select the System Information tab.
2. In the Instrument Name field, modify the alias for the instrument’s 

name as desired.
Other fields are read-only (grayed out) and thus cannot be modified.

Defining and Editing Filter Slides
The Filter Slides tab (Figure 3-4) is used to add, remove, and configure filter 
slides and the filters installed on a filter slide. Slide definitions may also be 
imported and exported.
Filters used to perform measurements are mounted on two types of 
interchangeable slides. One slide is reserved for excitation filters used in 
absorbance and fluorescence measurements; the other is used for emission 
filters used in fluorescence and some luminescence measurements. Each slide 
can hold up to six filters.

Table3-1 Instrument Settings fields

Field Description

Instrument Name The alias for the instrument name.

Instrument Type The model of the instrument

Serial Number The serial number of the instrument.

Device Number The device number of the instrument.

Firmware Version The firmware version loaded for the instrument.

PIC FW Version The instrument PIC processor firmware version.

Features The types of measurements the instrument is capable of 
performing.
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When exchanging slides, an identification code built into the slide allows Multi-
Mode Analysis Software to recognize the new slide and filter configuration. 
When a slide with a new configuration is inserted, or the filters on a slide 
change, the slide must be configured in the Filter Slides tab. Up to 31 excitation 
filter slides and 31 emission filter slides may be stored in Multi-Mode Analysis 
Software at one time.

Figure 3-4 Instrument Settings - Filter Slides

This section covers:
• Adding Filter Slides on page 59
• Configuring Filter Slides on page 60
• Removing Filter Slides on page 61
• Exporting and Importing All Filter Slide Configurations on page 61
• Exporting and Importing Single Filter Slide Configurations on page 61

Adding Filter Slides

When a new filter slide is used with the instrument for the first time, it must be 
added so that the Multi-Mode Analysis Software may identify the slide and 
filter configuration.
To add filter slides:

1. Select the type of filter slide to add: Excitation or Emission. The list of 
filter slides displays all slides of the selected type currently stored in 
memory.

2. Click Add Slide. A new filter slide appears on the list of slides in the 
central pane.

3. Configure the slide following the steps in Configuring Filter Slides on 
page 60.

Note: Excitation and emission filter slides are different sizes to prevent them 
from being installed in the incorrect position.

Note: For FilterMax Multi-Mode Microplate Readers to create or run 
quantitation protocols, a genomic filter slide, which contains narrow 
bandwidth 260 nm and 280 nm filters) must be installed and configured.
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Configuring Filter Slides

The Filter Slide Properties pane shows filter name and ID for the currently 
selected slide, and displays information about the filters installed on the slide. 
When a new slide is added, or the filter configuration on a slide changes, the 
slide must be configured.

CAUTION! It is recommended not to reconfigure standard filter slides.

To configure a filter slide:
1. Select the type of filter slide to configure: Excitation or Emission. The list 

of filter slides displays all configured slides of the selected type.
2. Select the desired filter slide to configure from the list. The he Filter 

Slide Properties pane displays information about the selected slide 
(Figure 3-4).

3. In the Slide ID field, enter the identification number printed on the slide.
4. In the Slide Name field, enter a name by which to identify the filter 

slide.
5. In the list of filter slides, click the + to the left of the filter slide name to 

display the list of filters installed on the slide.
6. Select a filter to configure. Filter properties for the selected filter is 

displayed on the Filter Properties pane (Figure 3-5).

Figure 3-5 Configuring Filter Properties

7. In the Wavelength field, enter the wavelength of the filter.
8. Click in the Techniques field and then click the down arrow to display a 

list of the available detection techniques.
9. Select all techniques for which the filter applies. The filter can be used 

only for measurements of the selected technique types. When 
techniques are selected, the read-only Installed field appears Yes. When 
No is appears, no techniques are selected and the filter may not 
execute any techniques. 

Note: FilterMax 5 Multi-Mode Microplate Reader only: Select Polarization 
only for filter positions where a polarization filter is installed.
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10. In the Name field, enter a name for the selected filter. Filter names 
default to the wavelength entered, but may be renamed as desired.

11. In the Bandwidth field, enter the bandwidth (in nanometers) of the 
selected filter.

12. Repeat steps 6 through 11 to configure additional filters on the slide.

Removing Filter Slides

If a filter slide is no longer used with an instrument, it can be removed from 
the Multi-Mode Analysis Software.
To remove a filter slide:

1. Select the type of filter slide to remove: Excitation or Emission. The list 
of filter slides displays all slides of the selected type.

2. Select the desired filter slide to remove from the list. The Filter Slide 
Properties window displays information about the selected slide.

3. Click Remove Slide. The selected filter slide is removed from the list.

Exporting and Importing All Filter Slide Configurations

Information for all excitation and emission filter slides configured for the 
instrument may be exported to an XML file and imported at a later time to 
restore that configuration or share the filter slide configuration with another 
instrument. Importing the filter slide configuration from an XML file replaces 
the current configuration for all filter slides with the configuration from the file.

To export all filter slides:
1. Select Export Slides. The Save As dialog appears.
2. In the Save As window, select the desired directory and enter a file 

name.
3. Click Save. Slide information is saved as an XML file with the specified 

path and file name.
To import all filter slides from a previously exported file:

1. Select Import Slides. The Open dialog appears.
2. In the Open dialog, browse to and select the desired XML file to import.
3. Click Open. The filter slides defined in the XML file are imported into the 

filter slide list and replace all existing filter slides.

Exporting and Importing Single Filter Slide Configurations

Configuration information for a single filter slide may be exported to an XML 
file and imported to restore that configuration or share the configuration with 
another instrument.
To export a single filter slide configuration:

1. In the list of filter slides, select the slide desired to export.
2. Select Export This Slide. The Save As dialog appears.
3. In the Save As dialog, select the desired directory and enter a file 

name.
4. Click Save. Slide information is saved as an XML file with the specified 

path and file name.

Note: If necessary, the default filter slide configuration may be restored by 
importing the file for the type of instrument in use located in Documents and 
Settings\All Users\Application Data\Multi-Mode\Detection Software\Filters.
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To import a single filter slide configuration:
1. If the list of filter slides currently loaded contains a slide with the same 

ID as a slide configuration for import, delete that currently loaded slide. 
Every filter slide ID stored in the software must be unique.

2. Select Import Single Slide. The Open dialog appears.
3. In the Open dialog, browse to and select the desired XML file to import.
4. Click Open. The selected filter slide is imported and added to the list of 

filter slides for the current instrument.

Manually Controlling the FilterMax Multi-Mode 
Microplate Readers
The Manual Control tab (Figure 3-6) provides options to control the actions of 
the connected instrument. These actions include microplate shaking and 
ejecting or loading filter slides.

Figure 3-6 FilterMax Multi-Mode Microplate Readers Instrument Settings - 
Manual Control Tab

Manual Control is divided into five subsections:
• Temperature Control (FilterMax 5 Multi-Mode Microplate Reader only) 

on page 63
• Shake Control on page 63
• Plate Carrier Control on page 64
• Excitation Filter and Emission Filter Slide Control on page 64
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Temperature Control (FilterMax 5 Multi-Mode 
Microplate Reader only)

Temperature Control is used to set the microplate chamber temperature. The 
temperature is set by heating the microplate chamber; cooling the chamber is 
not supported. Depending on the light source used to perform measurements 
configured in the protocol, the temperature may range from 3°C (5.4°F) or 
4°C (7.2°F) above ambient to 45°C (113°F). The Actual field displays the 
current temperature of the instrument.
To set the temperature:

1. In the Set Point field, enter the desired temperature in Celsius.
2. Click Set. Temperature control is activated for the instrument and 

begins to heat to the desired temperature. The set temperature is 
maintained until it is changed or the instrument is powered off.

To turn off temperature control:
• In the Set Point field, enter 0, then click Set.

OR
Turn the power to the instrument off and on.

Shake Control

Shake Control is used to manually shake the microplate loaded in the 
instrument.
To manually perform a shaking operation:

1. In the Mode field, select the desired shaking mode: 
 Linear: shakes from side to side.
 Orbital: shakes in a circular pattern.
 Squared: shakes in a square pattern, moving clockwise or counter-

clockwise at right angles.

CAUTION! Shake low-density plates, such as 6- or 48-well plates, at Low speed 
only. Shaking low density plates at higher speeds may cause liquid in wells to 
spill.

2. In the Intensity field, select the desired shaking intensity: Low, Medium, 
or High.

3. In the Duration field, enter the length of time (in seconds) for shaking.
4. Click Shake. The instrument immediately shakes the microplate 

according to these settings.

Note: A minimum of 15 minutes is required for the instrument to reach the 
desired temperature from ambient. The actual time required depends on the 
relative change in temperature.

The FilterMax 3 Multi-Mode Microplate Reader does not support heating to a 
set temperature.
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Plate Carrier Control

Plate Carrier Control provides options to eject or load the plate carrier. It also 
features an option to sense that a microplate is in the plate carrier before 
starting a measurement.
To manually control the plate carrier:

• Click Eject to extend the plate carrier outside the instrument.
• Click Load to retract the plate carrier into the instrument.
• Select Check if plate is inserted before each read to sense if a microplate is 

in the plate carrier before starting measurement.

Excitation Filter and Emission Filter Slide Control

Excitation Filter Slide Control and Emission Filter Slide Control are used to 
manually eject or load the excitation or emission filter slides.
To manually eject or load the excitation or emission filter slide:

• Click Eject from the desired filter slide control section to unload the 
filter slide from the filter compartment and partially open the 
compartment door.

• Click Load from the desired filter slide control section to retract the filter 
slide into position.

Configuring SpectraMax Paradigm Multi-Mode 
Detection Platform Instrument Settings

Instrument settings and detection cartridges used by the SpectraMax 
Paradigm Multi-Mode Detection Platform are configured in Instrument Settings. 
Configuring Instrument Settings informs Multi-Mode Analysis Software about 
the instrument, such as the configuration of detection cartridges. Instrument 
activities – such as microplate shaking and the ejection or loading of filter 
slides – may also be controlled manually.

Note: To remove the filter slide, it is still necessary to grasp it by the 
tab and pull it until it is free of the geared track. Store the removed 
filter slide in a protected, dust-free area, preferably in the original 
packaging.

Note: To configure the FilterMax Multi-Mode Microplate Readers, see 
Configuring the FilterMax Multi-Mode Microplate Readers Instrument Settings 
on page 57.

Note: Only the current instrument can be controlled, set the desired 
instrument to the current instrument. See Configuring the Current 
Instrument on page 54.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role supported by the Instrument Settings permission may configure 
instrument settings. See Configuring Roles for Multi-Mode Analysis Software 
User Accounts on page 76 for more information about roles and permissions.
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To configure current instrument settings:
1. From the tool bar, click Settings.

OR
From the menu bar select Actions > Instrument Settings.
OR
Right-click on the current instrument and select Instrument Settings 
from the menu that appears.

2. The Instrument Settings window appears.
3. Configure instrument settings on the four tabs as described in the 

following sections: 
 Configuring SpectraMax Paradigm Multi-Mode Detection Platform 

System Information Settings on page 65
 Viewing Installed Detection Cartridges on page 66
 Defining and Editing the Available Detection Cartridges on page 66
 Manually Controlling the SpectraMax Paradigm Multi-Mode 

Detection Platform Instrument on page 69

Configuring SpectraMax Paradigm Multi-Mode 
Detection Platform System Information Settings

The System Information tab (Figure 3-7) contains information about the 
instrument.

Figure 3-7 Instrument Settings - System Information Settings
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To configure System Information settings:
1. In the Instrument Settings dialog, select the System Information tab.
2. In the Instrument Name field, modify the alias for the instrument’s 

name as desired.
3. Click Apply. The instrument information fields are automatically 

populated with information about the connected instrument. Refer to 
Table 3-2 for more information about each field.

Viewing Installed Detection Cartridges
The Installed Detection Cartridges tab appears detection cartridges currently 
installed in the instrument. Detection Cartridges are automatically detected 
and added to the Installed Detection Cartridge tab and Available Detection 
Cartridges tab when they are inserted into the instrument.

Defining and Editing the Available Detection Cartridges
The Available Detection Cartridges tab (Figure 3-8) is used to add detection 
cartridges to My Detection Cartridges for convenient configuration of methods 
and protocols. The detection cartridges do not need to be installed in the 
instrument, however to configure a detection cartridge it is necessary to add it 
to My Detection Cartridges.

Table3-2 Instrument Settings fields

Field Description

Instrument Name The alias for the instrument name.

Instrument Type The model of the instrument

Serial Number The serial number of the instrument.

Device Number The device number of the instrument.

Firmware Version The firmware version loaded for the instrument.

PIC FW Version The instrument PIC processor firmware version.
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Figure 3-8 Instrument Settings - Available Detection Cartridges

This section covers:
• Adding Detection Cartridges to the list of Available Detection Cartridges 

on page 67
• Removing Detection Cartridges from the list of Available Detection 

Cartridges on page 68

Adding Detection Cartridges to the list of Available 
Detection Cartridges

To use a detection cartridge with the instrument, the detection cartridge must 
be added to My Detection Cartridges so that it can be used in protocols. Only the 
detection cartridges contained within the My Detection Cartridges will be 
available for creating Detection Methods and Protocols.

Note: When a detection cartridge is installed in the instrument the software 
automatically adds the detection cartridge to My Detection Cartridges.

Note: Any available detection cartridge can be added to My Detection 
Cartridges for use in creating detection methods and protocols. The detection 
cartridge can be placed in the instrument at a later point in time. 
Fluorescence Intensity detection methods are based upon a Top Read or 
Bottom Read, it is important to install the cartridge in the proper Top Read or 
Bottom Read detection cartridge transport according to the created protocol.
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To manually add detection cartridges to My Detection Cartridges:
1. Click on the Available Detection Cartridges tab.
2. A list of all detection cartridges available is displayed in All Detection 

Cartridges. The list of installed detection cartridges is displayed within 
My Detection Cartridges. Select the detection cartridges to add from All 
Detection Cartridges.

3. Click Add. The selected detection cartridges are added to My Detection 
Cartridges. They are now available for use in a detection method, see 
Creating Detection Methods (SpectraMax Paradigm Multi-Mode 
Detection Platform) on page 99.

Removing Detection Cartridges from the list of 
Available Detection Cartridges

In simulation mode, removing a detection cartridge from My Detection 
Cartridges disables its use. All Detection Methods and Protocols associated with 
the detection cartridge will become unavailable for use in simulation mode. 
Associated Detection Methods and Protocols are not deleted, they are simply 
removed from the view. If the detection cartridge is added to My Detection 
Cartridges again, all Detection Methods and Protocols associated with it will 
become available again.

To remove detection cartridges from My Detection Cartridges:
1. Click on the Available Detection Cartridges tab.
2. A list of all detection cartridges available is displayed in All Detection 

Cartridges. The list of installed detection cartridges is displayed within 
My Detection Cartridges. Select the detection cartridges to remove from 
My Detection Cartridges.

3. Click Remove. The detection cartridges are removed from My Detection 
Cartridges. All detection methods and protocols that use this detection 
cartridge are now unavailable.

Note: When an instrument is connected and not in simulation mode, 
removing a detection cartridge from My Detection Cartridges is only temporary. 
As soon as the connection is refreshed the detection cartridge will be added 
to My Detection Cartridges and it will become available again.
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Manually Controlling the SpectraMax Paradigm Multi-Mode 
Detection Platform Instrument
The Manual Control tab (Figure 3-9) provides options to control the actions of 
the connected instrument, such as shaking microplates and ejecting or loading 
detection cartridges.

Figure 3-9 SpectraMax Paradigm Multi-Mode Detection Platform Instrument 
Settings - Manual Control

Manual Control is divided into five subsections:
• Temperature Control on page 70
• Shake Control on page 70
• Plate Control on page 71
• Top Read Detection Cartridge Transport Control on page 71
• Bottom Read Detection Cartridge Transport Control on page 71
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Temperature Control

Temperature Control is used to adjust microplate chamber temperature. The 
temperature is set by heating the microplate chamber; cooling the chamber is 
not supported. Depending on the light source used to perform measurements 
configured in the protocol, the temperature may range from 3°C (5.4°F) or 
4°C (7.2°F) above ambient to 45°C (113°F). The Actual field displays the 
current temperature of the instrument.
To set the temperature:

1. In the Set Point field, enter the desired temperature in Celsius.
2. Click Set. Temperature control is activated for the instrument and 

begins to heat to the desired temperature. The set temperature is 
maintained until it is changed or the instrument is powered off.

To turn off temperature control:
• In the Set Point field, enter 0, then click Set.

OR
Turn the power to the instrument off and on.

Shake Control

Shake Control is used to manually shake the microplate loaded in the 
instrument.
To manually perform a shaking operation:

1. In the Mode field, select the desired shaking mode: 
 Linear: shakes from side to side.
 Orbital: shakes in a circular pattern.

CAUTION! Shake low-density plates, such as 6-well or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause liquid in 
wells to spill.

2. In the Intensity field, select the desired shaking intensity: Low, Medium, 
or High.

3. In the Duration field, enter the length of time (in seconds) for shaking.
4. Click Shake. The instrument immediately shakes the microplate 

according to these settings.

Note: A minimum of 15 minutes is required for the instrument to reach the 
desired temperature from ambient. The actual time required depends on the 
relative change in temperature.

Note: Squared shaking (available in FilterMax Multi-Mode Microplate 
Readers) is not supported on the SpectraMax Paradigm Multi-Mode 
Detection Platform.
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Plate Control

Plate Control provides options to eject or load the plate carrier. It also features 
an option to sense that a microplate is in the plate carrier before starting a 
measurement.
To manually control the plate carrier:

• Click Eject to extend the plate carrier outside the instrument.
• Click Load to retract the plate carrier inside the instrument.
• Select Check if plate is inserted before each read to sense if a microplate is 

in the plate carrier before starting each measurement.

Top Read Detection Cartridge Transport Control

The Top Read Detection Cartridge Transport Control is used to manually eject 
or load detection cartridges into the Top Read detection cartridge transport.
To manually eject or load the Top Read detection cartridge transport:

• Click Eject from the Top Read Detection Cartridge Transport Control 
section to unload a detection cartridge from the Top Read 
compartment.

• Click Load from the Top Read Detection Cartridge Transport Control 
section to retract the detection cartridge into position. If a detection 
cartridge is inserted into the instrument it will automatically be 
detected.

Bottom Read Detection Cartridge Transport Control

The Bottom Read Detection Cartridge Transport Control is used to manually 
eject or load detection cartridges into the Bottom Read detection cartridge 
transport.
To manually eject or load the Bottom Read detection cartridge transport:

• Click Eject from the Bottom Read Detection Cartridge Transport Control 
section to unload a detection cartridge from the Bottom Read transport 
compartment.

• Click Load from the Bottom Read Detection Cartridge Transport Control 
section to retract the detection cartridge into position. If a detection 
cartridge is inserted into the instrument it will automatically be 
detected.
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4
Setting Up and Using GxP Permissions
Overview
To assist users in complying with electronic signature regulations, such as 21 
CFR Part 11, the optional GxP Permissions module for Multi-Mode Analysis 
Software may be purchased from Molecular Devices. When GxP Permissions is 
enabled for Multi-Mode Analysis Software, users must have a valid user 
account and password on the system to access the software. Each user is 
assigned roles that contain specific permissions which determine the software 
actions the user may perform.
GxP Permissions provides support for closed systems only; access over a 
network is not supported. In a location where several systems are present, 
GxP Permissions must be installed and enabled separately for each system 
where compliance is desired. Users require separate accounts on each system 
they need to access.

A single system administrator sets up the level of support provided by GxP 
Permissions, creates and manages roles assigned to user accounts, and 
configures GxP Permissions system parameters.
This section covers:

• Enabling GxP Permissions on page 73
• Performing System Administration Tasks on page 75

Enabling GxP Permissions
A single system administrator account may be configured for GxP Permissions. 
The system administrator enables the system by setting the desired support 
level. Three support levels are available:

• No Support: GxP Permissions is disabled; user accounts are not 
required.

• GxP Permissions: User accounts are required to log into the software, 
but passwords are not required to sign items.

• GxP Permissions, with password checks for signing and check-in: User 
accounts are required to log into the software, and passwords must be 
entered for confirmation when prompted.

Note: Compliance with regulations, such as 21 CFR Part 11, requires 
implementing site processes beyond the control of the software.

Note: GxP Permissions without password checks may not provide 
adequate support to comply with 21 CFR Part 11 or other regulations. 
Each site must evaluate the level of support required for a given 
system.

Note: Compliance with regulations, such as 21 CFR Part 11, requires 
implementing site processes beyond the control of the software.
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To enable GxP Permissions by setting a support level:
1. Log off and close all Molecular Devices applications.
2. Place the GxP Permissions CD in the drive, and browse to the contents 

of the CD.
3. Double-click GxP Permissions -- Support Options.exe. The 

Administrator Login appears.
4. If GxP Permissions is being enabled for the first time, in Administrator 

Login, enter Password. A message explaining that the password must 
be changed appears.
OR
If GxP Permissions has been enabled previously, in Administrator Login, 
enter the administrator password and click OK. Support Options appear. 
Proceed to step 5. 

5. In the message box, click OK. The Change Password dialog appears.
6. In the upper field, enter a new password.
7. In the lower field, re-enter the new password and click OK to confirm. 

The Support Options dialog appears (Figure 4-1).

Figure 4-1 Support Options Dialog

8. Select the Multi-Mode Analysis Software tab, as necessary. Multiple tabs 
appear only when several software applications with GxP Permissions 
support are installed on the system.

9. Select the level of support: 
 No support: User accounts are not required to access Multi-Mode 

Analysis Software. Users have access to all software operations and 
functionality. System activity is logged in the audit trail and may be 
viewed in the Audit Log. See Viewing the System Activity Audit Log 
on page 79.

 GxP Permissions: Enables the use of user accounts and permissions 
for Multi-Mode Analysis Software. Users must log in to use the 
software and may access only features and actions for which they 
have permission. Actions performed in the software, such as signing 
a labware type or protocol, do not require password confirmation.

Note: If the Administration Password is lost, forgotten, or not known, 
follow the steps in Restoring the Administrator Password on page 79.
74 5008530 A 



Multi-Mode Analysis Software User Guide
 GxP Permissions, with password checks for signing and check-in: 
Enables the use of user accounts and permissions and electronic 
signatures for Multi-Mode Analysis Software. Users must log in to 
use the software and may access only features and operations for 
which they have permission. Support for 21 CFR Part 11 or other 
regulations is provided by requiring password checks for operations 
such as signing a detection method.

10. Click OK to activate the support level chosen and close Support 
Options. 

Performing System Administration Tasks
On a system with GxP Permissions enabled, a single administrator account 
provides the ability to perform GxP Permissions system administration tasks, 
including:

• Administering User Accounts and Roles on page 75
• Restoring the Administrator Password on page 79
• Viewing the System Activity Audit Log on page 79

Administering User Accounts and Roles
GxP Permissions system administration tasks are performed in the Account 
Management application included as part of the GxP Permissions installation. 
The system administrator sets up and configures user accounts, passwords, 
and roles, and configures system settings, such as automatic password 
expiration and system logout time.
A single system administrator password is used on a controlling system. 
System administration tasks may be performed only on the computer where 
Account Management is installed; access to Account Management over a 
network is not supported.

Note: GxP Permissions without password checks may not provide 
adequate support to comply with 21 CFR Part 11 or other regulations. 
Each site must evaluate the level of support required for a given 
system.

Note: When other applications that support GxP Permissions are 
installed on the system, each must be configured with the same 
support level as Multi-Mode Analysis Software.

Note: Regulations, such as 21 CFR Part 11, contain additional 
requirements for account management beyond the control of this 
software.

Note: After GxP Permissions is enabled for the first time, the administrator 
must create at least one user account to access Multi-Mode Analysis 
Software. See Administering User Accounts and Roles on page 75 for detailed 
instructions.

Note: If the administrator requires access to Multi-Mode Analysis Software, a 
separate user account must be created.
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This section covers accessing Account Management and configuring roles that 
are assigned to user accounts. See Configuring Roles for Multi-Mode Analysis 
Software User Accounts on page 76. Refer to the Account Management online 
help for detailed information about GxP Permissions system administration 
tasks.
To open Account Management:

1. Close all Molecular Devices applications.
2. In the Windows Start menu, select Settings > Control Panel. the Control 

Panel appears.
3. In Control Panel, double-click on Administrative Tools. The Administrative 

Tools window appears.
4. In the Administrative Tools window, double-click on Account 

Management. The Administrator Login window appears.
5. Enter the administrator password and click OK. The Account 

Management window appears (Figure 4-2).

Figure 4-2 Account Management

Configuring Roles for Multi-Mode Analysis Software 
User Accounts
Multi-Mode Analysis Software permissions, which control access to software 
actions, are installed as a part of Multi-Mode Analysis Software as the GxP 
Permissions module. Permissions are not assigned directly to user accounts. 
Instead the system administrator assigns permissions to roles, which are then 
assigned to accounts as desired.
Roles may be assigned multiple permissions. When several software 
applications that support GxP Permissions are installed on the same system, 

Note: Regulations, such as 21 CFR Part 11, contain additional requirements 
for account management beyond the control of this software.
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permissions from different applications may be assigned to the same role. A 
permission may be assigned to as many roles as desired.
Three preconfigured roles are installed with the GxP Permissions module (refer 
to Table 4-3). These roles may be assigned to user accounts as is, or edited, 
renamed, or deleted as desired.

To configure roles:
1. In the Account Management window, select the Roles tab (Figure4.3).

Figure 4-3 Configuring Roles

2. In the Roles section, click the Create Role button or select an existing 
role to edit. Table 4-1 describes the default roles provided with the 
software.

3. While ensuring the appropriate role is highlighted in the Roles pane, in 
the Permissions pane select the permissions to match the selected role. 
Table 4-2 describes the permissions available for Multi-Mode Analysis 
Software.

4. Repeat steps 2 and 3 for each role being configured.
5. When all roles are configured as desired, select the Accounts tab.
6. In the Accounts tab, click the Create Account button or select an existing 

user account.
7. While ensuring the appropriate role is highlighted in the Accounts pane, 

in the Roles pane, select the desired roles to assign to the account 
(Figure 4-3).

Note: Refer to the Account Management online help for more detailed 
information. To access online help, press F1 or click the Help (question mark) 
button in the lower right corner of the Account Management window.
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Table4-1 Multi-Mode Analysis Software Default Roles

Role Description

Lab Administrator Contains all Multi-Mode Analysis Software permissions. Users 
assigned this role may perform all software actions.

Protocol Developer Contains the Multi-Mode Analysis Software Copy, Create, and 
Edit permissions. Users assigned this role may create and edit 
protocols, labware, and detection methods, but may not sign 
or delete items.

Lab Technician No Multi-Mode Analysis Software permissions are assigned. 
Users assigned this role may run protocols and view 
measurement results, but not create, edit, delete, or sign 
items or change instrument settings.

Table4-2 Multi-Mode Analysis Software Permissions

Permission Description

Add Instruments Allows users to manually add new simulated instruments to the 
Software.

Note: Auto-detected instruments are added to the list 
automatically when they are connected.

Add, edit, delete 
License Code

Allows users to add, edit, or delete license codes.

Change current 
Instrument

Allows user to set the current instrument. See Configuring the 
Current Instrument on page 54.

Copy Protocol, 
Labware, Method

Allows users to make copies of protocols, labware types, and 
detection methods.

Create Protocol, 
Labware, Method

Allows users to create protocols, labware types, and detection 
methods.

Delete all Items from 
Trash

Allows users to permanently remove all items in the Trash 
Selection List from the database.

Delete Protocol, 
Labware, Method, 
Result, Trash

Allows users to delete protocols, labware types, detection 
methods, results, and permanently remove individual items in 
the Trash Selection List from the database.

Edit Instrument 
Setting

Allows users to edit Instrument Settings. See Configuring and 
Controlling Instruments.

Edit Protocol, 
Labware, Method, 
Result

Allows users to edit protocols, labware types, detection 
methods, and results.

Optimize Labware Allows users to optimize labware. See Optimizing Labware on 
page 137.

Sign Protocol, 
Labware, Method, 
Result

Allows users to electronically sign protocols labware types, 
detection methods, and results. See Adding Electronic 
Signatures and Comments to Items on page 84.

View Audit Entry Allows users to view the Multi-Mode Analysis Software audit log 
using the Audit Viewer. See Viewing and Searching the Multi-
Mode Analysis Software Audit Log on page 83.
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Restoring the Administrator Password
Only one GxP Permissions administrator account exists on a system with GxP 
Permissions installed. If the administrator password is lost or forgotten, 
technical support must be contacted to restore access to the Account 
Management application.
To restore the administrator password:

1. Place the GxP Permissions CD in the drive, and browse to the contents 
of the CD.

2. Double-click on Administrator Password Restore.exe. The Administrator 
Password Restore dialog appears (Figure 4-4).

Figure 4-4 Administrator Password Restore Dialog

3. Contact technical support and provide the code displayed in the upper 
field of the Administrator Password Restore dialog. 

CAUTION! Leave the Administrator Password Restore dialog open until technical 
support supplies a new code. The new code is based on the code displayed in 
the upper field, which changes each time the Administrator Password Restore 
dialog is opened.

4. In the lower field of the Administrator Password Restore dialog, enter 
the new code provided by technical support.

5. Click OK to close the Administrator Password Restore dialog and accept 
the new code.

6. Follow any additional instructions provided by technical support.

Viewing the System Activity Audit Log
The system administrator may view the Audit Log, which displays the audit 
trail for all user activity in software applications that support GxP Permissions. 
System activity is logged, even when GxP Permissions is set to No Support. See 
Enabling GxP Permissions on page 73.

Note: Other than changing the level of support for GxP Permissions, 
Administrator activity is not saved in the Audit Log. Administrator activity is 
viewed in the Audit tab of the Account Management application.

Note: User activity within Multi-Mode Analysis Software may be viewed in the 
Audit Viewer. See Viewing and Searching the Multi-Mode Analysis Software 
Audit Log on page 83.
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To view the Audit Log:
1. In the Windows Start menu, select Settings > Control Panel. the Control 

Panel window appears.
2. In the Control Panel, double-click on Administrative Tools. The 

Administrative Tools window appears.
3. In the Administrative Tools window, double-click on Audit Log. The Audit 

Log appears (Figure 4-5).

Figure 4-5 GxP Permissions Audit Log

4. As desired, click Export to export the entire audit log to a text file. The 
exported file may be opened, read, and printed in any application that 
supports text files. 

Performing GxP Permissions User Actions in 
Multi-Mode Analysis Software
When GxP Permissions is enabled, users are required to log in to Multi-Mode 
Analysis Software. Permissions configured in the roles assigned to accounts 
determine which actions are available to users. The User Selection List 
provides access to GxP Permissions actions (Figure 4-6).
GxP Permissions user actions include:

• Logging On and Off the System on page 81
• Changing the Current User Password on page 82
• Viewing and Searching the Multi-Mode Analysis Software Audit Log on 

page 83
• Reactivating Disabled Message Boxes on page 83
• Adding Electronic Signatures and Comments to Items on page 84

Note: When the Audit Log is open while applications that support GxP 
Permissions are open, system activity is logged, but not refreshed on the 
screen automatically.
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Figure 4-6 Accessing User Actions

Logging On and Off the System

When GxP Permissions is enabled, users must log on before Multi-Mode 
Analysis Software or other installed applications that support GxP Permissions 
may be accessed. Only one user may be logged onto the system at time. Once 
logged in, the current user may access all applications installed on the system 
supported by GxP Permissions.
This section covers:

• Logging On the System on page 81 
• Logging Off the System on page 82 
• Handling Disabled Accounts on page 82 

Logging On the System 
When the software launches or is idle with no user logged on, the Logon dialog 
appears.
To log on the system:

1. Enter the desired account User Name and Password. 

2. Click OK. The user is logged on to the Multi-Mode Analysis Software and 
any other supported software applications installed on the system. The 
current user’s full name appears in the title bar next to instrument 
status (Figure 4-6).

Note: The first time a user logs on using a new account, or after having 
the password changed by the administrator, the Multi-Mode Analysis 
Software prompts for the password to be changed.

The new password must be different from the original and may include 
alphanumeric characters and spaces up to 250 characters in length. 
Passwords are not case sensitive.
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Logging Off the System 
The current user must log off the system before another user may log on. 
Logging off automatically logs the user off all installed applications that 
support GxP Permissions.
To log off the system and close the software:

• Select File > Exit. 
To log off the system and leave the software open for the next user:

1. In the navigation pane, click Users to access the User Selection List.
2. From the tool bar, click Log out current user. The user is logged out of the 

Multi-Mode Analysis Software and any other supported software 
applications installed on the system.
OR
From the menu bar select Actions > Log out current user.
OR
Right-click in the User Selection List and select Log out current user.

Handling Disabled Accounts 
The administrator may manually disable user accounts in Account 
Management, or configure accounts to be automatically disabled after a 
number of logon attempts for the account fail.
When an account is automatically disabled, an Administrator Notification 
appears. The administrator password must be entered before Multi-Mode 
Analysis Software may be accessed by the disabled account.

Changing the Current User Password
The user currently logged into the system may change their password.
To change the password:

1. In the navigation pane, click Users to access the User Selection List.
2. From the tool bar, click Change password of user currently logged in. The 

Change Password dialog appears.
OR
From the menu bar select Actions > Change password of user currently 
logged in.
OR
Right-click in the User Selection List and select Change password of user 
currently logged in.

3. In the upper field, enter the new password desired.
4. In the lower field, re-enter the new password to confirm.
5. Click OK to change the password.
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Viewing and Searching the Multi-Mode Analysis 
Software Audit Log
Users assigned a role with the View Audit Entry permission may view or search 
the audit log of user activity within Multi-Mode Analysis Software. Refer to 
Table 4-2 for more information about the permissions available to users.
The Multi-Mode Analysis Software audit log lists actions performed within the 
software only. To view a log of system-wide GxP Permissions activity, use the 
system Audit Log. See Viewing the System Activity Audit Log on page 79.
To view records in the log or search for specific records:

1. In the navigation pane, click Users to access the User Selection List.
2. From the tool bar, click View the audit log for this software. The Audit 

Viewer appears.
OR
From the menu bar select Actions > View the audit log for this software.
OR
Right-click in the User Selection List and select View the audit log for this 
software.

3. In Audit Viewer, perform the action desired. Table 4-3 describes the 
actions available.

Reactivating Disabled Message Boxes
Message boxes that have been disabled by users may be reactivated.

To reactivate disabled dialog boxes:
1. In the navigation pane, click Users to access the User Selection List.
2. From the tool bar, click Reactivate Disabled Message Boxes.

OR
From the menu bar select Actions > Reactivate Disabled Message Boxes.
OR
Right-click in the User Selection List and select Reactivate Disabled 
Message Boxes.

3. The Message dialog appears, confirming that the message boxes are 
reactivated.

Table4-3 Audit Log Actions

Action Description

Close Close the Audit Viewer.

Export Export records currently displayed in the Audit Viewer to an XML 
file.

Search Criteria Enter the desired search terms and click Go. All records containing 
matching terms are listed. Searching for terms within records may 
also be limited to specific dates configured in Date from...to.

Date from...to Limit the records displayed to those falling between the specified 
dates. Searching for records by date may also be combined with 
terms entered in Search Criteria.

Note: Message boxes are disabled by selecting Don't show this message again 
when the message box is displayed.
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Adding Electronic Signatures and Comments to Items
Protocols, measurement results, detection methods, and labware types may 
signed be by users assigned a role with the Sign permission. Signing an item 
adds a user's comments and electronic signature to the audit trail and 
prevents the item from being edited or deleted. An item may be signed 
multiple times by multiple users.
Users assigned a role with the Sign permission may also view existing 
signatures for signed items and unlock any signature attached to an item. An 
unlocked signature is deactivated and moved from Signatures to History; 
signatures are never permanently removed from the system. When all 
signatures for an item are unlocked, the item is no longer signed and may be 
edited again.
To sign an item or view or unlock an existing electronic signature:

1. From the desired Selection List, select the item to sign.
2. From the tool bar, click Sign the selected <item>.

OR
From the menu bar select Actions > Sign the selected <item>.
OR
Right-click on the selected item and select Sign the selected <item>.

3. The Sign the Selected Item dialog appears (Figure 4-7).

Figure 4-7 Signing an Item

4. Select the desired action: 
 Sign the item. See Signing Items on page 85.
 View or unlock an existing signature. See Viewing or Unlocking 

Signatures for an Item on page 85.
 View unlocked signatures. See Viewing Unlocked Signatures on 

page 86.
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Signing Items

To sign an item:
1. In the Sign tab, enter a Comment. A comment is required to complete 

an electronic signature.
2. Select the type of signature: Sign or Approved. The selected type is 

saved in the audit trail.
3. If the Password field is visible, enter the password for the user account.

4. Click OK to sign the item.

Viewing or Unlocking Signatures for an Item

Users assigned a role with the Sign permission may view active signatures for 
an item in the Signatures tab. Users with the Sign permission may also unlock 
any signature attached to an item. An unlocked signature is deactivated and 
moved from Signatures to History. Signatures are never permanently removed 
from the system. Unlocking all signatures attached to an item allows the item 
to be edited again.
To view existing signatures:

1. Select the desired item and open Sign the Selected Item following the 
steps in Adding Electronic Signatures and Comments to Items on 
page 84.

2. Select the Signatures tab (Figure 4-8).

Figure 4-8 Viewing Active Signatures

Note: Passwords are required only when GxP Permissions, with 
password checks for signing and check-in is the selected support level. 
See Enabling GxP Permissions on page 73.
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3. Click on the + or - to the left of a signature to expand or collapse 
details about the signature. Details for each signature are listed on four 
lines: 
 date and time signature was entered
 the full name of the user signing the item
 user comments
 version of the item

4. If the Password field is visible, enter the password for the user account. 

5. To unlock the selected signature, click Unlock. Unlocked signatures can 
be viewed in the History tab.

Viewing Unlocked Signatures

Unlocked signatures are never permanently removed from the system. Users 
assigned a role with Sign permission may view unlocked signatures for an item 
in the History tab.

1. Select the desired item and open the Sign the Selected Item dialog 
following the steps in Adding Electronic Signatures and Comments to 
Items on page 84.

2. Select the History tab.
3. Click on the + or - to the left of a signature to expand or collapse 

details about the signature. Details for each signature are listed on four 
lines: 
 date and time the signature was created
 date and time the signature was unlocked
 the full name of the user signing the method
 comments entered by the use
 version of the item

Note: Passwords are required only when GxP Permissions, with 
password checks for signing and check-in is the selected support level. 
See Enabling GxP Permissions on page 73.
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Creating and Editing Detection Methods
Overview
Multi-Mode Analysis Software stores measurement configuration parameters in 
detection methods. Stored parameters include the method technique (for 
example, absorbance), FilterMax Filters or SpectraMax Paradigm Detection 
Cartridges used, and parameters specific to the selected method, such as 
integration time. The software supports absorbance, luminescence, and 
fluorescence method techniques. The method techniques available for 
configuration depend on the capabilities of the instrument being controlled.
Detection methods are created and edited using the Method Editor. Configured 
detection methods are listed in the Detection Method Selection List and are 
available for use in measurement protocols. See Creating and Running 
Protocols on page 145.

Viewing Available Detection Methods
To view available detection methods and access the Method Editor:
From the navigation pane, select Detection Methods. The Detection Method 
Selection List appears (Figure 5-1) containing detection methods for the 
currently selected instrument. To change the current instrument see 
Configuring the Current Instrument on page 54.

Figure 5-1 Accessing Detection Method Actions

Note: When GxP Permissions is enabled on the system, only users assigned 
with Sign, Copy, Create, Delete, and Edit permissions may perform all of the 
actions covered in this section. See Configuring Roles for Multi-Mode Analysis 
Software User Accounts on page 76 for more information about roles and 
permissions.
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All detection method functions are accessed from the Detection Method 
Selection List. Available detection method functions are:

• Creating Detection Methods (FilterMax Multi-Mode Microplate Readers) 
on page 88

• Creating Detection Methods (SpectraMax Paradigm Multi-Mode 
Detection Platform) on page 99

• Editing Detection Methods on page 123
• Copying Detection Methods on page 124
• Deleting Detection Methods on page 124
• Exporting and Importing Detection Methods on page 125

Creating Detection Methods (FilterMax Multi-Mode 
Microplate Readers)

Detection methods are created in the Method Editor, which guides the creation 
process with a wizard-type interface. Creating a new detection method 
requires:

• Selecting a Method Technique (FilterMax Multi-Mode Microplate 
Readers) on page 89

• Selecting the Method Type (FilterMax Multi-Mode Microplate Readers) 
on page 90
The Method Type is configured for absorbance detection methods only

• Defining Method Parameters (FilterMax Multi-Mode Microplate Readers) 
on page 91

• Signing a Detection Method (FilterMax Multi-Mode Microplate Readers) 
on page 98 (Optional)
This is used to prevent methods from being edited or deleted. Methods 
can be signed only when GxP Permissions is enabled on the system.

To create and define a new detection method:
1. Click the Detection Methods selection list button.
2. From the tool bar, click Create.

OR
From the menu bar select Actions > Create a new method.
OR
Right-click in the Detection Method Selection List and select Create a 
new method.

3. The Method Editor appears (Figure 5-2).

Note: For the SpectraMax Paradigm Multi-Mode Detection Platform, detection 
methods will only display as enabled if the detection cartridge is listed within 
My Detection Cartridges. See Defining and Editing the Available Detection 
Cartridges on page 66.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Create permission may create new detection methods.

To sign detection methods, users must be assigned a role containing the Sign 
permission. See Configuring Roles for Multi-Mode Analysis Software User 
Accounts on page 76 for more information about roles and permissions.
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Selecting a Method Technique (FilterMax 
Multi-Mode Microplate Readers)
In the Method Editor, the type of detection method to create is selected in 
Method Technique (Figure 5-2). Only techniques supported by the instrument 
currently selected in the Instrument Selection List are available for 
configuration. See Configuring and Controlling Instruments on page 51.

Figure 5-2 Selecting a Method Technique

To select a method technique:
1. In Supported techniques, select the desired detection method.
2. If defining an absorbance method, click Next to select the Method Type. 

See Selecting the Method Type (FilterMax Multi-Mode Microplate 
Readers) on page 90.
OR
If defining a luminescence or fluorescence method, click Next to define 
Method Parameters. See Defining Method Parameters (FilterMax Multi-
Mode Microplate Readers) on page 91.
5008530 A 89 



Creating and Editing Detection Methods
Selecting the Method Type (FilterMax 
Multi-Mode Microplate Readers)
When defining an absorbance detection method, use Method Type to select 
whether a monochromatic or bichromatic method will be defined (Figure 5-3).

Figure 5-3 Selecting an Absorbance Method Type

To select a method type:
1. In the Method Editor, click on Method Type.
2. Select the desired method: Monochromatic or Bichromatic.

If you want to use PathCheck® Pathlength Measurement Technology, 
select Monochromatic. See PathCheck® Pathlength Measurement 
Technology on page 245.

3. Click Next to define Method Parameters. See Defining Method 
Parameters (FilterMax Multi-Mode Microplate Readers) on page 91.

Note: Method Type appears only when defining absorbance methods.

Note: Monochromatic methods perform a single-wavelength 
measurement.

Bichromatic methods perform a second measurement at a reference 
wavelength, which is subtracted from the first to calculate the final 
result.
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Defining Method Parameters (FilterMax 
Multi-Mode Microplate Readers)
Detection method parameters, such as filters and integration time, are defined 
in Method Parameters. The parameters available for configuration depend on 
the technique selected in Method Technique. See Selecting a Method Technique 
(FilterMax Multi-Mode Microplate Readers) on page 89.
Use Method Parameters for:

• Defining Absorbance Method Parameters on page 91
• Defining Luminescence Method Parameters on page 92
• Defining Fluorescence Intensity Top Method Parameters on page 93
• Defining Fluorescence Intensity Bottom Method Parameters (FilterMax 

5 Multi-Mode Microplate Reader only) on page 95
• Defining Fluorescence Polarization Method Parameters (FilterMax 5 

Multi-Mode Microplate Reader only) on page 96
• Defining Time-Resolved Fluorescence Method Parameters (FilterMax 5 

Multi-Mode Microplate Reader only) on page 97

Defining Absorbance Method Parameters

A monochromatic absorbance method performs an absorbance measurement 
at a single wavelength. A bichromatic method performs a second 
measurement at a reference wavelength. This measurement is subtracted 
from the first to calculate the final result.

Figure 5-4 Defining Absorbance Method Parameters
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To define absorbance method parameters:
1. Enter a Method Name (Figure 5-4).

2. In the Excitation Wavelength (nm) field, select the measurement filter.
The PathCheck Pathlength Measurement Technology requires a filter 
of 900 nm and 998 nm. See Defining and Editing Filter Slides on 
page 58.

3. If a bichromatic measurement is being defined, in the Reference 
Excitation Filter (nm) field, select the reference filter. 

4. To enable PathCheck Pathlength Measurement Technology, select the 
PathCheck Enabled check box. See PathCheck® Pathlength 
Measurement Technology on page 245.

5. Click Save to save the new absorbance detection method. The new 
method appears in the Detection Method Selection List.

Defining Luminescence Method Parameters

A luminescence method performs glow luminescence measurements on 
samples. Generally, luminescence measurements do not require a filter; 
however, cutoff filtration using an emission filter may be specified to eliminate 
photoluminescence generated by the microplate itself, if desired.

Figure 5-5 Defining Luminescence Method Parameters

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example an 
absorbance measurement @ 260 ms might read ABS_260.

Note: The filters available are those installed on the excitation filter 
slide loaded in the instrument and configured for absorbance 
techniques in Instrument Settings. See Defining and Editing Filter 
Slides on page 58.
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To define luminescence method parameters:
1. Enter a Method Name (Figure 5-5).

2. In the Emission Filter (nm) field, select 0 when no cutoff filtration is 
desired. Most luminescence measurements do not require cutoff 
filtration.
OR
In the Emission Filter (nm) field, select the cutoff filter. 

3. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) the signal is collected from samples. Set 
the integration time within the range of 50 µseconds to 3600 seconds.

4. Click Save to save the new luminescence detection method. The new 
method appears in the Detection Method Selection List.

Defining Fluorescence Intensity Top Method Parameters

In a fluorescence intensity top method, the source light is focused by an 
objective lens and directed through an excitation filter above the plate. The 
filter passes only the wavelength necessary to excite samples. The objective 
lens collects the resulting fluorescence and directs it through an emission filter 
to separate background light from the specific wavelengths generated by 
samples. This signal is detected by the photo multiplier tube. When performing 
a fluorescence intensity top method on a FilterMax 5 Multi-Mode Microplate 
Reader, excitation of samples from below the plate is stopped.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example a 
luminescence measurement @ 400 ms might read LUM_400.

Note: The filters available are those installed on the emission filter slide 
loaded in the instrument and configured for luminescence techniques in 
Instrument Settings. See Defining and Editing Filter Slides on 
page 58.
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Figure 5-6 Defining Fluorescence Intensity Top Method Parameters

To define fluorescence intensity top method parameters:
1. Enter a Method Name (Figure 5-5).

2. Select the Excitation Filter (nm).
3. Select the Emission Filter (nm).

4. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) the signal is collected from samples. Set 
the integration time within the range of 50 µseconds to 3600 seconds.

5. Click Save to save the new fluorescence intensity top detection method. 
The new method appears in the Detection Method Selection List.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example a 
fluorescence intensity top measurement @ 400 ms might read 
FI_T_400.

Note: The filters available are those installed on the slides loaded in the 
instrument and configured for fluorescence techniques in Instrument 
Settings. See Defining and Editing Filter Slides on page 58.
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Defining Fluorescence Intensity Bottom Method Parameters 
(FilterMax 5 Multi-Mode Microplate Reader only)

In a fluorescence intensity bottom method, the source light is directed through 
an excitation filter, which passes only the wavelengths necessary to excite 
samples, and focused by an objective lens below the plate. The objective lens 
collects the resulting fluorescence from below the plate and directs it through 
an emission filter to separate background light from the specific wavelengths 
generated by samples. This signal is detected by the photo multiplier tube. 
When performing a fluorescence intensity bottom method on a FilterMax 5 
Multi-Mode Microplate Reader, excitation of samples from above the plate is 
stopped.

Figure 5-7 Defining Fluorescence Intensity Bottom Method Parameters

To define fluorescence intensity bottom method parameters:
1. Enter a Method Name (Figure 5-7).

2. Select the Excitation Filter (nm).
3. Select the Emission Filter (nm).

4. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) the signal is collected from samples. Set 
the integration time within the range of 50 µseconds to 3600 seconds.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example a 
fluorescence intensity bottom measurement @ 400 ms might read 
FI_B_400.

Note: The filters available are those installed on the slides loaded in the 
instrument and configured for fluorescence techniques in Instrument 
Settings. See Defining and Editing Filter Slides on page 58.
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5. Click Save to save the new fluorescence intensity bottom detection 
method. The new method appears in the Detection Method Selection 
List.

Defining Fluorescence Polarization Method Parameters 
(FilterMax 5 Multi-Mode Microplate Reader only)

A fluorescence polarization method measures two orthogonal (perpendicular) 
polarization states by performing two sequential fluorescence intensity 
measurements from above the plate.
Light is directed through an excitation filter (which passes only the wavelength 
necessary for excitation) and a polarizing filter. The fluorescence resulting from 
the excitation of the sample is passed through two emission filters equipped 
with polarizing filters to distinguish the parallel and perpendicular polarization 
states.
The polarized signals are then detected sequentially by the photo multiplier 
tube.

Figure 5-8 Defining Fluorescence Polarization Method Parameters

To define fluorescence polarization parameters:
1. Enter a Method Name (Figure 5-8).

Note: The read direction settings configured in a protocol determine when 
polarization states are measured during a run. See Configuring Labware 
Layout Settings on page 151. 

When Read by well is selected, both states are measured for each sample 
before proceeding to the next sample. When Read by row or Read by column is 
selected, the parallel states are measured for all samples in a row or column 
before measuring the perpendicular states of the same group of samples.
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2. Select the Excitation Wavelength (nm).
3. Select the Emission Wavelength (nm).

4. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) the signal is collected from samples. Set 
the integration time within the range of 50 µseconds to 3600 seconds.

5. Click Save to save the new fluorescence polarization detection method. 
The new method appears in the Detection Method Selection List.

Defining Time-Resolved Fluorescence Method Parameters 
(FilterMax 5 Multi-Mode Microplate Reader only)

In a time-resolved fluorescence measurement, the excitation light source is 
turned off and the measurement is performed from above the plate after a 
specified delay. Several of these excitation/measurement cycles may be 
performed on each sample. When multiple excitation/measurement cycles are 
performed, the results from all cycles are used to calculate a single 
measurement result for each sample.

Figure 5-9 Defining Time-Resolved Fluorescence Method Parameters

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example an 
fluorescence polarization measurement @ 400 ms might read FP_400.

Note: The wavelength filters available are those installed on the 
excitation and emission wavelength filter slides loaded in the 
instrument and configured for fluorescence polarization techniques in 
Instrument Settings. See Defining and Editing Filter Slides on 
page 58.
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To define time-resolved fluorescence parameters:
1. Enter a Method Name (Figure 5-9).

2. Select the Excitation Wavelength (nm).
3. Select the Emission Wavelength (nm).

4. In the Pulse Length field, enter the length of time (in seconds, 
milliseconds, or microseconds) that the LED light source remains 
turned on.

5. In the Number of Pulses field, enter the number of 
excitation/measurement cycles performed for each well in the 
measurement. The number of pulses sets the exposure received by 
samples during measurements.

6. In the Measurement Delay field, enter the interval (in seconds, 
milliseconds, or microseconds) between switching off the light source 
and performing the measurement. Set the delay within the range of 
1 µs to 7.5 ms.

7. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) each sample is measured. Set the 
integration time within the range of 50 µs to 7.5 ms.

8. Click Save to save the new time-resolved fluorescence detection 
method. The new method appears in the Detection Method Selection 
List.

Signing a Detection Method (FilterMax 
Multi-Mode Microplate Readers)
When GxP Permissions is enabled on the controlling computer system, 
detection methods may be signed to prevent methods from being edited or 
deleted. Detection methods may be signed at any time after the configuration 
is complete.
Detection methods may be signed by users who are assigned a role containing 
the Sign permission. See Configuring Roles for Multi-Mode Analysis Software 
User Accounts on page 76 for more information about roles and permissions.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example a time-
resolved fluorescence measurement @ 0.89 ms might read TRF_0.89.

Note: The wavelength filters available are those installed on the 
excitation and emission wavelength filter slides loaded in the 
instrument and configured for time-resolved fluorescence techniques in 
Instrument Settings. See Defining and Editing Filter Slides on 
page 58.
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To sign labware:
1. In the Detection Method Selection List, select the detection method to 

sign.
2. From the tool bar, click Sign the selected method.

OR
From the menu bar select Actions > Sign the selected method.
OR
Right click on the selected labware and select Sign the selected method.

3. The Sign the Selected Item dialog appears.
4. In the Sign the Selected Item dialog, add comments and an electronic 

signature by following the instructions in Adding Electronic Signatures 
and Comments to Items on page 84.

Creating Detection Methods (SpectraMax Paradigm 
Multi-Mode Detection Platform)

Detection methods are created in the Method Editor, which guides the creation 
process with a wizard-type interface. Creating a new detection method 
requires:

• Selecting a Detection Cartridge (SpectraMax Paradigm Multi-Mode 
Detection Platform) on page 100 

• Selecting the method technique, configuring the method type 
(absorbance detection methods only), and defining method parameters 
based upon the selected cartridge:
 Absorbance (ABS) Detection Cartridge on page 101 
 Fluorescence Polarization (FP) Detection Cartridge on page 102 
 Multi-Mode (MULTI) Detection Cartridge on page 104 
 Fluorescence Intensity (FI) Detection Cartridge on page 109 
 Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection 

Cartridge on page 110 
 Time Resolved Fluorescence (TRF) Detection Cartridge on page 112 
 Cisbio HTRF® Detection Cartridge on page 116 
 Luminescence (LUM) Detection Cartridge on page 118 
 AlphaScreen Detection Cartridge on page 121 

• Signing a Detection Method (SpectraMax Paradigm Multi-Mode 
Detection Platform) on page 122 (Optional)
This is used to prevent methods from being edited or deleted. Methods 
can only be signed when GxP Permissions is enabled on the system 

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Create permission may create new detection methods.

To sign detection methods, users must be assigned a role containing the Sign 
permission. See Configuring Roles for Multi-Mode Analysis Software User 
Accounts on page 76 for more information about roles and permissions.
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To create and define a new detection method:
1. From the tool bar, click Create.

OR
From the menu bar select Actions > Create a new method.
OR
Right-click in the Detection Method Selection List and select Create a 
new method.

2. The Method Editor appears (Selecting a Detection Cartridge 
(SpectraMax Paradigm Multi-Mode Detection Platform) on page 100).

Selecting a Detection Cartridge (SpectraMax Paradigm 
Multi-Mode Detection Platform)
In the Method Editor, the detection cartridges contained within My Detection 
Cartridges display in the detection cartridge list (Figure 5-10). Detection 
cartridges installed on the machine, but not within My Detection Cartridges are 
not displayed in the detection cartridge list. See Defining and Editing the 
Available Detection Cartridges on page 66.

Figure 5-10 Selecting a Detection Cartridge
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To select a detection cartridge:
1. In the Detection Cartridge field, select the desired detection cartridge.
2. Define the Method Technique, Method Type (for absorbance detection 

cartridges), and Method Parameters based upon the selected cartridge: 
 Absorbance (ABS) Detection Cartridge on page 101 
 Fluorescence Polarization (FP) Detection Cartridge on page 102 
 Multi-Mode (MULTI) Detection Cartridge on page 104 
 Fluorescence Intensity (FI) Detection Cartridge on page 109 
 Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection 

Cartridge on page 110 
 Time Resolved Fluorescence (TRF) Detection Cartridge on page 112 
 Cisbio HTRF® Detection Cartridge on page 116 
 Luminescence (LUM) Detection Cartridge on page 118 
 AlphaScreen Detection Cartridge on page 121 

Absorbance (ABS) Detection Cartridge

To create an absorbance detection method using an absorbance detection 
cartridge:

1. The only supported method technique using an absorbance detection 
cartridge is absorbance. Click Next in Method Technique to define the 
Method Type.

2. When defining an absorbance detection method, use Method Type to 
select whether a Monochromatic or WavelengthScan method will be 
defined (Figure 5-11).
 A Monochromatic absorbance method performs an absorbance 

measurement at a single wavelength.
 A WavelengthScan absorbance method performs a series of 

absorbance measurement scans within a specified range configured 
in the protocol.

Note: For additional information regarding absorbance detection cartridges 
please see the detection cartridge’s user guide.
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Figure 5-11 Absorbance Detection Cartridge Method Type

3. Click Next to define the Method Parameters.
4. In the Method Name field, enter a name for the method. 

5. For a Monochromatic absorbance method, in the Excitation Wavelength 
(nm) field, specify the wavelength.
OR
For a Wavelength Scan absorbance method, in the Minimum Wavelength 
(nm) and Maximum Wavelength (nm) fields, specify the wavelength.

6. To enable PathCheck Pathlength Measurement Technology, select the 
PathCheck Enabled check box. See PathCheck® Pathlength 
Measurement Technology on page 245.

7. Click Save to save the new absorbance detection method. The new 
method appears in the Detection Method Selection List.

Fluorescence Polarization (FP) Detection Cartridge

A fluorescence polarization method measures two orthogonal (perpendicular) 
polarization states by performing two simultaneous fluorescence intensity 
measurements from above the plate.
Light is directed through an excitation filter, which passes only the wavelength 
necessary for excitation, and a polarizing filter. The fluorescence resulting from 
the excitation of the sample is passed through two emission filters equipped 
with polarizing filters to distinguish the parallel and perpendicular polarization 
states.
The polarized signals are then detected simultaneously by the photo multiplier 
tubes.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example a 
monochromatic measurement @ 260 might read ABS_260, while an 
Absorbance scan measurement between 260 -360 might read 
ABS_260-350 Scan.
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To create a fluorescence polarization detection method using a fluorescence 
polarization detection cartridge:

1. The only supported method technique using a fluorescence polarization 
detection cartridge is fluorescence polarization. Click Next to define the 
Method Parameters (Figure 5-12).

Figure 5-12 Fluorescence Polarization Detection Cartridge Method 
Parameters

2. In the Method Name field, enter a name for the method. 

3. Optionally, to use on-the-fly detection select On the Fly Detection. 

4. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

Note: For additional information regarding the fluorescence polarization 
detection cartridges please see the detection cartridge’s user guide.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example an 
fluorescence polarization measurement @ 400 ms might read FP_400.

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.
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OR
Specify the measurement time per well (in seconds, milliseconds, or 
microseconds) using the Integration Time field.

5. Click Save to save the new fluorescence polarization detection method. 
The new method appears in the Detection Method Selection List.

Multi-Mode (MULTI) Detection Cartridge

The Multi-Mode detection cartridge allows for three detection techniques:
• Luminescence: A luminescence method performs glow luminescence 

measurements on samples.
• Fluorescence Intensity: In a fluorescence intensity method, the source 

light is focused by an objective lens and directed through an excitation 
filter above or below the plate. The filter passes only the wavelength 
necessary to excite samples. The objective lens collects the resulting 
fluorescence and directs it through an emission filter to separate 
background light from the specific wavelengths generated by samples. 
This signal is detected by the photo multiplier tubes. When performing 
a fluorescence intensity method on a SpectraMax Paradigm Multi-Mode 
Detection Platform, excitation of samples from below the plate may be 
stopped depending on the mounting position of the Multi-Mode 
detection cartridge.

• Time Resolved Fluorescence: In a time-resolved fluorescence 
measurement, the excitation light source is turned off and the 
measurement is performed from above the plate after a specified delay. 
Several of these excitation/measurement cycles may be performed on 
each sample. When multiple excitation/measurement cycles are 
performed, the results from all cycles are used to calculate a single 
measurement result for each sample.

Note: Selecting Speed results in the fastest possible read time per 
plate. However there is a trade-off between the data quality (for 
example, CVs vs. dynamic range) and read speed because each well is 
sampled for shorter integration times. Selecting Performance results in 
a faster read time than not using On the Fly Detection, but not as fast as 
the Speed mode. Performance provides considerably better results than 
Speed for demanding assays.

Note: It is necessary for the detection cartridge to be installed in the Upper 
Read Detection Cartridge Transport for Fluorescence Intensity Top Detection 
Methods and in the Lower Read Detection Cartridge Transport for 
Fluorescence Intensity Bottom Detection Methods.

Note: For additional information regarding the Multi-Mode detection cartridge 
please see the detection cartridge’s user guide.
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To create a detection method using the Multi-Mode detection cartridge:
• In the supported technique select from Luminescence, Fluorescence 

Intensity Top, Fluorescence Intensity Bottom, or Time Resolved 
Fluorescence (Figure 5-13).

Figure 5-13 Multi-Mode Detection Cartridge Method Technique

For Luminescence (Figure 5-14):
1. Before using the Luminescence technique, determine whether to take 

measurements using the On the Fly Detection feature. 

2. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

3. If not using on-the-fly detection, specify the measurement time per 
well (in seconds, milliseconds, or microseconds) using the Integration 
Time field.

4. Click Save to save the new luminescence detection method. The new 
method appears in the Detection Method Selection List.

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.

Note: Selecting Speed results in the fastest possible read time per 
plate. However there is trade-off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.
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Figure 5-14 Luminescence Method Parameters

For Fluorescence Intensity Top or Fluorescence Intensity Bottom (Figure 5-15):
1. Before using the Fluorescence Intensity Top or Fluorescence Intensity 

Bottom techniques, determine whether to take measurements using 
the On the Fly Detection feature. 

2. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

3. If not using on-the-fly detection, specify the measurement time per 
well (in seconds, milliseconds, or microseconds) using the Integration 
Time field.

4. Click Save to save the new fluorescence intensity detection method. 
The new method appears in the Detection Method Selection List.

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.

Note: Selecting Speed results in the fastest possible read time per 
plate. However there is trade-off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.
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Figure 5-15 Fluorescence Intensity Bottom Method Parameters

For Time Resolved Fluorescence (Figure 5-17):
1. Before using the Time Resolved Fluorescence technique, determine 

whether to take measurements using the On the Fly Detection feature. 

2. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

3. In the Method Name field, enter a name for the method.
4. In the Pulse Length field, enter the length of time (in seconds, 

milliseconds, or microseconds) that the LED light source remains 
turned on (t1 on Figure 5-16).

5. If On the Fly Detection is not selected, in the Number of Pulses field, enter 
the number of excitation/measurement cycles performed in the 
measurement. The number of pulses sets the exposure received by 
samples during measurements.

6. In the Measurement Delay field, enter the interval between (in seconds, 
milliseconds, or microseconds) switching off the light source and 
performing the measurement (t2 on Figure 5-16).

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.

Note: Selecting Speed results in the fastest possible read time per 
plate. However there is trade-off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.
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7. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) each sample is measured. Set the 
integration time within the range of 50 µs to 7.5 ms (t3 on 
Figure 5-16).

Figure 5-16 Time Resolved Fluorescence

8. Click Save to save the new time resolved fluorescence detection 
method. The new method appears in the Detection Method Selection 
List. 

Figure 5-17 Time Resolved Fluorescence Method Parameters

Note: Measurement Delay + Integration Time + Pulse Delay => Minimum 
Pulse Period (t2 + t3 + t4 => t5)
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Fluorescence Intensity (FI) Detection Cartridge

In a fluorescence intensity detection method, the source light is focused by an 
objective lens and directed through an excitation filter above or below the 
plate, depending upon the mounting position of the cartridge. Reading of the 
plate is determined by the method type, fluorescence intensity top methods 
read above the plate and fluorescence intensity top methods read below the 
plate. The filter passes only the wavelength necessary to excite samples. The 
objective lens collects the resulting fluorescence and directs it through an 
emission filter to separate background light from the specific wavelengths 
generated by samples. This signal is detected by the photo multiplier tube.

To create a fluorescence intensity detection method using a fluorescence 
intensity detection cartridge:

1. In the Supported technique field select Fluorescence Intensity Dual-Label, 
FRET, Fluorescence Intensity Top, or Fluorescence Intensity Bottom.

2. Click Next to define the Method Parameters (Figure 5-18).

Figure 5-18 Fluorescence Intensity Detection Cartridge Method 
Parameters

3. In the Method Name field, enter a name for the method. 

Note: It is necessary for the Fluorescence Intensity detection cartridge to be 
installed in the Upper Read Detection Cartridge Transport for the 
Fluorescence Intensity Top Detection Method. It is necessary for the 
Fluorescence Intensity detection cartridge to be installed in the Bottom Read 
Detection Cartridge Transport for the Fluorescence Intensity Bottom detection 
method.

Note: For additional information regarding the fluorescence intensity 
detection cartridge please see the detection cartridge’s user guide.
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4. To use on-the-fly detection select On the Fly Detection. 

5. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

6. Specify the measurement time per well (in seconds, milliseconds, or 
microseconds) using the Integration Time field.

7. Click Save to save the new fluorescence intensity detection method. 
The new method appears in the Detection Method Selection List.

Fluorescence Intensity Dual Label (FI-DL) 
(MultiTox-Fluor) Detection Cartridge

In a fluorescence intensity dual-label detection method, the source light is 
focused by an objective lens and directed through an excitation filter above or 
below the plate, depending upon the mounting position of the cartridge. The 
filter passes only the wavelength necessary to excite samples. The objective 
lens collects the resulting fluorescence and directs it through an emission filter 
to separate background light from the specific wavelengths generated by 
samples. This signal is detected by the photo multiplier tubes.

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example, an 
absorbance measurement @ 260 might read ABS_260.

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.

Note: Selecting Speed results in the fastest possible read time per 
plate. However, there is trade off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.

Note: It is necessary for the Fluorescence Intensity Dual Label (FI-DL) 
(MultiTox-Fluor) Detection Cartridge to be installed in the Upper Read 
Detection Cartridge Transport for reading from above the plate. It is 
necessary for the Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) 
Detection Cartridge to be installed in the Bottom Read Detection Cartridge 
Transport for reading from the below plate.

Note: For additional information regarding the Fluorescence Intensity Dual 
Label (FI-DL) (MultiTox-Fluor) Detection Cartridge, please see the detection 
cartridge user guide.
110 5008530 A 



Multi-Mode Analysis Software User Guide
To create a fluorescence intensity dual-label detection method using a 
Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) Detection 
Cartridge:

1. In the Supported technique field, select Fluorescence Dual-Label. Other 
detection methods might be available also, such as FRET, Fluorescence 
Intensity Top, or Fluorescence Intensity Bottom.

2. Click Next to define the Method Parameters (Figure 5-19).

Figure 5-19 Fluorescence Intensity Dual Label (FI-DL) (MultiTox-Fluor) 
Detection Cartridge Method Parameters

3. In the Method Name field, enter a name for the method.

4. To use on-the-fly detection select On the Fly Detection. 

5. If using on-the-fly detection, specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

6. Specify the measurement time per well (in seconds, milliseconds, or 
microseconds) using the Integration Time field.

Note: When naming detection methods, it is important to use a 
consistent and informative naming convention. For example, an 
absorbance measurement @ 260 might read ABS_260.

Note: On the Fly Detection yields considerably faster read times since 
the plate moves continuously as each well is measured, as opposed to 
the stop and go mode where the plate stops moving for each read.

Note: Selecting Speed results in the fastest possible read time per 
plate; however, there is trade off between the data quality (that is, CVs 
or dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.
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7. Click Save to save the new fluorescence intensity dual-label detection 
method. The new method appears in the Detection Method Selection 
List.

Time Resolved Fluorescence (TRF) Detection Cartridge

In a time resolved fluorescence measurement, the excitation light source is 
turned off and the measurement is performed from above the plate after a 
specified delay. Several of these excitation/measurement cycles may be 
performed on each sample. When multiple excitation/measurement cycles are 
performed, the results from all cycles are used to calculate a single 
measurement result for each sample.
The time resolved fluorescence measurement cycle consists of five parts:

• Pulse Length: the time that the excitation light source is turned on (t1 
on Figure 5-19).

• Measurement Delay: the time between the excitation light source being 
turned off and when the measurement begins (t2 on Figure 5-19).

• Integration Time: the measurement time (t3 on Figure 5-19).
• Pulse Delay: the time between the measurement stopping (integration 

time) and when the excitation light source is turned on for the next 
measurement (t4 on Figure 5-19). This value is read only and is 
adjusted based upon the Minimum Pulse Period, Measurement Delay, 
and Integration time.

• Minimum Pulse Period: The minimum time required between the 
excitation light source being turned off and when the excitation light 
source is turned on again (t5 on Figure 5-19). This value is based upon 
each detection cartridge and is not editable.

Figure 5-20 Time Resolved Fluorescence

Note: Measurement Delay + Integration Time + Pulse Delay  Minimum 
Pulse Period (t2 + t3 + t4  t5)
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The dual-time resolved fluorescence measurement cycle consists of seven 
parts:

• Pulse Length: the time that the excitation light source is turned on (t1 
on Figure 5-20).

• Measurement Delay (First Window): the time between the excitation light 
source being turned off and when the first measurement begins (t2 on 
Figure 5-20).

• Integration Time (First Window): the measurement time (t3 on 
Figure 5-20) that each sample is measured for the first time.

• Measurement Delay (Second Window): the time between the excitation 
light source being turned off and when the second measurement begins 
(t2+t3+t6 on Figure 5-20).

• Integration Time (Second Window): the measurement time (t7 on 
Figure 5-20) each sample is measured the second time.

• Pulse Delay: the time between the measurement stopping (integration 
time) and when the excitation light source is turned on for the next 
measurement (t4 on Figure 5-20). This value is read only and is 
adjusted based upon the Minimum Pulse Period, Measurement Delay, 
and Integration time.

• Minimum Pulse Period: The minimum time required between the 
excitation light source being turned off and when the excitation light 
source is turned on again (t5 on Figure 5-20). This value is based upon 
each detection cartridge and is not editable.

Figure 5-21 Dual-Time Resolved Fluorescence

Note: First Measurement Delay + First Integration Time + Second 
Measurement Delay + Second Integration Time + Pulse Delay  
Minimum Pulse Period (t2 + t3 + t6 + t7 + t4   t5)

Note: For additional information regarding the time resolved fluorescence 
detection cartridge please see the detection cartridge’s user guide.
5008530 A 113 



Creating and Editing Detection Methods
To create a time resolved fluorescence detection method using a time resolved 
fluorescence enabled detection cartridge:

1. If applicable, in the Supported Technique field select Time Resolved 
Fluorescence or Time Resolved Fluorescence Dual.

2. If applicable, in the Wavelengths field specify the Excitation and 
Emission Wavelength.

3. Click Next to define the Method Parameters (Figure 5-21).

Figure 5-22 Time Resolved Fluorescence Method Parameters - Time 
Resolved Fluorescence

4. In the Method Name field, enter a name for the method. 

5. To use on-the-fly detection select On the Fly Detection. 

6. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example an 
absorbance measurement @ 260 might read ABS_260, while an 
Absorbance scan measurement between 260 -360 might read 
ABS_260-350 Scan.

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.
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7. In the Pulse Length field, enter the length of time (in seconds, 
milliseconds, or microseconds) that the light source remains turned on 
(t1 in Figure 5-19 and Figure 5-20).

8. If On the Fly Detection is not selected, in the Number of Pulses field, enter 
the number of excitation/measurement cycles performed in the 
measurement. The number of pulses sets the exposure received by 
samples during measurements.

9. In the Measurement Delay field, enter the time interval (in seconds, 
milliseconds, or microseconds) between switching off the light source 
and performing the measurement (t2 in Figure 5-19 and Figure 5-20).

10. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) each sample is measured. Set the 
integration time within the range of 10 µs to 10 ms (t3 in Figure 5-19 
and Figure 5-20).

11. For dual time resolved fluorescence, in the second Measurement Delay 
field, enter the time interval (in seconds, milliseconds, or 
microseconds) between switching off the light source and performing 
the second measurement (t2+t3+t6 in Figure 5-20).

12. For dual time resolved fluorescence, in the second Integration Time 
field, enter the length of time (in seconds, milliseconds, or 
microseconds) each sample is measured the second time. Set the 
integration time within the range of 10 µs to 10 ms (t7 in Figure 5-20).

13. Click Save to save the new time resolved fluorescence detection 
method. The new method appears in the Detection Method Selection 
List.

Note: Selecting Speed results in the fastest possible read time per 
plate. However, there is trade off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.
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Cisbio HTRF® Detection Cartridge

HTRF (homogeneous time resolved fluorescence) is a measurement technique 
based upon fluorescence resonance energy transfer (FRET) using the 
advantage of time resolved florescence.
The homogeneous time resolved fluorescence measurement cycle consists of 
five parts:

1. Pulse Length: the time that the excitation light source is turned on (t1 
on Figure 5-22).

2. Measurement Delay: the time between the excitation light source being 
turned off and when the measurement begins (t2 on Figure 5-22).

3. Integration Time: the measurement time (t3 on Figure 5-22).
• Pulse Delay: the time between the measurement stopping (integration 

time) and when the excitation light source is turned on for the next 
measurement (t4 on Figure 5-22). This value is read only and is 
adjusted based upon the Minimum Pulse Period, Measurement Delay, 
and Integration time.

• Minimum Pulse Period: The minimum time required between the 
excitation light source being turned off and when the excitation light 
source is turned on again (t5 on Figure 5-22). This value is based upon 
each detection cartridge and is not editable.

Figure 5-23 Homogeneous Time Resolved Fluorescence

Note: Measurement Delay + Integration Time + Pulse Delay => 
Minimum Pulse Period (t2 + t3 + t4 => t5)

Note: For additional information regarding the homogeneous time 
resolved fluorescence detection cartridge please see the detection 
cartridge’s user guide.
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To create a homogeneous time resolved fluorescence detection method using a 
homogeneous time resolved fluorescence enabled detection cartridge:

1. The only supported method technique using a homogeneous time 
resolved fluorescence detection cartridge is homogeneous time 
resolved fluorescence. Click Next to define the Method Parameters 
(Figure 5-23).

Figure 5-24 Homogeneous Time Resolved Fluorescence Method 
Parameters

2. In the Method Name field, enter a name for the method. 

3. To use on-the-fly detection select On the Fly Detection. 

4. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example an 
absorbance measurement @ 260 might read ABS_260, while an 
Absorbance scan measurement between 260 -360 might read 
ABS_260-350 Scan.

Note: On the Fly Detection yields considerably faster read times while 
the plate moves continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.
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5. If On the Fly Detection is not selected, in the Number of Pulses field, enter 
the number of excitation/measurement cycles performed in the 
measurement. The number of pulses sets the exposure received by 
samples during measurements.

6. In the Measurement Delay field, enter the interval (in seconds, 
milliseconds, or microseconds) between switching off the light source 
and performing the measurement (t2 in Figure 5-22).

7. In the Integration Time field, enter the length of time (in seconds, 
milliseconds, or microseconds) each sample is measured. Set the 
integration time within the range of 10 µs to 10 ms (t3 in Figure 5-22).

8. Click Save to save the new homogeneous time resolved fluorescence 
detection method. The new method appears in the Detection Method 
Selection List.

Luminescence (LUM) Detection Cartridge

In a luminescence method, the intensity at which light is emitted from a 
chemiluminescent or bioluminescent reaction is measured. The light output is 
measured as the rate of photons per time and is expressed as counts per 
second. In glow luminescence reactions, the light output decays slowly with 
time. Since the light is emitted as a result of a chemical reaction, no excitation 
light and no excitation filters are required to measure luminescence. In a dual 
glow luminescence method, different wavelength bands at the same time are 
measured.

Note: Selecting Speed results in the fastest possible read time per 
plate. However, there is trade off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.

Note: There are different types of Luminescence detection cartridges available 
for the SpectraMax Paradigm Multi-Mode Detection Platform. All are designed 
and optimized for different applications and microplate formats (for more 
details, refer to the respective detection cartridge manuals).
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To create a detection method using the Luminescence detection cartridge:
1. In the supported technique select Luminescence or Dual Luminescence 

(Figure 5-25).

Figure 5-25 Luminescence Detection Cartridge Method Technique

2. As required, select the detection wavelengths using the Wavelengths 
field.

3. Click Next to define the Method Parameters (Figure 5-26).
4. In the Method Name field, enter a name for the method. 

5. To use on-the-fly detection select On the Fly Detection. 

6. If using on-the-fly detection specify whether the detection method 
should be optimized for Speed or Performance using the On the Fly 
Optimization field. 

Note: When naming detection methods it is important to use a 
consistent and informative naming convention. For example 
Absorbance measurement @ 260 might read ABS_260, while an 
Absorbance scan measurement between 260 -360 might read 
ABS_260-350 Scan.

Note: On the Fly Detection yields considerably faster read times due to 
the plate moving continuously as each well is measured, as opposed to 
stop and go mode where the plate stops moving for each read.

Note: Selecting Speed results in the fastest possible read time per 
plate. However, there is trade off between the data quality (i.e. CVs or 
dynamic range) and read speed because each well is sampled for 
shorter integration times. Selecting Performance results in a faster read 
time than not using On the Fly Detection, but not as fast as the Speed 
mode. Performance provides considerably better results than Speed for 
demanding assays.
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OR
If not using on-the-fly detection, specify the measurement time per 
well (in seconds, milliseconds, or microseconds) using the Integration 
Time field.

7. Select Attenuation to apply a neutral density optical filter to the reading, 
which will reduce the intensity of all samples. 

CAUTION! Luminescence light levels visible to the human eye may cause 
damage to the detection system.

8. Click Save to save the new luminescence detection method. The new 
method appears in the Detection Method Selection List. 

Figure 5-26 Dual Luminescence Method Parameters

Note: Using attenuation will shift the linear dynamic range to higher 
sample concentrations. A similar effect can be achieved by using black 
plates instead of white plates. Samples appearing even stronger in 
signal although attenuation is applied are outside the measurement 
range.

Note: The attenuation option is available only for luminescence top 
reading.
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AlphaScreen Detection Cartridge

In an AlphaScreen method, the intensity at which light is emitted from the 
bead-based AlphaScreen assay is measured. The light output is measured as 
the rate of photons per time and can be normalized to counts per second. In 
AlphaScreen reactions, the light output decays slowly with time. Since the light 
is emitted as a result of a photochemical reaction, excitation light is exposed to 
the sample once, before signal is integrated for a specified time.

To create a detection method using the AlphaScreen detection cartridge:
1. In the Supported technique, select AlphaScreen (Figure 5-27). 

Figure 5-27 AlphaScreen Detection Cartridge Method Technique 

2. As required, select the detection wavelengths using the Wavelengths 
field. 

3. Click Next to define the Method Parameters (Figure 5-28). 
4. In the Method Name field, enter a name for the method. 

5. In the Excitation Time field, type the length of time in milliseconds that 
you want the laser beam to be on.

6. In the Integration Time field, type the elapsed time in milliseconds from 
when the laser beam is turned off to when you want the signal to be 
detected. 

7. To normalize raw data from counts into counts per second, select 
Normalization. 

Note: There are different types of AlphaScreen detection cartridges available 
for the SpectraMax Paradigm Multi-Mode Detection Platform. All are designed 
and optimized for different microplate formats (for more details, refer to the 
AlphaScreen Detection Cartridge user guide).

Note: When naming detection methods, it is important to use a 
consistent and informative naming convention. For example, 
Absorbance measurement @ 260 might read ABS_260, while an 
Absorbance scan measurement between 260 and 350 might read 
ABS_260-350 Scan.
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8. Select Interlaced Reading when you expect a high assay dynamic range 
in white plates. 

9. Click Save to save the new AlphaScreen detection method. The new 
method appears in the Detection Method Selection List. 

Figure 5-28 AlphaScreen Method Parameters

Signing a Detection Method (SpectraMax Paradigm 
Multi-Mode Detection Platform)
When GxP Permissions is enabled on the system, detection methods may be 
signed to prevent method properties from being edited or methods from being 
deleted. Detection methods may be signed at any time after the configuration 
is complete.
Detection methods may be signed by users who are assigned a role containing 
the Sign permission. See Configuring Roles for Multi-Mode Analysis Software 
User Accounts on page 76 for more information about roles and permissions.
To sign a detection method:

1. In the Detection Method Selection List, select the detection method to 
sign.

2. From the tool bar, click Sign the selected method.
OR
From the menu bar select Actions > Sign the selected method.
OR
Right click on the selected labware and select Sign the selected method.

3. The Sign the Selected Item dialog appears.
4. In the Sign the Selected Item dialog, add comments and an electronic 

signature by following the instructions in Adding Electronic Signatures 
and Comments to Items on page 84.

Note: Interlaced Reading processes every other well in a checkerboard 
fashion and adds another plate run to cover the wells left from the first 
run. Using this process minimizes crosstalk from the possible afterglow 
of an adjacent well that may have a strong emission when the critical 
well is read. Interlaced Reading is the suggested read mode when 
expecting high assay dynamic range in white plates.
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Editing Detection Methods
Parameters configured in user-defined detection methods may be edited; 
however, the method technique may not be changed. Default methods 
installed with the software and methods used in protocols may be edited, but 
not renamed.

To edit a detection method:
1. In the Detection Method Selection List, select the detection method to 

edit.
2. From the tool bar, click Edit.

OR
From the menu bar select Actions > Edit the selected method.
OR
Right-click on the selected detection method and select Edit the selected 
method.

3. The Method Editor appears.
4. Edit the method parameters as desired. For more information about the 

parameters for a specific detection method, refer to the section that 
covers defining the desired detection method: 
 Creating Detection Methods (FilterMax Multi-Mode Microplate 

Readers) on page 88
 Creating Detection Methods (SpectraMax Paradigm Multi-Mode 

Detection Platform) on page 99
5. Click Save to close the Method Editor and save the changes.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Delete permission may delete user-defined detection 
methods. Signed methods may not be deleted. See Configuring Roles for 
Multi-Mode Analysis Software User Accounts on page 76 for more information 
about roles and permissions.
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Copying Detection Methods
Copies may be made of existing detection methods. After a copy has been 
created, it may be used as a template for a new detection method using the 
same method technique.

To make a copy of a detection method:
1. In the Detection Method Selection List, select the detection method to 

copy.
2. From the tool bar, click Copy.

OR
From the menu bar select Actions > Make a copy of the selected method.
OR
Right-click on the selected detection method and select Make a copy of 
the selected method.

Deleting Detection Methods
User-defined detection methods may be deleted from the Detection Method 
Selection List. Some detection methods may not be deleted, including:

• methods used in protocols.
• default methods installed with Multi-Mode Analysis Software.
• methods signed on systems with GxP Permissions enabled.

When a detection method is deleted it is moved to the trash selection list. To 
permanently remove or restore items for deletion see Deleting and Restoring 
Items on page 48.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Delete permission may delete user-defined detection 
methods. Signed methods may not be deleted. See Configuring Roles for 
Multi-Mode Analysis Software User Accounts on page 76 for more information 
about roles and permissions.

Note: The default name format for copied detection methods is Copy of 
OriginalName. To change the name, edit the detection method. See Editing 
Detection Methods on page 123.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Delete permission may delete user-defined detection 
methods. Signed methods may not be deleted. See Configuring Roles for 
Multi-Mode Analysis Software User Accounts on page 76 for more information 
about roles and permissions.
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To delete a detection method:
1. In the Detection Method Selection List, select the detection method to 

delete.
2. From the tool bar, click Delete.

OR
From the menu bar select Actions > Delete the selected method.
OR
Right-click on the selected detection method and select Delete the 
selected method. 

3. A dialog box appears. Click Yes to delete the selected detection 
method.

4. To permanently remove the detection method see Deleting and 
Restoring Items on page 48

Exporting and Importing Detection Methods
A user-defined detection method can be exported to an XML file and imported 
later to restore that configuration or share it with a copy of Multi-Mode 
Analysis Software installed on another system.
Default detection methods installed with Multi-Mode Analysis Software are 
present on all systems and may not be deleted or overwritten. For this reason, 
importing default detection methods from an XML export file is not permitted.

To export a detection method:
1. In the Detection Method Selection List, select the detection method to 

export.
2. From the File menu, click Export > Detection Method. The Browse for 

Folder dialog appears.
3. In the Browse for Folder dialog, browse to the folder where the 

exported detection method will be saved.
OR
Click Make New Folder to create a new folder where the exported 
detection method will be saved.

4. Click OK to export the detection method. The exported detection 
method is saved using the default file name format, 
Method_MethodName.xml. 

Note: Multiple items may be selected for deletion by holding down the 
CTRL or SHIFT key while selecting each item desired.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Delete permission may delete user-defined detection 
methods. Signed methods may not be deleted. See Configuring Roles for 
Multi-Mode Analysis Software User Accounts on page 76 for more information 
about roles and permissions.

Note: To import the file at a later date, the filename must not be 
changed.
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To import a detection method from an exported XML file:
1. From the File menu, click Import > Detection Method. The Open dialog 

appears. 

2. In the Open dialog, browse to and select the desired XML file to import.
3. Click Open. The detection method is imported to the Detection Method 

Selection List.

Note: For SpectraMax Paradigm Multi-Mode Detection Platform, the 
detection cartridge used in the imported detection method must be 
contained within the list of available detection cartridges in My 
Detection Cartridges configured in instrument settings. To add a 
detection cartridge to the list of available detection cartridges see 
Adding Detection Cartridges to the list of Available Detection Cartridges 
on page 67.
126 5008530 A 



6
Creating and Editing Labware
Overview
Multi-Mode Analysis Software supports a wide range of labware, with many 
common microplate formats already preconfigured and ready for use in 
protocols. Configured labware types are listed in the Labware Selection List 
and are available for use in protocols.
New labware types may be created at any time using the Labware Editor. The 
Labware Editor also provides the ability to edit and delete existing labware 
types not used in protocols, make copies of labware types, and optimize 
labware dimensions to compensate for slight dimensional variations that may 
exist between production lots.
The types of labware supported depend on the capabilities of the instrument:

• FilterMax 3 Multi-Mode Microplate Reader: Supports 96-well and 384-
well microplates.

• FilterMax 5 Multi-Mode Microplate Reader: Supports 6-well to 384-well 
microplates.

• The SpectraMax Paradigm Multi-Mode Detection Platform supports 6-
well to 1536-well microplates, depending on the installed detection 
cartridges.

Labware actions are accessed from the Labware Selection List (Figure6.1). 
Labware actions include:

• Creating Labware on page 128 
• Editing Labware on page 133 
• Copying Labware on page 136 
• Deleting Labware on page 136 
• Optimizing Labware on page 137 
• Exporting and Importing Labware on page 143 

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Create permission may define labware. See Configuring 
Roles for Multi-Mode Analysis Software User Accounts on page 76 for more 
information about roles and permissions.
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To define and edit labware:
• From the navigation pane, click Labware. The Labware Selection List 

appears (Figure 6-1).

Figure 6-1 Accessing Labware Actions

Creating Labware
New types of labware are created in the Labware Editor, which guides the 
creation process with a wizard-type interface. Creating labware includes:

• Defining Labware Information on page 129
• Configuring Offsets and Well Dimensions for the Default Labware Lot on 

page 131
• Signing Labware on page 133 (Optional)

This is used to prevent labware from being edited or deleted. Labware 
may be signed only when GxP Permissions is enabled on the system.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Create permission may create new labware definitions. To 
sign labware, users must be assigned a role containing the Sign permission. 
See Configuring Roles for Multi-Mode Analysis Software User Accounts on 
page 76 for more information about roles and permissions.
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To create and define new labware:
1. From the tool bar, click Create.

OR
From the menu bar select Actions > Create a new labware type.
OR
Right-click in the Labware Selection List and select Create a new labware 
type.

2. The Labware Editor display (Figure 6-2).

Defining Labware Information
Use Labware Information to define labware names, dimensions, well 
parameters, and supported measurement techniques (Figure 6-2).

Figure 6-2 Defining Plate Dimensions and Information

To define Labware Information:
1. If necessary, click the + next to Labware Info to display the fields in the 

category.
2. Enter the Plate Name. A name must be entered to proceed to the 

second configuration screen, Labware Lots.

Note: After installing Multi-Mode Analysis Software, profiles for commonly 
used labware load to the system upon start up. Further labware profiles may 
be loaded by importing them. For details see Exporting and Importing 
Labware on page 143.
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3. If necessary, click the + next to Labware Measurements to display the 
fields in the category. 

CAUTION! The plate height configured must not be less than that of the actual 
plate. Doing so may cause the FilterMax Multi-Mode Microplate Readers to 
collide with the plate during a Read Height Optimization. The SpectraMax 
Paradigm Multi-Mode Detection Platform has an auto-detection to prevent 
collision, if an incorrect plate height is entered for the SpectraMax Paradigm 
Multi-Mode Detection Platform an error message appears while running 
protocols using the defined labware.

4. In the Height field enter the height of the plate without the lid. All 
labware dimensions are entered in centimeters.

5. In the Height with lid field enter the height of the plate with lid in 
centimeters.

6. In the Length field enter the length of the plate in centimeters.
7. In the Reading height field enter the height from the top of the plate at 

which the plate is read.
8. In the Width field enter the width of the plate.
9. If necessary, click the + next to Well Info to display the fields in the 

category.
10. In the Columns field enter the number of columns on the plate.
11. In the Row Label field select Alpha or Numeric for the row label.
12. In the Rows field enter the number of rows on the plate.
13. Click in either column of Well bottom shape, then click on the down 

arrow and select the shape of well bottoms: Flat, Cone, or Round.
14. Click in either column of Well shape, then click on the down arrow and 

select the shape of the wells: Round, Square, or Cone.
15. Enter the maximum Well volume in microliters.
16. In Supported Techniques, select all measurement techniques compatible 

with the plate being defined. The labware being configured will only be 
available for use in protocols configured with compatible measurement 
techniques. 

17. As desired, in Notes, enter information about the labware or 
configuration.

18. Click Next to define the default row and column offsets and well 
dimensions for the labware type in Labware Lots. See Configuring 
Offsets and Well Dimensions for the Default Labware Lot on page 131.

Note: More information about the field being defined is displayed below 
the property grid (Figure 6-2).

If information text is too long to be displayed entirely, the text box may 
be enlarged by dragging the upper border of the Notes box.

Note: See General Labware Selection Guidelines on page 131 for more 
information about selecting the appropriate labware for the desired 
techniques.
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General Labware Selection Guidelines

When creating labware, select only measurement techniques compatible with 
the microplate being defined. Each measurement technique requires labware 
of a specific color and/or material be used.
Table 6-1 provides general labware color and material guidelines for each 
measurement technique. Along with these basic guidelines, always select 
microplates with a surface treatment suitable for the desired application, and 
follow any additional guidelines provided by the plate manufacturer.

Configuring Offsets and Well Dimensions for 
the Default Labware Lot
Use Labware Lots to define row and column offsets and well dimensions 
(Figure 6-3). The offsets and dimensions entered when new labware is created 
define the default labware lot (DefaultLot). After the new labware has been 
saved, additional lots may be created by optimizing the labware to 
compensate for dimensional variations between different production lots. See 
Optimizing Labware on page 137.
In Labware Lots, x and y offsets are defined for all four corners of the labware. 
An x offset is the distance from the edge of the microplate to the center of 
wells on the first row; a y offset is the distance from the edge of plate to the 
center of wells in the first column. Well dimensions defined include well depth, 
length, and width, as well as distances between rows and columns.

Table6-1 General Microplate Selection Guidelines

Measurement 
Technique

Supported 
Plate Color Additional Considerations

Absorbance clear, white with 
clear bottom, or 
black with clear 
bottom

Clear polystyrene or film plates with 
transparent bottoms are suitable. 
Polypropylene or PVC plates do not 
provide sufficient optical quality.

Luminescence Glow 
Type

solid black or solid 
white

Black plates are recommended unless 
the signal is weak enough to require the 
higher sensitivity of white plates. 
However, with strong signals, white 
plates may produce crosstalk.

Fluorescence Intensity 
Top

solid black N/A

Fluorescence Intensity 
Bottom

black with clear 
bottom

N/A

Fluorescence 
Polarization

solid black Microplates must not be covered with a 
lid or plastic film during fluorescence 
polarization measurements.

Time-Resolved 
Fluorescence

solid white N/A

Time-Resolved 
Fluorescence Dual

solid white N/A
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To configure offsets and well dimensions:
1. If necessary, click the + next to Labware Lot Measurements to display 

the fields in the category. More information about the field being 
defined is displayed below the property grid (Figure 6-3).

2. Enter column and row x and y offsets for each of the four corner wells. 
All offsets and well dimensions are entered in millimeters. 

Figure 6-3 Defining Offsets and Well Dimensions

3. If necessary, click the + next to Well Measurements to display the fields 
in the category.

4. In Column Distance, enter the distance between columns (well center to 
well center).

5. In Row Distance, enter the distance between rows (well center to well 
center).

6. Enter the Well depth.
7. In Well Width, enter the diameter of the well in the direction of the rows 

on the plate.
8. In Notes, enter information about the labware lot or configuration, if 

desired.
9. Click Save to save the new labware and close the Labware Editor.

Note: The fields in Labware Lot Info may not be configured when 
creating new labware.
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Signing Labware
When GxP Permissions is enabled on the system, labware may be signed to 
prevent labware properties from being edited. Signed labware may not be 
optimized to create new labware lots unless all signatures attached to the 
labware are unlocked, which changes the labware status to unsigned.
Labware may be signed by users who are assigned a role containing the Sign 
permission. See Configuring Roles for Multi-Mode Analysis Software User 
Accounts on page 76 for more information about roles and permissions.
To sign labware:

1. In the Labware Selection List, select the labware type to sign.
2. From the tool bar, select Sign the selected labware type.

OR
From the menu bar select Actions > Sign the selected labware type.
OR
Right-click on the selected labware and select Sign the selected labware 
type.

3. The Sign the Selected Item dialog appears.
4. In the Sign the Selected Item dialog, add an electronic signature by 

following the instructions in Adding Electronic Signatures and 
Comments to Items on page 84.

Editing Labware
Dimensions and information for user-defined labware not used in 
measurement protocols may be edited. Dimensions and information may be 
viewed, but not edited, for:

• default labware installed with Multi-Mode Analysis Software.
• labware used in protocols.
• labware that has been signed on a system with GxP Permissions 

enabled.

All labware in the Labware Selection List may be optimized to create new 
labware lots. See Optimizing Labware on page 137. Labware lots compensate 
for dimensional variations between production lots. When multiple lots exist 
for a labware type, the active lot may be changed. Labware lot properties may 
be edited for all labware types except those that have been signed.
Labware is edited in the Labware Editor (Figure 6-5). Editing includes:

• Viewing and Editing Labware Information on page 134
• Selecting and Editing Labware Lots on page 135

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Edit permission may edit labware definitions. See 
Configuring Roles for Multi-Mode Analysis Software User Accounts on page 76 
for more information about roles and permissions.
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To view and edit labware dimensions and information:
1. In the Labware Selection List, select the labware to edit.
2. From the tool bar, click Edit.

OR
From the menu bar select Actions > Edit the selected labware type.
OR
Right-click on the selected labware and select Edit the selected labware 
type.

Viewing and Editing Labware Information
Use Labware Information to view and edit labware dimensions, information, 
and supported techniques. Plate information for default labware included in the 
software installation and labware used in protocols may be viewed, but not 
edited.

Figure 6-4 Editing Labware Dimensions and Well Information

To edit labware information:
1. In the property grid, edit labware dimensions and information as 

desired. See Defining Labware Information on page 129 for more 
information about the fields available in the property grid.

2. In Supported Techniques, change the measurement techniques 
supported by the labware, if desired. 

3. Edit the labware Notes, if desired.
4. Click Next to select and edit labware lots and save changes made to the 

labware. See Selecting and Editing Labware Lots on page 135.

Note: See General Labware Selection Guidelines on page 131 for more 
information about labware/technique compatibility.
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Selecting and Editing Labware Lots
Use Labware Lots to select the active lot and/or edit and save changes made in 
the Labware Editor (Figure 6-5). Lots can be selected and edited for all 
labware, including labware used in measurement protocols.

Figure 6-5 Configuring Offsets and Well Dimensions in Labware Lots

To select and edit lots:
1. From the pull-down menu, select the lot to use or edit. The default lot 

created when the labware was defined and all lots configured using 
Optimizing Labware are available. See Optimizing Labware on 
page 137.

2. Click in Current labware lot and select True, if necessary. True must be 
selected to save changes made to the labware lot.

3. In the property grid, edit lot dimensions and information as desired. 
See Configuring Offsets and Well Dimensions for the Default Labware 
Lot on page 131, for more information about the fields available in the 
property grid.

4. Edit the lot Notes, if desired.
5. Click Save to save changes made in the Labware Editor.

Note: Labware Lots are created by optimizing labware. See Optimizing 
Labware on page 137.
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Copying Labware
Labware can be copied and then used as a template for a new labware type by 
editing the dimensions and parameters in the Labware Editor. See Editing 
Labware on page 133.

To make a copy of a labware type:
1. In the Labware Selection List, select the labware type to copy.
2. From the tool bar, click Copy.

OR
From the menu bar select Actions > Make a copy of the selected labware 
type.
OR
Right-click on the selected labware type and select Make a copy of the 
selected labware type.

Deleting Labware
User-defined labware may be deleted from the Labware Selection List. Some 
labware may not be deleted:

• labware used in protocols.
• default labware installed with Multi-Mode Analysis Software.
• labware that has been signed on a system with GxP Permissions 

enabled.

When labware is deleted it is moved to the trash selection list. To permanently 
remove or restore items for deletion see Deleting and Restoring Items on 
page 48.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Copy permission may create copies of labware definitions. 
See Configuring Roles for Multi-Mode Analysis Software User Accounts on 
page 76 for more information about roles and permissions.

Note: The default name format for copied labware types is Copy of 
OriginalName. To change the name, edit the labware type. See Editing 
Labware on page 133.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Delete permission may delete user-defined labware. See 
Configuring Roles for Multi-Mode Analysis Software User Accounts on page 76 
for more information about roles and permissions.
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To delete labware:
1. In the Labware Selection List, select the labware to delete.
2. From the tool bar, click Delete.

OR
From the menu bar select Actions > Delete the selected labware type.
OR
Right-click on the selected labware and select Delete the selected labware 
type. 

3. The Message dialog appears.
4. Click Yes to delete the selected labware.
5. To permanently remove the labware see Deleting and Restoring Items 

on page 48.

Optimizing Labware
Microplate dimensions may vary slightly between production lots, which 
potentially affects measurement accuracy. Multi-Mode Analysis Software 
allows labware dimensions to be optimized by determining the centers of the 
four corner wells on the plate. Each time a labware type is optimized, a new 
labware lot is created with dimensions specific to that lot.

Labware is optimized in Optimizing Labware, which guides the process with a 
wizard-type interface. Optimizing labware includes:

• Creating a Copy of the Labware to be Optimized on page 138
• Start the Optimization Wizard on page 138
• Selecting the Detection Method on page 138
• Preparing and Loading the Labware on page 139
• Performing the Optimization Read on page 140
• Selecting the Centers of the Four Corner Wells on page 141
• Verifying Well Centers on page 142

Note: Multiple items may be selected for deletion by holding down the 
CTRL or SHIFT key while selecting each item desired.

Note: If a microplate type is to be used in different plate orientations for 
measurements, labware optimization must be done for each plate orientation 
separately.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Optimize permission may optimize labware to create new 
labware lots. See Configuring Roles for Multi-Mode Analysis Software User 
Accounts on page 76 for details about permissions.

New labware lots may be created by optimizing labware for labware types 
that have been signed. See Signing Labware on page 133.
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Creating a Copy of the Labware to be Optimized
To create a copy of the labware to be optimized:

1. In the Labware Selection List, select the labware to optimize.
2. From the tool bar, click Make a copy of the selected labware type.

OR
From the menu bar select Actions > Make a copy of the selected labware 
type.
OR
Right-click on the selected labware and select Make a copy of the selected 
labware type.

3. As desired, rename the copied labware. See Editing Labware on 
page 133.

Start the Optimization Wizard
To start the optimization wizard:

1. In the Labware Selection List, select the copied version of the labware 
to optimize.

2. From the tool bar, click Optimize the selected labware type.
OR
From the menu bar select Actions > Optimize the selected labware type.
OR
Right-click on the selected labware and select Optimize the selected 
labware type.

Selecting the Detection Method
Labware is optimized by performing area scan measurements of the four 
corner wells of the microplate and then defining the well centers using images 
of the wells generated by the measurements. To ensure the most accurate 
optimization is performed, use Select Detection Method to select the most 
appropriate detection method for the optimization (Figure 6-6).

Figure 6-6 Selecting the Detection Method for Labware Optimization
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To select the detection method:
1. To optimize labware for use in absorbance, fluorescence, or 

luminescence protocols, select a detection method configured in the 
protocol.

2. Click Next to Prepare the Labware. See Preparing and Loading the 
Labware on page 139.

Preparing and Loading the Labware
Labware dimensions are optimized by reading the four corner wells of the 
plate. Prepare Labware provides controls to load and eject labware from the 
instrument and to select the orientation of the plate on the microplate carrier 
(Figure 6-7).

Figure 6-7 Preparing the Labware for Optimization

To prepare labware for optimization:
1. Click Eject Plate Carrier to move the microplate carrier outside the 

instrument.
2. Fill the corner wells of the plate with identical samples. To ensure 

accuracy, samples must be appropriate for the selected detection 
method. Sample concentration and volume must be identical in each 
well.

3. Place the microplate to be optimized on the plate carrier.
4. Click Close Plate Carrier to load the microplate into the instrument.
5. In Select Plate Orientation, select the orientation of the plate on the 

microplate carrier. The selected orientation is displayed graphically to 
the right of the screen, with well A1 highlighted in red.

6. Click Next to start the optimization. See Performing the Optimization 
Read on page 140. The optimization read begins automatically.

Note: If a microplate type is to be used in different plate orientations for 
measurements, labware optimization must be done for each plate orientation 
separately.
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Performing the Optimization Read
Optimization in Progress displays the status of the optimization read and 
provides the ability to cancel the optimization in progress (Figure 6-8). The 
optimization read requires several minutes to complete.

Figure 6-8 Labware Optimization In Progress

To cancel the optimization process and close the Optimizing Labware dialog 
without saving the optimization data click the Stop Optimization button.
When the optimization read is complete:

• Click Next to select the centers of the four corner wells. See Selecting 
the Centers of the Four Corner Wells on page 141.
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Selecting the Centers of the Four Corner Wells
Use Select Center to precisely define the centers of the corner wells read in the 
optimization Figure 6-9. Select Center displays an image of the well generated 
by the optimization read. Well centers are defined graphically by dragging 
cross hairs to the position visually identified as the center. Select Center is 
performed for each corner well individually.

Figure 6-9 Selecting the Well Center

To define the centers of the wells:
1. Place the cursor in the well image.
2. Click-and-drag the cross hairs to the desired center of the well. 

3. Click Next to define the centers of the remaining well reads.
4. When all four well centers are defined, Verify Well Centers appears. See 

Verifying Well Centers on page 142.

Note: The cross hairs will not display if the cursor is not in the well 
image.
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Verifying Well Centers
Use Verify Well Centers to verify that the x and y offsets and distances 
between rows and columns are correct (Figure 6-10). The offsets, distances, 
and lot name may be edited in Verify Well Centers.

Figure 6-10 Verifying Well Centers

1. If necessary, click the + next to Labware Lot Measurements to display 
the fields in the category. 

2. In Column distance, verify the distance between columns and edit the 
dimension. All offsets and well dimensions are entered in centimeters, 
if desired.

3. Verify the x and y offsets for the lower two wells and edit the 
dimensions, if desired.

4. In Row distance, verify the distance between rows and edit the 
dimension, if desired.

5. Verify the x and y offsets for the upper two wells and edit the 
dimensions, if desired.

6. If necessary, click the + next to Labware Lot Name to display the default 
name assigned to the new labware lot.

7. Enter a new Lot ID/Name, if desired.
8. Click Save to save the optimization data and create the new labware lot.

Note: More information about the field being defined is displayed below 
the property grid (Figure 6-10).

Note: To use the optimized lot in a measurement protocol, open the labware 
for editing and select the new Labware Lot. See Selecting and Editing 
Labware Lots on page 135.
142 5008530 A 



Multi-Mode Analysis Software User Guide
Exporting and Importing Labware
User-defined labware can be exported to an XML file and imported later to 
restore that configuration or share it with a copy of Multi-Mode Analysis 
Software installed on another system.
Default labware installed with Multi-Mode Analysis Software is present on all 
systems and may not be edited, deleted, or overwritten. For this reason, 
importing default labware from an XML export file is not permitted.

To export labware:
1. In the Labware Selection List, select the labware to export.
2. From the File menu, select Export > Labware. The Browse for Folder 

dialog appears.
3. In the Browse for Folder dialog, browse to the folder where the exported 

labware will be saved.
OR
Click Make New Folder to create a new folder where the exported 
labware will be saved.

4. Click OK to export the labware. The exported labware is saved using the 
default file name format, Labware__LabwareName.xml. To import the 
file at a later date, the filename must not be changed.

To import labware from an exported XML file:
1. From the File menu, select Import > Labware. The Open dialog appears.
2. In the Open dialog, browse to and select the desired XML file to import.
3. Click Open. The labware is imported to the Labware Selection List.

Note: When GxP Permissions is enabled, signed labware may be exported for 
use on another system; however, electronic signatures are not retained, 
which allows labware to be edited when imported to another system. Because 
signed labware may not be deleted or overwritten, importing signed labware 
into the system from which it was originally exported is not permitted.
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7
Creating and Running Protocols
Overview
A protocol stores all parameters required to perform a measurement, including 
technique type, detection methods, labware type, and preparation methods, 
such as shaking. Multiple measurements, including kinetic and scan 
measurements, may be configured in a single protocol. Protocols also specify 
how measurement results are viewed, exported, or printed when a protocol 
run completes. This section includes instructions for configuring the analysis 
features. Detection methods and labware must be configured before the 
protocol is created. See Creating and Editing Detection Methods on page 87 
and Creating and Editing Labware on page 127 for additional information.

Protocols are listed in the Protocol Selection List (Figure 7-1), which provides 
access to all protocol actions:

• Creating Protocols on page 146
• Creating a Protocol from a Template on page 196
• Running Protocols on page 197
• Editing Protocols on page 211
• Copying Protocols on page 212
• Deleting Protocols on page 212
• Printing Protocol Configuration Information on page 213
• Exporting and Importing Protocols on page 214

To select protocols and access protocol functions:
• From the navigation pane, click Protocols. The Protocol Selection List 

appears (Figure 7-1).

Note: Always verify the parameters configured in a protocol. Failing to verify 
all configured parameters may result in incorrect measurement results.
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Figure 7-1 Protocol Selection List

Creating Protocols
New protocols are defined in Create Protocol, which guides the creation 
process with a wizard-type interface. Creating a new protocol requires:

• Configuring General Settings on page 148
• Selecting the Technique Type on page 149 (for Analysis protocols)
• Selecting the Labware Type Used in the Protocol on page 150
• Configuring Labware Layout Settings on page 151
• Adding Detection and Preparation Methods for Analysis Protocols on 

page 155
OR
Configuring Methods for Quantitation Protocols on page 165

• Configuring the Data Reduction on page 172
• Configuring Output Settings on page 187

Several analysis options may be selected and configured to transform 
measurement data as desired when configuring Analysis and Quantitation 
protocols:

• Configuring Variables on page 170
• Configuring a Transformation Formula on page 177
• Configuring Concentration on page 179
• Configuring Cutoff Values on page 183
• Configuring Validation Rules on page 185
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To create and configure a new protocol:
1. From the tool bar, click Create.

OR
From the menu bar select Actions > Create a new protocol.
OR
Right-click in the Protocol Selection List and select Create a new protocol.

2. The Select Protocol Type dialog appears (Figure 7-2).

Figure 7-2 Selecting the Protocol Type

3. There are two options for creating protocols, from the New Protocol tab 
and Template Protocols tab. To create a new (non-template) protocol, 
continue to step 4. To create a protocol using a template protocol see 
Creating a Protocol from a Template on page 196. 

4. Select the Protocol Type: 
 Analysis: Analysis applications allow measurement data to be 

transformed and analyzed using formulas, variables, and 
parameters configured in the protocol.

 Quantitation: Quantitation applications measure the purity and/or 
concentration of proteins or nucleic acid samples, such as DNA or 
RNA.

Note: Template protocols are used to create a protocol based upon a 
selected template. Pre-defined settings appear as the protocol is 
configured.

Note: By disabling the Menu Options > Show Example Protocols, all 
example protocols (starting with x_) are hidden from view in the 
Protocol Selection List.

Note: For the FilterMax Multi-Mode Microplate Readers, to create or run 
quantitation protocols a genomic filter slide, which contains narrow 
bandwidth 260nm and 280nm filters must be installed and configured.
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5. Click Next to configure the protocol. The Create Protocol dialog 
appears, displaying General Settings. See Configuring General Settings 
on page 148.

Configuring General Settings
Use General Settings to define the protocol name and enter any related notes 
about the protocol (Figure 7-3). Analysis Options to include in the protocol are 
available for selection.

Figure 7-3 Defining a Protocol Name and Entering Notes About the Protocol

To configure the general settings for a new protocol:
1. In Protocol name, enter a unique name for the protocol. Duplicate 

protocol names are not permitted.
2. In Notes, enter a description for the protocol, if desired.
3. In Run Notes, enter further notes specific to this run, if desired. These 

notes will appear when the protocol starts up.
4. Select the desired Analysis Options for configuration in the protocol: 

 Variables: define up to ten numeric values that may be used in any 
formula configured in the protocol. See Configuring Variables on 
page 170.

 Transformation: configure an algebraic formula to transform 
measurement data. See Configuring a Transformation Formula on 
page 177.

Note: The Variables option is only available for Analysis applications.

Note: The Transformation option is only available for Analysis 
applications.
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 Concentration: values or formulas for quantitation of sample 
concentration with a standard curve. See Configuring Concentration 
on page 179.

 Cutoff: configure cutoff formulas to classify measured samples 
according to defined cutoff values. See Configuring Cutoff Values on 
page 183.

 Validation: configure up to ten validation formulas to evaluate if a 
protocol run meets the specified conditions required to be valid. See 
Configuring Validation Rules on page 185.

5. Click Next to select the Technique Type. See Selecting the Technique 
Type on page 149.

Selecting the Technique Type
Use Technique Type to select the measurement technique to be performed by 
the protocol (Figure 7-4). Only techniques supported by the instrument and 
for which detection methods have already been defined are available. For more 
information about technique types, see Creating and Editing Detection 
Methods on page 87.

Figure 7-4 Selecting the Measurement Technique

Note: Only Analysis Options that have been selected appear in the 
Create Protocol navigation pane and are available for configuration in 
the protocol.

Note: Technique Type is only configured for Analysis protocols. For 
Quantitation protocols see Selecting the Labware Type Used in the Protocol on 
page 150.
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To select a technique type:
1. In Technique Type, select the desired measurement techniques. Multiple 

techniques may be selected to create protocols using different 
detection techniques. 

2. Click Next to select the Labware Type. See Selecting the Labware Type 
Used in the Protocol on page 150.

Selecting the Labware Type Used in the Protocol
Use Labware Selection to select the type of labware used in the protocol 
(Figure 7-5). Labware must be configured prior to configuring the protocol. 
Only labware configured for the selected protocol and technique type is 
available. Labware cannot be edited once it is used in a protocol. See Creating 
and Editing Labware on page 127 for detailed information about creating and 
configuring labware.

Figure 7-5 Selecting the Type of Labware Used in the Protocol

Note: By selecting different technique types following options while 
creating a protocol are filtered (such as available labware, detection 
methods, etc.).

Note: If editing an existing protocol, selecting a different technique 
type removes any detection methods previously configured in Method 
Selection. New detection methods must be configured before the 
protocol may be used to perform measurements. See Adding Detection 
and Preparation Methods for Analysis Protocols on page 155.
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To select labware:
1. Select the desired Type of Labware from the list. 

2. Click Next to configure the Labware Layout Settings. See Configuring 
Labware Layout Settings on page 151.

Configuring Labware Layout Settings
Use Layout Settings to configure how wells on the plate are read (Figure 7-6). 
Settings include configuring well types and locations, replicates, and the layout 
of well identifiers on the plate.
To configure labware layout settings:

1. To import a plate layout from an existing protocol, click Import Layout 
and select the desired protocol from the list that appears. Only 
protocols with compatible plate layouts are listed.
OR
To create a new or edit an existing plate layout, select the desired wells 
to label. To select: 
 all wells on the plate: click the small button in the upper left corner of 

the plate layout display (Figure 7-6).
 all wells in a single column or row: click the desired column or row 

header. Multiple columns or rows may be selected by holding down 
the CTRL key while selecting each header desired.

 individual wells: click on the desired well. Multiple wells may be 
selected by holding down the CTRL key while clicking on each well 
desired.

 groups of wells: click and drag over the desired group of wells. 
Multiple groups may be selected by holding down the CTRL key 
while dragging over each desired group.

Figure 7-6 Configuring Layout Settings

Note: If the labware is not optimized a Warning dialog appears. To 
continue without optimizing the labware click Yes. To optimize the 
labware, click No and then Cancel to exit the Create Protocol Wizard 
and optimize the labware first. See Optimizing Labware on page 137. 
Labware optimization can be done after the protocol is created. The 
protocol always uses the active labware lot.
5008530 A 151 



Creating and Running Protocols
2. In Index, select the initial label number for the sequence of selected 
wells.

3. In Filling, select the desired direction for labeling the selected wells: 
 Vertical: labels wells column by column.
 Horizontal: labels wells row by row.

4. In Flow, select how the index is applied to wells in the selection. 
 Constant: all well identifiers in the selection are assigned the current 

index number.
 Incremental: increases each well identifier in the selection by one.

5. In Replicates, select the number of replicates for each sample and the 
layout orientation on the plate: 
 Vertical: replicates are arranged vertically in columns.
 Horizontal: replicates are arranged horizontally in rows.

6. Select the type of wells to add to the plate layout from the Type field 
and clicking Fill or by right-clicking on a selected well: 
 Standard: a well with a known concentration used to develop or 

correct a standard curve. Up to twelve standards may be configured 
on a plate.

 Control: a well with a known, expected signal used to verify the 
results of the plate.

 Positive Control: a control well in which a known amount of target 
reagent generates a signal to verify positive results measured in 
sample wells.

• Negative Control: a control well lacking the target reagent that 
generates little to no signal; verifies negative results measured in 
sample wells.
 Sample: a well containing a sample to measure.
 Blank: a well filled with reagents but no reacting sample. Blank 

wells are used to measure background noise. When blanks are 
configured, background correction is automatically applied to 
measurement results.

 Empty: a well that is left empty.
 Advanced Controls (Blue/Green/Red): For use with wells of a known, 

expected color signal to verify the results of the plate.
7. If configuring Blank wells, select the type of Blank Validity desired: 

Plate, Row, or Column. The mean value of all blank wells in the selected 
validity option is subtracted from sample wells to provide background 
correction. 

8. If necessary, click Delete to delete existing labels from the selected 
wells.

9. Repeat steps 1 through 8 to define additional well selections, as 
desired.

10. Configure Dilution Factors, if desired. See Configuring Dilution Factors 
on page 154.

Note: Replicate parameters are available for configuration only when 
Incremental Flow is selected.

Note: By choosing Blank, Blank Validity replaces Filling, Flow, and 
Replicate options in Layout Settings when configuring Blank wells.
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11. Select the desired reading direction using the Direction menu: 
 Read by row reads plates row-by-row.
 Read by column reads plates column-by-column.
 Read by well reads each well individually before reading the next 

well, which is useful for short-interval kinetic, area scan, and 
wavelength scan measurements.

12. To use a multi-plate layout, using the Multi Layout menu select Yes. To 
view the multiplate layout click View. A multi-plate layout places all the 
controls on the first plate and the following plates only have samples. 
The number of plates in a multi-plate layout is specified when the 
protocol is run, see Running a Protocol on an Instrument on page 197. 

13. Click Print Options and select which information about plate layouts will 
display in printed reports. 
 Print all Wells in List Format: Well label identifiers will display in a list.
 Print all Wells in Layout Format: Well label identifiers appear in a 

layout.

Note: If adding a wavelength scan to the protocol, the reading direction 
must be set to well mode.

Note: In a multi-plate layout the multiple plates are treated like one 
large plate. All controls are on the first plate and the following plates 
only have samples. The limit for a multi-plate layout is 100 plates.
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Configuring Dilution Factors
If wells are diluted, the dilution factor can be set for each well. As desired, the 
dilution factor can be used in the Data Reduction step.
To configure dilution factors for the wells on a plate:

1. In the View: menu, select Dilutions. The plate map display changes to 
show the well identifier and the dilution ratio. Initially, the dilution ratio 
for all wells is 1/1, or undiluted. 

Figure 7-7 Configuring Dilution Factors for a Plate

2. Select the well or wells for which to set the dilution ratio.
3. In the Dilution Factor field, select the desired dilution ratio.
4. In Filling, select whether to fill across rows first or down columns first. 

Options are: 
 Vertical: fill the dilution ratio for wells vertically down columns 

before filling the dilution ratio in the next column.
 Horizontal: fill the dilution ratio for wells horizontally across rows 

before filling the dilution ratio in the next row.
5. In Flow, specify whether to use a constant dilution factor or to 

increment each well by the Dilution Factor. Options are: 
 Constant: set the dilution ratio of all selected wells to the Dilution 

Factor.
 Incremental: increment the dilution ratio for each well by the 

Dilution Factor, starting with an undiluted well. For example, if the 
Dilution Factor is 1/2, four wells are selected, and the Flow is 
incremental, the dilution ratio for those four wells will be 1/1, 1/2, 
1/4, and 1/8.

6. Click Fill to set the dilution ratio for the selected wells using the current 
Dilution Factor, Filling, and Flow settings.

7. Repeat Step 1 through Step 5 to configure the dilution ratio for all wells 
on the plate.

8. Click Next to configure the Detection and Preparation Methods. See 
Adding Detection and Preparation Methods for Analysis Protocols on 
page 155 or Configuring Methods for Quantitation Protocols on 
page 165.
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Adding Detection and Preparation Methods 
for Analysis Protocols
Use Method Selection to select and add detection and preparation methods. 
The estimated duration time for the protocol is displayed in the Estimated Time 
Field of the protocol. Selecting Per Cartridge sorts the detection methods by 
cartridge type versus detection method type. Selecting Show only installed 
Methods displays only enabled detection methods in the selection list when 
connected to an instrument.

To add a method:
1. Select the measurement type using the tabs: 

 Single: One read per well (endpoint measurement).
 Kinetic: Kinetic measurements perform a specified series of 

measurements on each sample at specified intervals. Final 
measurement results are calculated from raw data using a data 
reduction method. For more information about data reductions see 
Configuring the Data Reduction on page 172.

 Area Scan: Area scans read a number of measurement points 
arranged in a grid pattern across each well. Linear scans read a 
number of points in a linear axis crossing the center of each well.

 Wavelength Scan: Wavelength scan enables scan measurements 
between 230-1000nm in 1nm increments on each well.

2. Available detection and preparation methods display within the Select 
Method section on the left-side of the window. To add a detection or 
preparation method, click-and-drag the method to the protocol list in 
the center of the window.
OR
Select the detection or preparation method and click the Add a method 
to this protocol button (Figure 7-8).
OR
Select the detection or preparation method and press Enter or Space to 
add the method. 

Note: If configuring a protocol in Quantitation mode, see Configuring Methods 
for Quantitation Protocols on page 165.

Note: If adding a wavelength scan the reading direction must be set to 
well mode.
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Figure 7-8 Adding a Single Detection Method

3. Select the method in the protocol and as required configure it using the 
Method Info section in the right pane.
OR
If adding a preparation method, in the protocol pane select the 
preparation method. The preparation info replaces the Method Info in 
the right pane. Configure the preparation method properties, as 
applicable: 
 Shake: See Configuring Shake Properties on page 163 to configure the 

Method Properties for the Shake preparation method.
 Set Temperature: See Configuring Set Temperature Properties 

(FilterMax 5 Multi-Mode Microplate Reader and SpectraMax 
Paradigm Multi-Mode Detection Platform only) on page 163 to 
configure the Method Properties for the Set Temperature 
preparation method.

 Wait: halts operations on the instrument for a specified length of 
time before continuing to the next action in the method sequence. 
See Configuring Wait Properties on page 164 to configure the Method 
Properties for the Wait preparation method.

 Eject: moves the plate carrier outside the instrument to allow access 
for placement or removal of a microplate. Eject has no Method 
Properties to configure.

 Load: retracts the plate carrier and microplate inside the instrument 
in preparation for performing a measurement. Load has no Method 
Properties to configure.

 Pause: halts operations on the instrument for an indefinite length of 
time and displays a message, requiring user interaction to continue 
to the next action in the method sequence. See Configuring Pause 
Properties on page 164 to configure the Method Properties for the 
preparation method.

Note: The Eject preparation method should be followed by a Pause 
preparation method. If there is no Pause, the next command in the 
sequence is executed immediately after completion of the Eject 
command.
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4. If adding a kinetic detection method, in the protocol select Kinetic for 
the detection method. Kinetic Info appears in the right pane. Configure 
Kinetic Info by following the instructions in Configuring Kinetic Method 
Properties on page 159.
OR
If adding an area or linear scan detection method, in the protocol select 
Area Scan for the detection method. Area Scan Info appears in the right 
pane. Configure Area Scan Info by following the instructions in 
Configuring Area Scan Method Properties on page 160 or Configuring Linear Scan 
Method Properties on page 161.
OR
If adding a wavelength scan detection method, in the protocol select 
Wavelength Scan for the detection method. Wavelength Scan Info 
appears in the right pane. Configure Wavelength Scan Info by following 
the instructions in Configuring Wavelength Scan Method Properties on page 162. 

5. Add and configure additional detection or preparation methods by 
repeating steps 1 through 5, as desired. 

Note: A new detection method can be created at this time by clicking 
the Create button. The Method Editor appears allowing the creation of a 
new detection method for the current instrument. See Creating 
Detection Methods (FilterMax Multi-Mode Microplate Readers) on 
page 88 or Creating Detection Methods (SpectraMax Paradigm Multi-
Mode Detection Platform) on page 99 for more information regarding 
creating a detection method.

Note: To change method parameters, in the Method Information 
window select the method and then click the Edit button.

Note: If adding a wavelength scan the reading direction must be set to 
well mode.

Note: Edit selected methods by clicking the Edit button near the top 
right corner of the Method Selection window. See Figure 7-9.
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Figure 7-9 Method Selection window Edit button

6. To change the order in which detection and preparation methods are 
executed in the sequence, in the protocol, select the method to be 
moved and click the blue up or down arrows.
OR
In in the protocol, right-click on the desired method and select Move Up 
or Move Down.
OR
In the protocol, click on the desired method and drag the method up or 
down into the desired position. 

7. To remove a detection or preparation method from the protocol, in the 
protocol select the method to be removed and click the red delete 
button.
OR
In the protocol, right-click on the desired detection or preparation 
method and select Remove. 

8. To add a group, select the desired detection or preparation method for 
creating a new group. Click on Group, and a new group will be created. 
Two or more groups can be created in a protocol, there is no limit to the 
number of groups that can be created. 

Note: To move a kinetic, area scan, or wavelength scan method, select 
Kinetic, Area Scan, or Wavelength Scan above the detection method 
desired to move, not the method itself.

Note: To delete a kinetic, area scan, or wavelength scan method, select 
Kinetic, Area Scan, or Wavelength Scan above the detection method 
desired to delete, not the method itself.
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9. If you are using a method with PathCheck Pathlength Measurement 
Technology enabled and you have determined a plate background 
constant for your microplate, you can enter the value in the Plate 
Background field. See Use Plate Background Constant on page 247.

10. Click on the Print Options button to select the method information and 
measurement results data included in printouts: 
 Print Method Parameters: details about the configured method, 

including technique type and filters used.
 Print Graphical View: kinetic or scan graphs of results for all 

measured samples. Available for kinetic and scan measurements 
only.

 Raw Data: results from each kinetic cycle or scan point. Available 
when kinetic measurements, scan measurements, or multiple 
detection methods are configured in the sequence.

 Print Well Status: status indicating whether the well was read 
successfully.

11. Click Next to configure the Variables (if selected in the General Settings, 
see Configuring Variables on page 170) or to configure the Data 
Reduction, see Configuring the Data Reduction on page 172.

Configuring Method Properties

Detection methods and preparation methods that are added to a protocol may 
have method properties that need to be configured.

• Configuring Kinetic Method Properties on page 159
• Configuring Area Scan Method Properties on page 160
• Configuring Linear Scan Method Properties on page 161
• Configuring Wavelength Scan Method Properties on page 162
• Configuring Shake Properties on page 163
• Configuring Set Temperature Properties (FilterMax 5 Multi-Mode 

Microplate Reader and SpectraMax Paradigm Multi-Mode Detection 
Platform only) on page 163

• Configuring Wait Properties on page 164
• Configuring Pause Properties on page 164

Configuring Kinetic Method Properties 
Kinetic measurements perform a specified series of measurements on each 
sample at specified intervals. Final measurement results are calculated from 
raw data using a data reduction method.

• FilterMax Multi-Mode Microplate Readers: Kinetic measurements may be 
configured for all FilterMax Multi-Mode Microplate Readers method 
types except time-resolved fluorescence, FRET and area scans.

• SpectraMax Paradigm Multi-Mode Detection Platform: Kinetic 
measurements may be configured for all SpectraMax Paradigm Multi-
Mode Detection Platform method types except area scans and 
absorbance wavelength scans.

Note: The group option is used for integration or multi-step analysis 
purposes, providing a break in the protocol without ending the 
protocol. Data obtained from each group can be used together in the 
Analysis.
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To configure properties for a kinetic measurement:
1. Select Kinetic for the detection method being configured. Kinetic Info 

appears in the right pane.
2. In Kinetic Info enter the number of Kinetic Cycles to be performed. 

Kinetic measurements may be set to perform 2 to 100 cycles.
3. In Kinetic Info enter the desired Kinetic Interval in seconds. The interval 

is the length of time between each measurement of the same well. 

Configuring Area Scan Method Properties 
Area scan measurements may be configured for absorbance and fluorescence 
intensity detection methods. Area scans read a number of measurement points 
arranged in a grid pattern across each well.

To configure properties for an area scan:
1. Select Area Scan for the detection method being configured. Area Scan 

Info appears in the right pane.
2. To configure the type of scan measurement and the number of points 

measured, in Method Properties, click in Scan Points and click the 
configuration button. Scan Selection Editor appears (Figure 7-10).

Figure 7-10 Configuring an Area Scan

3. In Resolution (mm), use the up and down arrows to select the proximity 
of measurement points. selecting a smaller value increases the number 
of measurement points available; selecting a larger value decreases the 
number of points available. Available resolutions are determined by the 

Note: The minimum kinetic interval is populated automatically in Kinetic 
Interval, and is determined by the labware type and layout settings 
configured in the protocol. The maximum interval between 
measurement cycles is 65,535 seconds.

Note: Properties (Resolution and Point Selection) are fixed when using on-
the-fly detection methods.
160 5008530 A 



Multi-Mode Analysis Software User Guide
type of labware selected for use in the protocol. Detection methods 
with “On the fly” detection selected have fixed resolution and scan 
points. See Selecting the Labware Type Used in the Protocol on 
page 150 and Configuring Labware Layout Settings on page 151 for 
more information.

4. Click anywhere inside the well boundary, except the center row, and 
drag until the desired number of measurement points is selected 
(Figure 7-10).

5. Click OK to save the scan configuration and close the Scan Selection 
Editor.

Configuring Linear Scan Method Properties 
Linear scan measurements may be configured for absorbance and fluorescence 
intensity detection methods. Linear scans read a number of points in a linear 
axis crossing the center of each well.
To configure properties for a linear scan:

1. Select Area Scan for the detection method being configured. Area Scan 
Info appears in the right pane.

2. To configure the type of scan measurement and the number of points 
measured, in Method Properties, click in Scan Points and click the 
configuration button. Scan Selection Editor appears (Figure 7-11).

Figure 7-11 Configuring a Linear Scan

3. In Resolution (mm), use the up and down arrows to select the proximity 
of measurement points. selecting a smaller value increases the number 
of measurement points available; selecting a larger value decreases the 
number of points available. Available resolutions are determined by the 
type of labware selected for use in the protocol. Detection methods 
with “On the fly” detection selected have fixed resolution and scan 
points. See Selecting the Labware Type Used in the Protocol on 
page 150 and Configuring Labware Layout Settings on page 151 for 
more information.

4. To configure a linear scan, click anywhere on the center row or column 
inside the well boundary and drag towards the boundary until the 
desired number of measurement points is selected (Figure 7-11).
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5. Click OK to save the scan configuration and close the Scan Selection 
Editor.

Configuring Wavelength Scan Method Properties 
Wavelength scan measurements enables scans between the defined start 
wavelength and end wavelength in user configurable increments on each well.

To configure properties for a wavelength scan:
1. Select the wavelength scan detection method to configure. Wavelength 

Scan Info appears in the right pane (Figure 7-12).

Figure 7-12 Wavelength Scan Detection Method Properties

2. In Method Info enter the number of wavelength ranges in Number of 
Ranges, Up to three wavelength ranges can be defined so that the 
spectrum can be divided into separate parts (such as 230-300 and 900-
1000).

3. In Method Info enter the Wavelength Increment in nm. The wavelength 
step interval is the increment between each wavelength measurement 
of the same well.

4. In Method Info enter the Start Wavelength in nm. The starting 
wavelength must me smaller than the end wavelength.

5. In Method Info enter the End Wavelength in nm.
6. As required for multiple wavelength ranges, repeat Step 4 through 

Step 5.

Note: The type of scan that may be configured is determined by the 
reading direction settings in Layout Settings. See Configuring Labware 
Layout Settings on page 151. Horizontal linear scans along the center 
row may be configured only when Read by row is selected, while 
vertical linear scans along the center column may be configured only 
when Read by column or Read by well is selected.

Note: If adding a wavelength scan the reading direction must be set to well 
mode.
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Configuring Shake Properties 
A Shake preparation method may be placed in the desired location in the 
sequence, or attached to a kinetic measurement when interval shaking 
between each measurement cycle is desired.
To configure properties for a Shake preparation method:

1. Select the desired Shake preparation method in the protocol. Shake 
Info appears in the right pane.

CAUTION! Shake low density plates, such as 6- or 48-well plates, at low speed 
only. Shaking low density plates at higher speeds may cause liquid in wells to 
spill.

2. In Shake Intensity, select the desired intensity of shaking: Low, Medium, 
or High.

3. In Shake Interval, enter the length of time in seconds (0-18000) to 
shake the microplate. 

4. In Shake Mode, select the desired shaking pattern. 
 Linear: shakes from side to side.
 Orbital: shakes labware in a circular pattern.
 Squared: shakes labware in a square pattern, moving at right angles 

(FilterMax Multi-Mode Microplate Readers only).
Configuring Set Temperature Properties (FilterMax 5 Multi-Mode Microplate 
Reader and SpectraMax Paradigm Multi-Mode Detection Platform only)
A Set Temperature preparation method sets the temperature inside the 
microplate chamber by heating the chamber; cooling the chamber is not 
supported. Depending on the light source used in the protocol, the set 
temperature may range from 3°C (5.4°F) or 4°C (7.2°F) above ambient to 
45°C (113°F). A minimum of 15 minutes is required for the instrument to 
reach the desired temperature. The actual time required depends on the 
relative change in temperature. The instrument may be configured to wait for 
it to reach the desired temperature or continue immediately to the next 
command in the method sequence.

Note: Shaking efficiency for 24- to 384-well plates has been improved 
in Multi-Mode Analysis Software version 2.0 and above. The Shake 
Interval for protocols originally created for use with version 1.0 may 
need to be reduced.

Note: Set Temperature preparation methods are useful for kinetic 
measurements intended to measure the effects of temperature changes on 
samples.

The FilterMax 5 Multi-Mode Microplate Reader does not support heating to a 
set temperature.
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To configure properties for a Set Temperature preparation method:
1. Select the Set Temperature preparation method in the protocol. 

Temperature Info appears in the right pane.
2. In Set Temperature, enter the desired microplate chamber temperature 

in degrees Celsius. In protocols that perform measurements only at 
visible wavelengths (>359 nm), the minimum temperature that may be 
set is 3°C (5.4°F) above ambient. When the protocol performs 
measurements in the UV range the minimum temperature is 4°C 
(7.2°F) above ambient. The maximum temperature that may be set is 
45°C (113°F).

3. In Wait for Temperature, select the desired option: 
 True: wait until the FilterMax 5Multi-Mode Microplate Reader or 

SpectraMax Paradigm Multi-Mode Detection Platform reaches the 
Set Temperature before executing the next command.

 False: immediately execute the next command.
Configuring Wait Properties 
A Wait preparation method halts actions on the instrument for a specified 
length of time prior to executing the next command. Properties for a Wait 
preparation method include the length of time to wait before continuing with 
the protocol.
To configure properties for a Wait preparation method:

1. In Method Selection, select the desired Wait preparation method. 
Method Properties for the selected method appear.

2. In Wait Time, enter the length of time in seconds the instrument should 
wait before executing the next command. 

Configuring Pause Properties 
A Pause preparation method halts actions on the instrument for an indefinite 
length of time and display a message, requiring user interaction to continue to 
the next action in the method sequence. Properties for a Pause preparation 
method include the message to display during the pause.
To configure properties for a Pause preparation method:

1. Select the desired Pause preparation method in the protocol. Pause Info 
appears in the right pane.

2. In Comment, enter the text for the message to display when the Pause 
is executed during the protocol run.

Note: The temperature remains at the current setting until overridden 
by another Set Temperature preparation method, by changing the 
temperature in Manual Control, or by turning the instrument off and 
on.

Note: Wait Time must be between 1 and 3600 seconds.
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Configuring Methods for Quantitation Protocols
In a Quantitation protocol, Method Selection (Figure 7-13) is used to select the 
quantitation methods to perform as part of the measurement. Configuring a 
quantitation method includes selecting the desired applications to run and 
configuring the parameters for the selected applications. Parameters may 
include a Normalization Factor, or effective sample height, which transforms 
the microplate OD values to a comparable value for the same sample in a 1cm 
cuvette. This Normalization Factor is applied as a divisor of the sample 
reading.

Figure 7-13 Configuring a Quantitation Method in Method Selection

To select and configure a quantitation method:
1. In Method Selection, select the Applications tab (Figure 7-13).
2. In Select Methods, select the desired quantitation applications to run: 

 260 Abs Value: net absorbance value at 260 nm. This selection is 
required when the Analysis option Concentration is selected in 
General Settings and samples are quantified against standards 
supplied in the plate layout. See Configuring Labware Layout 
Settings on page 151.

 DNA Purity: measures absorbance at both 260 nm and 280 nm and 
determines the ratio as an indicator of nucleic acid purity. Pure DNA 
has a ratio around 1.8, while pure RNA has a ratio around 2.0.

 Pure dsDNA Concentration (260): measures absorbance at 260 nm 
and determines the concentration of pure dsDNA by normalizing the 
measurement values to equivalent 1cm cuvette measurements and 
transforming the equivalent values into concentrations. Requires 
input of a normalization factor and reciprocal coefficient of 
extinction.

Note: To create or run quantitation protocols for a FilterMax Multi-Mode 
Microplate Reader, a genomic filter slide, which contains narrow bandwidth 
260nm and 280nm filters must be installed and configured.
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 Pure RNA Concentration (260): measures absorbance at 260 nm and 
determines the concentration of pure RNA by normalizing the 
measurement values to equivalent 1 cm cuvette measurements and 
transforming the equivalent values into concentrations. Requires 
the input of a normalization factor and reciprocal coefficient of 
extinction.

 Pure ssDNA Concentration (260): measures absorbance at 260 nm 
and determines the concentration of pure ssDNA by normalizing the 
measurement values to equivalent 1cm cuvette measurements and 
transforming the equivalent values into concentrations. Requires 
the input of a normalization factor and reciprocal coefficient of 
extinction.

3. If no blank wells were added in Layout Settings, alternative Blank 
Correction options are available. Select Blank Correction to enable it for 
the protocol and select the desired type of correction to use: 

 Pre read high: requires a pre read plate filled with blanks that is read 
prior to the measurement plate; subtracts the buffer measurement 
value of a well from the analyte measurement value of the same 
well for each well read. Use this option when blank variability from 
well to well is high.

 Pre read low: requires a pre read plate filled with blanks that is read 
prior to the measurement plate; averages the buffer measurement 
values from all wells read and subtract the average from the analyte 
measurement value for each well. Use this option when blank 
variability from well to well is low, or relatively constant.

Note: Reliable results require blank subtraction prior to performing 
further calculations. If the plate layout does not include blank wells, it 
is recommended that Blank Correction is selected.

Note: The blank plate should come from the same batch as the 
measurement plate with blank replicates dispensed into all wells. A 
blank replicate should contain all components common to all samples 
except for the analyte. Leaving blank wells empty may be an 
approximation and should be validated for each assay.

Note: When running a quantitation protocol with a pre read, the blank 
plate is measured first. After reading the blank plate, the plate carrier 
opens and the protocol pauses to allow the blank plate to be removed 
and the measurement plate to be loaded.

Note: The blank plate should come from the same batch as the 
measurement plate with blank replicates dispensed into all wells. A 
blank replicate should contain all components common to all samples 
except for the analyte. Leaving blank wells empty may be an 
approximation and should be validated for each assay.

Note: When running a quantitation protocol with a pre read, the blank 
plate is measured first. After reading the blank plate, the plate carrier 
opens and the protocol pauses to allow the blank plate to be removed 
and the measurement plate to be loaded.
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 Fixed Constant: subtracts a fixed constant for 260 nm, 280 nm, and 
320 nm (if 320 nm Background Correction is selected) 
measurements from each well. Use this option when the average 
blank value is stable for the given set of assay conditions. Enter the 
desired constants for 260 and 280, and 320. Default values are 
displayed in Table 7-1.

a Values are based on using TE buffer in a Costar 96-well microplate.

4. Select 320 nm Background Correction to subtract the blanked 
measurement value at 320 nm from the value of each well. This 
background correction partially compensates for the turbidity of 
samples and is in addition to blank subtraction. Selection of this option 
results in an additional measurement being made at 320 nm. 

5. Select the Parameters tab to display the parameter information. Only 
the parameters for the methods selected on the Applications tab are 
displayed. 

6. Configure the Parameters as appropriate. The application each 
parameter is associated with is identified in the front of each parameter 
name. See Table 7-2.

Table7-1 Default blank values for Fixed Constanta 

Wavelength Blank Value

260 0.065

280 0.047

320 0.035

Note: Reading background at 320nm does not substitute for blank 
correction, as the 320nm sample read is typically different from the 
blank reads at 260 nm and 280nm.

Table7-2 Quantitation Parameters by Application Type

Application Parameter Default 
Value

260 Abs Value

A[xxx] = sample measurement at xxx nm
B[xxx] = blank measurement at xxx nm

Has no 
parameters.

N/A

DNA Purity

A[xxx] = sample measurement at xxx nm
B[xxx] = blank measurement at xxx nm

Normalization 
Factor [cm] (also 
called effective 
sample height)

Default: 
0.29aValid 
range: 0.01 
to 1

Pure dsDNA Conc (260)

abs = absorbance value at 260 nm, as 
defined in 260 Abs Value above
norm = normalization factor
1/E = reciprocal coefficient of extinction 
dilution = dilution factor

Normalization 
Factor [cm] (also 
called effective 
sample height)

Default: 
0.29a Valid 
range: 0.01 
to 1

Reciprocal 
Coefficient of 
Extinction 
[(µg/mL) / 
(OD/cm)]

Default: 50 
Valid range: 
1 to 100
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a Default value for normalization factor is based on 100 µL of DNA in a 96-well plate. This 
value is dependent on a number of factors, including volume of DNA, buffer viscosity, 
plate type, and well shape, and should be determined empirically and modified for the 
specific application. See Determining the Normalization Factor. See Table 7-3 for typical 
values for DNA in a 96-well plate.

a Values are based on volume of DNA in TE buffer in a Costar 96-well microplate. See 
Determining the Normalization Factor for instructions on determining normalization 
factors for different labware types.

7. As desired, in Options select Temperature to set the temperature of the 
instrument before reading. Properties for Temperature appears.

8. As necessary, in Set Temperature, enter the desired microplate 
chamber temperature in degrees Celsius. In protocols that perform 
measurements only at visible wavelengths (>359 nm), the minimum 
temperature that may be set is 3°C (5.4°F) above ambient. When the 
protocol performs measurements in the UV range the minimum 
temperature is 4°C (7.2°F) above ambient. The maximum temperature 
that may be set is 45°C (113°F). 

Pure RNA Conc (260)

abs = absorbance value at 260 nm, as 
defined in 260 Abs Value above
norm = normalization factor
1/E = reciprocal coefficient of extinction
dilution = dilution factor

Normalization 
Factor [cm] (also 
called effective 
sample height)

Default: 
0.29aValid 
range: 0.01 
to 1

Reciprocal 
Coefficient of 
Extinction 
[(µg/mL) / 
(OD/cm)]

Default: 40 
Valid range: 
1 to 100

Pure ssDNA Conc (260)

abs = absorbance value at 260 nm, as 
defined in 260 Abs Value above
norm = normalization factor
1/E = reciprocal coefficient of extinction
dilution = dilution factor

Normalization 
Factor [cm] (also 
called effective 
sample height)

Default: 
0.29aValid 
range: 0.01 
to 1

Reciprocal 
Coefficient of 
Extinction 
[(µg/mL) / 
(OD/cm)]

Default: 37 
Valid range: 
1 to 100

Table7-3 Typical Values for Normalization Factora

Volume of DNA Normalization Factor 
(Effective Sample Height)

100 µL 0.29 cm

150 µL 0.44 cm

200 µL 0.59 cm

Table7-2 Quantitation Parameters by Application Type (cont’d)

Application Parameter Default 
Value

Note: The temperature remains at the current setting until overridden 
by another Set Temperature preparation method, by changing the 
temperature in Manual Control, or by turning the instrument off and 
on.
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9. As necessary, in Wait for Temperature, select the desired option: 
 True: wait until instrument reaches the Set Temperature before 

reading the plate.
 False: immediately read the plate.

10. As desired, in Options select Shake Before Read to shake the microplate 
before reading, if desired.

CAUTION! Shake low density plates, such as 6-well or 48-well plates, at low 
speed only. Shaking low density plates at higher speeds may cause liquid in 
wells to spill.

11. As necessary, in Shake Intensity, select the desired intensity of shaking: 
Low, Medium, or High.

12. As necessary, in Shake Interval, enter the length of time in seconds (0-
18000) to shake the microplate. 

13. As necessary, in Shake Mode, select the desired shaking pattern. 
 Linear: shakes from side to side.
 Orbital: shakes labware in a circular pattern.
 Squared (FilterMax Multi-Mode Microplate Readers only): shakes 

labware in a square pattern, moving at right angles.
14. Click Report Options and select the method information and 

measurement results data included in printouts: 
 Method Information: details about the configured method, including 

technique type and filters used.
 Raw Data: results from each kinetic cycle or scan point. Available for 

kinetic and scan measurements only.
 Print Status: status indicating whether or not the well was read 

successfully.
15. Click Next to configure the Variables (if selected in the General Settings, 

see Configuring Variables on page 170) or to configure the Data 
Reduction, see Configuring the Data Reduction on page 172.

Determining the Normalization Factor

The normalization factor is a value that relates the measurement value of a 
microplate well to its equivalent value in a 1cm cuvette. This normalization 
factor depends on the microplate type, well shape and dimensions, sample 
volume and viscosity, and other factors, and can be determined experimentally 
by comparing the value of a sample in a cuvette to the same sample measured 
in a microplate.

Note: Shaking efficiency for 24-well to 384-well plates has been 
improved in versions 2.0 and above. The Shake Interval for protocols 
originally created for use with version 1.0 of the software may need to 
be reduced.

Note: It is recommended for best results that the assay conditions for the 
microplate are replicated as closely as possible when determining the 
normalization factor. Therefore, use a DNA standard diluted in assay buffer 
with UV-transparent microplates and quartz glass cuvettes. The microplate 
used with the instrument should be optimized (see Performing the 
Optimization Read on page 140) and measurements made using the 260 nm 
filter on the genomic filter slide.
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To experimentally determine the normalization factor:
1. Aliquot a sample and a sample blank into separate 1cm pathlength 

cuvettes. 

2. Measure the sample and the sample blank in a spectrophotometer. 
Record the blanked value (absorbance of the sample minus absorbance 
of the blank) as the Absorbance value per 1cm.

3. Aliquot a volume of the same sample and sample blank equal to the 
volume that will be read with unknown samples into several wells of the 
microplate which will be used for measurements. This enables 
replicates to be performed and yields a more accurate result.

4. Measure the microplate on the instrument. Record the blanked value 
(absorbance of the sample minus absorbance of the blank) as the 
Absorbance value of the plate.

5. Calculate the normalization factor by dividing the Absorbance value of 
the plate (step 4) by the Absorbance value per 1 cm (step 2). For 
example: 

Configuring Variables
Up to ten variables may be defined for use in formulas configured in the 
protocol (Figure 7-14). Variables are typically used with test kits that have 
cutoff values or standard correction values based on lot number.

Note: Select a sample concentration within the dynamic range of the 
spectrophotometer at 1cm pathlength and in the instrument.

Table7-4 Example Calculation of Normalization Factor

Blank Sample
Absorbance 
(Sample - 
Blank)

Normalization 
Factor

1 cm cuvette 0.066 0.816 0.750 (step 2)

microplate 0.064 0.314 0.250 (step 4) 0.250/0.750 = 0.333 
(step 5)

Note: Variables appear only when selected in General Settings for an Analysis 
protocol. See Configuring General Settings on page 148. 
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Figure 7-14 Configuring Variables in an Analysis Protocol

To configure variables:
1. Select the Number of variables to be configured. Up to ten variables may 

be configured. Entry fields for each variable appear.
2. For each variable, enter the desired numeric Value.
3. For each variable, enter the desired Name to be used in reports.
4. Click Report Options and select Definition to include all variable names, 

values, and names used in reports in printouts, if desired.
5. Click Next to configure the Data Reduction. See Configuring the Data 

Reduction on page 172.
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Configuring the Data Reduction
Data reduction allows for multiple data calculations of measurement results 
from the detection methods in the protocol. Raw data results can be 
summarized to a single value. Results from the data reduction are used in 
analysis. Passes allow for additional data reduction using a previous data 
reduction. Results from the data reduction are displayed in the results and can 
be used for transformation, concentration, cutoff values, or for validation.
The raw data from each detection method is assigned a character that is listed 
besides the detection method in the Select Methods pane (For example, the 
first detection method is labeled “A”, the second “B”, and so on). The formula 
A+B+C would add the raw data from the three detection methods represented 
by A, B, and C. Detection methods that include multi-point data results can be 
expanded to view the additional labels (Figure 7-15).
Multipoint methods should have a data reduction (kinetic, area scan, 
wavelength scan). If the user does not enter a data reduction, the software 
creates a standard data reduction once the protocol is saved.

Figure 7-15 Data Reduction Page with Labels

To configure the data reductions:
1. In Data Reduction Method click Add new to use a data reduction 

method.
2. Select either the Functions tab or the Formula tab. The Functions tab 

provides access to predefined data reduction methods. The Formula tab 
allows for a manually creating a data reduction formula. 

Note: The Functions tab is accessible for certain types of detection 
methods and only on the first pass of the data reduction.
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3. If using the Functions tab (Figure 7-16): 
 Select the desired Basis of Evaluation using the selection box. 

 As necessary, select a Pre-Read Method. The Pre-Read method will 
subtract the measurement values of the Pre-Read method from the 
measurement values of the method selected in Basis of Evaluation.

 When necessary, using the Pre-Read Method menu select whether 
the Pre-Read method will subtract the average for all wells in the 
Pre-Read method (Mean), or subtract on a well-by well basis. 
(Well).

 Enter a name for the Data using the Name of Data field. This 
information is used later during data output in the reduced data 
results.

 As necessary, enter any notes about the data reduction using the 
Notes field.

 In the Reduction Properties section, using the Function field select 
the predefined data reduction method to use. 

 As necessary, configure the function’s parameters using the fields 
displaying below the Function field. 

Figure 7-16 Functions Tab

Note: Only detection methods that can be used as a basis of evaluation 
are available for selection.

Note: Each type of read mode has its own set of predefined data 
reduction functions. See Table A-1 on page 241 for details about the 
data reduction methods available for sequence measurements.
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OR
4. If using the Formula tab (Figure 7-17): 

 Enter a formula for the desired data reduction using any of the 
mathematical operators (except for <, >, or =) or mathematical 
functions listed in Mathematical Operators and Functions on 
page 249. 

 Enter a name for the Data using the Name of Data field. This 
information is used later during data output in the reduced data 
results.

 Enter the units for the data using the Name of Units field. This 
information is used for information purposes only during data 
output.

 As necessary, enter any notes about the formula using the Notes 
field.

 Select the wells to apply the data reduction formula to using the 
Calculate Formula for Controls section. Only the selected well types 
will be used in the current data reduction formula. 

Figure 7-17 Formula Tab

5. To add an additional data reduction click Add new.
OR
To add an additional pass of data reduction formulas click Add new Pass.
OR
To add an additional pass of data reduction formulas click Add new Pass. 

Note: The Formula field can be used to create ratios, such as A/B, or 
corrected ratios, such as (A–C)/(B–C).

Note: Up to twenty-six data reductions may be added for each pass. Up 
to twenty-six passes can be added.
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6. Optionally, click the Syntax Helper button, and the Syntax Helper window 
(Figure 7-18) appears. Syntax Helper helps in the creation of the 
correct syntax for accessing advanced data values. Access raw 
measurement data, blanked data (if blanks are used) or data resulting 
from any previous data reduction. 

Figure 7-18 Syntax Helper window

Note: Select the insertion point inside of the formula before starting 
Syntax Helper.
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Available mathematical functions (Figure 7-19) included in Syntax 
Helper are minimum, maximum, mean, median, standard deviation or 
coefficient of variation. 

Figure 7-19 Syntax Helper mathematical functions selection

Select attributes from the drop-down menus (Figure 7-20) to combine 
data with mathematical functions and validity constraints to render a 
desired configuration. 

Figure 7-20 Syntax Helper Validity
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Figure 7-21 Syntax Helper parameters

Conclude by clicking on the Insert Syntax button to apply the syntax to 
the formula at the point of insertion.

7. Add and configure additional passes by repeating steps 2 through 6.
8. Click Next.

Configuring a Transformation Formula
Use Transformation to configure an algebraic formula (X' =) that is applied to 
every well in a set of reduced data (X) (Figure 7-22). The transformation 
formula must include X, and may include mathematical operators, but not 
relational or logical operators. See Mathematical Operators and Functions on 
page 249 for more information about supported mathematical operators.

Note: Depending on the type of the data and mathematical function, 
validity can be plate-wide (valid for the whole plate), cycle wide (valid 
for the selected cycle), identifier (for example, maximum value of the 
specified control). Depending on function type and selected validity 
there are additional parameters available to specify a cycle for which 
the function should be applied.

Note: X represents the result value of a data reduction selected in the Basis of 
Evaluation field.

Note: Transformation is available for configuration only when selected in 
General Settings for an Analysis protocol. See Configuring General Settings 
on page 148.
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Figure 7-22 Configuring a Transformation Formula

To configure a transformation formula:
1. In the Basis of Evaluation field, select the desired data reduction to use 

for the transformation.
2. In X' =, enter the desired transformation formula. See Mathematical 

Operators and Functions on page 249 for detailed information about 
mathematical operators supported by the software.

3. In Name of X', enter a new name for the transformation formula. The 
name appears in printed reports and in protocol configuration screens 
where a basis for evaluation must be selected.

4. Click Report Options and select the transformation information included 
in printouts: 
 Definition: the transformation formula and name are listed.
 Print in Matrix: the transformed result calculated for each sample will 

display in a measurement results matrix corresponding to the plate 
layout.

 Print in List: the transformed result calculated for each sample will 
display in a list of measurement results.

 Print Status: status indicating whether or not the well was read 
successfully.
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Configuring Concentration
Use Concentration to select a curve fitting method and configure concentration 
and response formulas for standards (Figure 7-23).

Figure 7-23 Configuring Concentration Parameters

To configure a standard curve and standards:
1. To use a stored Standard Curve select Use stored Standard Curve. Click 

Select to select the standard curve. Using the Standard Curve Record 
Selection Form dialog select the specific record to use as the standard 
curve or Always use the most recent record from the Database. Click Next 
to continue.
OR
To use the standard curve definition from another protocol select Copy 
Standard curve definition from another protocol to this protocol. Click Select 
to select the protocol to copy the standard curve from. Click Next to 
continue.
OR
Select a Curve Type: Point to Point, Linear Regression, Cubic Spline, Four 
Parameter Fit, or Polynomial. See Table 7-5 more information about 
curve fitting methods. 

Note: Concentration is available for configuration only when selected in 
General Settings for an Analysis or Quantitation protocol. See Configuring 
General Settings on page 148.

Note: Standards may be deleted or inserted with a special key stroke 
combination. Use CTRL+Y to delete a standard and CTRL+N to insert a 
standard.
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Table7-5 Curve Fitting Methods

Method Description Example

Linear regression Construction of a straight line using the least 
squares method with the highest possible 
approximation to all standard points. Requires a 
minimum of 3 standard points.

Point to Point Direct connection of all standard points. Requires 
a minimum of 3 standard points.

Cubic Spline All standard points are connected by the best 
fitting curve.
Can only be used for nonlinear and nonsigmoid 
functions.
Requires a minimum of 3 standard points.

4 Parameter Fit This procedure can be used only to characterize 
sigmoid curves. The curve is calculated according 
to the formula:

a = zero dose response (upper asymptote)
d = infinite dose response (lower asymptote)
c = dose level which results in a response 
midway between a and d
b = slope factor
Requires a minimum of 3 standard points.
The X and Y axes are fixed:
X = logarithm
Y = linear

Polynomial Calculates the least squares fit through points 
using the formula:

Requires a minimum of n+1 standard points, 
where n is the order of the polynomial.
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2. Select the Number of standards to configure. Up to 12 standards may be 
configured in a protocol. Standards configured in the labware layout are 
automatically added to Concentration.

3. In Extrapolation, enter a percentage value to extrapolate the standard 
curve above and below the highest and lowest standard points in the 
curve, if desired. Extrapolation may be configured for all curve fitting 
methods.

4. In Y-Axis, select the Base for the axis. 
 Reduction: the reduced data from the protocol run.
 Transformation: the value calculated using the transformation 

formula configured in Transformation. This option is available only 
when Transformation is configured in the protocol. See Configuring 
a Transformation Formula on page 177.

5. In Y-Axis, select the Type of scale for the Y-Axis: linear or logarithmic. 

6. In X-Axis, enter a Name for the axis, if desired.
7. In X-Axis, select the Type of scale for the X-Axis: linear or logarithmic. 

8. Click Report Options and select the concentration information and data 
included in printouts: 
 Definition: curve type, parameters, and statistics, such as intercept 

and slope.
 Graph: the standard curve.
 Print in Matrix: the transformed result calculated for each sample will 

display in a measurement results matrix corresponding to the plate 
layout.

 Print in List: the transformed result calculated for each sample will 
display in a list of measurement results.

 Print Status: status indicating whether or not the well was read 
successfully.

9. In the Graph Setup tab, edit each Response Formula and the 
corresponding Concentration. Response formulas may contain any 
controls, standards, or variables defined in the test, as well as 
numerical constants and mathematical operators. A response formula is 
often simply the value of a measured standard, which is expressed as 
STD1, STD2, or STD3. 

Note: Transformation is the default name for transformation formulas. 
If a different name is entered in Transformation, that name appears in 
Base. See Configuring a Transformation Formula on page 177.

Note: Type is not available when configuring a four parameter fit curve.

Note: Type is not available when configuring a four parameter fit curve.

Note: See Mathematical Operators and Functions on page 249 for 
detailed information about mathematical operators supported by the 
software.
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10. If configuring a linear regression curve fitting method, select the 
Validation tab to validate the protocol based on acceptable coefficient of 
correlation, if desired (Concentration Options Tab on page 183).

Figure 7-24 Configuring Standard Curve Validation Parameters

11. Select Linear Regression Check Correlation to enable validation.
12. In Linear Regression Min Correlation, enter the minimum correlation 

percentage value for the test to be valid.
13. In the Options tab, it is possible to configure an algebraic formula that is 

applied to the calculated concentration of every well (Figure 7-28). The 
formula shall include X, and may include mathematical operators, but 
not relational or logical operators. For detailed information about 
mathematical operators supported by the software, see Mathematical 
Operators and Functions on page 249. 

Note: The Validation tab appears only when configuring a linear 
regression curve fitting method.

Note: X represents the result value of the concentration calculation. For 
example: X/DF => divides the concentration values of every well by 
the dilution factor (DF), which is entered in the plate layout settings.
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Figure 7-25 Concentration Options Tab

Configuring Cutoff Values
Use Cutoff to configure qualitative evaluations that classify measured samples 
into groups according to defined cutoff formulas or values (Figure 7-26). Up to 
ten cutoff groups may be configured.

Figure 7-26 Configuring Cutoff Values

Note: Cutoff is available for configuration only when selected in General 
Settings for an Analysis or Quantitation protocol. See Configuring General 
Settings on page 148.
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To configure cutoff groups and formulas:
1. Select the Basis of Evaluation: 

 Concentration: the value calculated using the standard curve 
configured in Concentration. This option is available only when 
Concentration is configured in the protocol. See Configuring 
Concentration on page 179.

 Transformation: the value calculated using the transformation 
formula configured in Transformation. This option is available only 
when Transformation is configured in the protocol. See Configuring 
a Transformation Formula on page 177.

 Reduction: reduced data from the protocol run. See Configuring the 
Data Reduction on page 172.

2. Select the Number of groups to configure.
3. Enter a Name for each group.
4. Enter the formulas and/or values used to classify samples into groups. 

The cutoff formula or value entered represents the maximum value 
included the group being configured. 

5. Click Report Options and select the cutoff information and data included 
in printouts: 
 Definition: the basis for measurement, group names, and cutoff 

values and/or formulas configured.
 Print in Matrix: the cutoff group classification for each sample 

appears in a measurement results matrix corresponding to the plate 
layout.

 Print in List: the cutoff group classification for each sample appears 
in a list of measurement results.

 Print Status: status indicating whether or not the well was read 
successfully.

Note: Transformation is the default name for transformation formulas. 
If a different name is entered in Transformation, that name appears in 
Basis of Evaluation. See Configuring a Transformation Formula on 
page 177.

Note: The results calculated from the formulas or the values entered 
must ascend. Results or values that do not ascend will generate an 
error during protocol runs.
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Configuring Validation Rules
Use Validation to configure up to ten validation rules (Figure 7-27). Protocol 
runs that do not meet the conditions specified in the rules are marked as 
invalid.

Figure 7-27 Configuring Validation Rules

To configure validation rules:
1. Select the Number of formulas to configure. Up to ten formulas may be 

configured.
2. Select the Basis of Evaluation for the first formula: 

 Concentration: the value calculated using the standard curve 
configured in Concentration. This option is available only when 
Concentration is configured in the protocol. See Configuring 
Concentration on page 179.

 Transformation: the value calculated using the transformation 
formula configured in Transformation. This option is available only 
when Transformation is configured in the protocol. See Configuring 
a Transformation Formula on page 177.

 Data Reduction Results: reduced data from the protocol run. See 
Configuring the Data Reduction on page 172.

Note: Validation is available for configuration only when selected in General 
Settings for an Analysis or Quantitation protocol. See Configuring General 
Settings on page 148.

Note: Transformation is the default name for transformation formulas. 
If a different name is entered in Transformation, that name appears in 
Basis of Evaluation. See Configuring a Transformation Formula on 
page 177.
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3. Enter the first formula. Formulas may contain: 
 any controls, standards, or variables defined in the protocol. For 

controls and standards, use the same labels displayed in Layout 
Settings; for example, STD1 for standard 1, C2 for control 2, P5 for 
positive control 5, or N2 for negative control 1.

 numeric constants.
 mathematical operators and functions and logical operators. See 

Mathematical Operators and Functions on page 249 for a complete 
list of supported operators and functions.

4. Repeat steps 2 through 3 for any additional formulas.
5. Click Report Options and select Definition to include the validation 

configuration and state (pass/fail) for all rules in printouts.

Table7-6 Example Test Validation Formulas

Application Validation Formula

The results from a protocol run are valid only if the 
mean absorption value of the positive control wells 
P2 is less than or equal to 0.8 OD.

P2<=0.8

The results from a protocol run are valid only if both 
controls are within the linear range of the 
instrument.

0.1<=C1 AND 
C1<=3.0 AND 
0.1<=C2 AND 
C2<=3.0
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Configuring Output Settings
Use Output Settings to specify which measurement result export, view, and 
print actions are performed automatically when a protocol run completes 
(Figure 7-28). An external software application, such as a notification utility, 
may also be configured to execute when a run completes.

Figure 7-28 Configuring Output Settings

To configure Output Settings:
1. Select export, view, and print output options as desired. Table 7-7 

describes the options available. Further output options are described in 
Table 7-8, Table 7-9, and Table 7-10.

2. Click Execute a program after protocol executes to display options for 
configuring an external software application to run after the protocol 
run is completed. See Configuring a Program to Execute after a Protocol 
Run Completes on page 195 for more information.

3. Click Run protocol now to run the protocol. See Running Protocols on 
page 197 for more information about running protocols. 

Note: When creating or editing a protocol, the protocol must be saved 
before it can be run. After saving the protocol, Run Protocol appears for 
protocols that were edited; new protocols must be selected in the 
Protocol Selection List before they may be run.
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Table7-7 Output Options

Output Option Description

Export to Microsoft 
Excel

Saves results in a format compatible with Microsoft Excel 
according to the Data Format configuration in Software Settings. 
See Configuring the Data Format on page 43, and automatically 
opens Excel after completing a protocol run.

Note: Versions of Excel prior to Office 2000 are not 
supported by the Export to Microsoft Excel function, but 
can open measurement results stored in tab-delimited 
data .dat files.

Note: When using Microsoft Excel 2002 or higher, the 
Multi-Mode Analysis Software will format the Excel 
worksheets with the appropriate column width and apply 
formatting to display the status of a measurement value 
(such as bold and colors).

User Defined Excel 
Export

Saves results in a format compatible with Microsoft Excel with 
customizable output attributes. Upon clicking the User Defined 
Excel Export checkbox, click the Define button to invoke the 
Excel Export Definition Dialog. Within this dialog designate more 
specific output attributes as needed. For more details, see User 
Defined Excel Export on page 189.

Show Result Viewer Automatically opens the measurement results in the Result 
Viewer after completing a protocol run. See Viewing 
Measurement Results in the Result Viewer on page 217.

Create XML and 
DAT data files

Automatically exports measurement results to a tab-delimited 
data (*.dat) file and an XML file. These files may be opened by 
software applications compatible with tab-delimited data or XML 
files.

Note: The directory where the data files are saved is 
configured in System Settings. See Selecting a Directory 
for Saving Exported Measurement Results on page 37.

Export Data to 
SoftMax Pro File 
Format

Automatically exports measurement results to a text file in a 
format that can be used to import the data into SoftMax Pro 
Software. See Exporting Data to SoftMax Pro File Format on 
page 193.

Note: The directory where the data file is saved is 
configured in System Settings. See Selecting a Directory 
for Saving Exported Measurement Results on page 37.

Start SoftMax Pro 
Software and 
Import Data

Automatically exports measurement results to a formatted text 
file, and then opens SoftMax Pro Software and imports the data 
from the text file after completing a protocol run. See Starting 
SoftMax Pro Software and Importing Data on page 194.

Print options Automatically prints the results after completing a protocol run.
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User Defined Excel Export

Upon completion of a protocol run, results may be exported into a user-defined 
format for viewing in Microsoft Excel. A preview of the exported results may be 
seen in the Preview window at the lower left portion of the Export Option 
Dialog window (Figure 7-29).
To configure User Defined Excel Export:

1. In Output Settings, click the Define button. The Excel Export Definitions 
Dialog window appears (Figure 7-29).

Figure 7-29 Export Option Dialog window

The Options list to the left of the Excel Export Definitions Dialog window 
allows for selection of data layout options. These options may be 
selected on the left portion of the window: 
 General
 List Format
 Matrix Format
 List Format Blanked Data
 Matrix Format Blanked Data
Further options specific to workbook and worksheet export properties 
may be combined to meet specific needs. These further export options 
are summarized in: 
 Workbook Export Options on page 190
 Worksheet Export Options on page 191
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Workbook Export Options

Options (Figure 7-30) specific to workbook export properties are available as 
follows:

Figure 7-30 Workbook options

Table7-8 Workbook Export Options

Properties Description

Export Automatic Multi-Mode Analysis Software automatically determines the file 
name and exports data to that file name.

Export to Open 
Workbook

Data results are exported to the currently open workbook on the 
controlling PC.

New Workbook Data results are exported to a new workbook on the controlling 
PC.

Existing Workbook Data results are exported to an existing workbook on the 
controlling PC.

Export disabled Data results will not be exported to an Excel file.
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Worksheet Export Options

Options (Figure 7-31) specific to worksheet export properties are available as 
follows:

Figure 7-31 Worksheet options

Table7-9 Worksheet Export Options

Properties Description

Automatic Multi-Mode Analysis Software automatically determines the 
worksheet name and exports data to a sheet with that name.

Active Sheet on 
Export

Data results are exported to the currently open worksheet on 
the controlling PC.

New Sheet Data results are exported to a new worksheet on the controlling 
PC.

Existing Sheet Data results are exported to an existing worksheet selected by 
the user on the controlling PC.
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New Sheet and Existing Sheet Export Options

Further worksheet options (Figure 7-32) allow for selection of data layout 
options for both new and existing sheets.

Figure 7-32 Further Worksheet Options

Table7-10 Further Worksheet Export Options

Properties Description

Column Determines the start column for export.

Row Determines the start row for export.

Formatting Allows export of data using user-defined formatting assigned to 
a numbered template.

Export data only Allows export of data without well, horizontal and vertical 
labels.

Export Mean Data Allows export of all mean values of each data reduction step.

Export CV Data Allows export of CV values of each data reduction step.

Export SD Data Allows export of Standard Deviation values of each data 
reduction step.

Note: New Sheet and Existing Sheet only: A preview of the selected format is 
shown in the Preview window.
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Exporting Measurement Data to SoftMax Pro Software

At the conclusion of a read, Multi-Mode Analysis Software can export the raw 
data, plate settings, wavelength settings, kinetic parameters, and scan 
parameters to a text file that can then be imported into SoftMax Pro Software. 
Results, reductions, and template settings are not exported. Certain data 
might be altered to match the parameters for the data differ in each program. 
For example, in Multi-Mode Analysis Software, you can specify a shorter 
interval time for a kinetic read than can be specified in SoftMax Pro Software.

There are two methods of exporting Multi-Mode Analysis Software data to 
SoftMax Pro Software:

• Export Data to SoftMax Pro File Format exports measurement results to a 
text file in a format that can be used to import the data into SoftMax 
Pro Software.

• Start SoftMax Pro Software and Import Data exports measurement results 
to a formatted text file, and then opens SoftMax Pro Software and 
imports the data from the text file.

Exporting Data to SoftMax Pro File Format

At the conclusion of a read, Multi-Mode Analysis Software can export the data 
to a text file that can then be imported into SoftMax Pro Software. To do this, 
select the Export Data to SoftMax Pro File Format check box in the Output Settings 
window. See Configuring Output Settings on page 187.
The text file is save in the directory where Multi-Mode Analysis Software saves 
its measurement results export files. See Selecting a Directory for Saving 
Exported Measurement Results on page 37.
The exported text file is given a unique name based on the Result Name and 
Protocol Name for the read.
For example, if the Result Name is 20100922-021736 and the Protocol Name is 
x_FilterMaxF5_Abs_384well_405_kin, then the text file will have the following 
name: 20100922-021736_x_FilterMaxF5_Abs_384well_405nm_kin SMP.txt 
When you save the data from the Results Viewer, the raw data is exported 
again to a formatted text file. For information about saving data from the 
Results Viewer, see Saving Measurement Results on page 228.
For information about importing a text file into SoftMax Pro Software, see the 
user guide provided with the program.

Note: Before importing Multi-Mode Analysis Software data into SoftMax Pro 
Software, you must select an instrument in SoftMax Pro Software that 
supports the read types, methods, and modes that were used in the 
Multi-Mode Analysis Software protocol.
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Starting SoftMax Pro Software and Importing Data

If you have SoftMax Pro Software installed on the same computer as 
Multi-Mode Analysis Software, then you can export the data at the conclusion 
of the read and then start SoftMax Pro Software to automatically import the 
data. To do this, select the Start SoftMax Pro Software and Import Data check box 
in the Output Settings window. See Configuring Output Settings on page 187.
Before starting SoftMax Pro Software, an export file is generated and saved. 
For information about how to locate this export file, see Exporting Data to 
SoftMax Pro File Format on page 193.
After Multi-Mode Analysis Software finishes the read and exports the data, 
SoftMax Pro Software starts and then automatically imports the data from the 
text file.

Figure 7-33 Data imported into SoftMax Pro Software

You can immediately work with the imported data in SoftMax Pro Software, or 
save the data to work with it later. For information about working with data in 
SoftMax Pro Software, see the user guide provided with the program.
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Configuring a Program to Execute after 
a Protocol Run Completes

Output Settings can be configured to open an external software application 
after completing a protocol run. If the selected application supports entering 
commands using a command line interface, a specific command for the 
application may also be configured.
To configure a program to run after a protocol is executed:

1. In Output Settings, click Execute a program after protocol executes. Two 
configuration fields appear (Figure 7-34).

Figure 7-34 Configuring an External Software Application in Output 
Settings

2. In Execute Program, enter the complete path of the program to run; for 
example, C:\Windows\System32\Net.exe. Net.exe is a small utility 
supplied with Windows operating systems that sends messages to 
computers on the same network.
OR
Select Choose an external program to run at the end of measurement. The 
Open dialog appears.

3. In the Open dialog, browse to the location of the desired application 
and select it.

4. Click Open to return to Output Settings. The selected path appears in 
Execute Program.

5. If the selected application supports command line parameters, in 
Command line parameter, enter the desired parameter. For example, if 
using Net.exe, entering the parameters “SEND” “Workstation1” 
“Finished” instructs the application to send the message, “Finished,” to 
a computer named Workstation1 when the protocol run completes.
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Signing a Protocol

When GxP Permissions is enabled on the system, protocols may be signed to 
prevent the configured parameters from being edited. Protocols may be signed 
at any time after the configuration is complete.
Protocols may be signed by users who are assigned a role containing the Sign 
permission. See Configuring Roles for Multi-Mode Analysis Software User 
Accounts on page 76 for more information about roles and permissions.
To sign a protocol:

1. In the Protocol Selection List, select the protocol to sign.
2. From the tool bar, click Sign the selected protocol.

OR
From the menu bar select Actions > Sign the selected protocol.
OR
Right-click on the selected labware and select Sign the selected protocol.

3. The Sign the Selected Item dialog appears.
4. In the Sign the Selected Item dialog, add comments and an electronic 

signature by following the instructions in Adding Electronic Signatures 
and Comments to Items on page 84.

Creating a Protocol from a Template
Template protocols are used to create a protocol based upon the selected 
template. Pre-defined settings appear as the protocol is configured.
To create a protocol from a template:

1. From the tool bar, click Create.
OR
From the menu bar select Actions > Create a new protocol.
OR
Right-click in the Protocol Selection List and select Create a new protocol.

2. The Select Application Type dialog appears.
3. Select the Templates tab. 

Figure 7-35 Selecting the Application Type - Templates Tab

4. Select the Group and Type for the template. To obtain more information 
about the template protocol click on Info.
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5. Click Next to configure the protocol. The Create Protocol dialog 
appears, displaying General Settings. See Configuring General Settings 
on page 148. 

Running Protocols
Saved protocols may be accessed and run at any time, either on an instrument 
or in simulation mode. The run options available are different for each mode. 
For more information, refer to:

• Running a Protocol on an Instrument on page 197
• Running a Protocol When Simulation Mode is Enabled on page 209

Running a Protocol on an Instrument
Running a protocol on an instrument performs measurements on samples and 
outputs results data following the parameters configured in the protocol.

To run a protocol on an instrument:
1. In the Protocol Selection List, select the protocol to run.
2. From the tool bar, click Run. 

OR
From the menu bar select Actions > Run the selected protocol.
OR
Right-click on the selected protocol and select Run the selected protocol 
from the menu.

Note: Pre-defined settings appear as the protocol is configured. See 
Creating Protocols on page 146 for detailed information about 
configuring protocol parameters.

Note: To create or run quantitation protocols for a FilterMax Multi-Mode 
Microplate Readers instrument, a genomic filter slide, which contains narrow 
bandwidth 260 nm and 280 nm filters, must be installed and configured.

Note: When running an Analysis protocol with variables configured, 
Variables appear as the first screen in Run Protocol. Change the values 
of the variables, if desired, and click Next to continue. Prepare to Run 
appears.
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3. The Prepare to Run dialog appears (Figure 7-36).

Figure 7-36 Preparing to Run a Protocol on an Instrument

4. Enter a new unique Result Name, if desired. The name must not match 
any previous result names, including those pending deletion.

5. Specify the Number of Samples to measure per plate.
6. Specify the Number of Plates to read. Changing the number of plates to 

read will increase or decrease the number of plates to read as specified 
in the plate layout of the protocol.

7. Use the Read Sample ID’s button to import .DAT file format samples. 

8. As required, select Plate is lidded. 

CAUTION! It is important to select Plate is lidded when the plate has a lid due to 
the low reading height.

Note: If a multi-plate layout is specified in the plate layout only the first 
plate will contain controls and all following plates will contain only 
samples. If a multi-plate layout is not selected in the plate layout for 
every plate will contain the controls specified in the plate layout. For 
more information see Configuring Labware Layout Settings on 
page 151.

Note: Clicking on the plate layout icon provides an expanded view of 
the microplate in its current configuration. Limited editing of the plate 
is allowed from this expanded view.
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9. Use Eject Plate Carrier and Close Plate Carrier to load the microplate into 
the instrument, if necessary. 

10. Select the orientation that matches how the plate is positioned on the 
plate carrier: 
 Landscape: the long edges of the plate run parallel to the front of 

the instrument, with well A1 located in the upper left corner.
 Portrait: the short edges of the plate run parallel to the front of the 

instrument, with well A1 located in the upper right corner.
 Opposite Landscape: the edges of the plate run parallel to the front 

of the instrument, with well A1 located in the lower right corner.
 Opposite Portrait: the short edges of the plate run parallel to the 

front of the instrument, with well A1 located in the lower left corner.

11. When preparing to run a luminescence, fluorescence top, fluorescence 
bottom (SpectraMax Paradigm Multi-Mode Detection Platform only), 
fluorescence polarization, or time-resolved (TRF) protocol, select 
Optimize Read Height to automatically determine and set the optimal 
read height used in the protocol run. See Optimizing Read Height 
(FilterMax 5 Multi-Mode Microplate Reader) on page 200 or Optimizing 
Read Height (SpectraMax Paradigm Multi-Mode Detection Platform) on 
page 203.

Note: If running a quantitation protocol with either Pre read low or Pre 
read high selected for blank correction, insert the blank plate first. 
During the protocol run, there will be a pause which requests the 
measurement plate be inserted.

Note: Labware optimization should be performed for the selected plate 
orientation.

Note: Well A1 is identified in the plate graphic by a red highlight. 
Clicking on the layout preview will zoom the view of the plate layout.

Note: Optimize Read Height is available for the FilterMax 5 Multi-Mode 
Microplate Reader and SpectraMax Paradigm Multi-Mode Detection 
Platform only.

Note: SpectraMax Paradigm Multi-Mode Detection Platform only — 
Optimize Read Height is not available for Luminescence detection 
cartridges. For Luminescence detection cartridges the optimum read 
height is the closest distance between the read head and the 
microplate, as derived from the labware definition, and confirmed by 
the plate height detection.
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12. Click Run to start the protocol run. The Run Protocol runtime window 
appears (Figure 7-37).

Figure 7-37 Run Protocol Runtime Display

Optimizing Read Height (FilterMax 5 Multi-Mode 
Microplate Reader)

The FilterMax 5 Multi-Mode Microplate Reader features an objective lens that 
may be moved up and down to optimize the read height used in luminescence, 
fluorescence intensity top, fluorescence polarization, and time-resolved 
fluorescence protocols. Read height is the distance between the top or bottom 
(using bottom reading) surface of the microplate being read and the surface of 
the objective lens. Optimizing read height matches the focus of the optics with 
the sample volume. This maximizes the raw signal, which yields the highest 
precision and maximum sensitivity.
Read height is optimized using the Read Height Optimization Wizard 
(Figure 7-40). A single sample with a known maximum signal and volume is 
placed on the same type of microplate used in the protocol. The sample is 
measured using the same, or very similar, detection method used in the 
protocol.
The optimized read height is saved in the protocol and is used for all 
subsequent runs of the protocol until reset by performing a new optimization 
or manually selecting a read height option.
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To optimize the read height:
1. In Run Protocol, select Optimize Read Height. When clicking on Run, the 

Read Height Optimization Wizard appears (Figure 7-40).
2. Select the well measured to perform the optimization. Prepare Labware 

appears (Figure 7-38).

Figure 7-38 Selecting the Well Read in the Read Height Optimization

3. Use a standard or sample position with a good signal or pipette liquid 
with a known maximum signal to a single well on the microplate used in 
the optimization. The concentration of the optimization sample should 
be at least ten times greater than the detection limit. The sample 
volume should be the same as that of samples measured in the 
protocol. If using a layout with standards, the standard well closest to 
the center of the plate is pre-selected. If not using a layout with 
standards, the first sample is pre-selected. 

4. Load the plate into the instrument.
5. In Prepare Labware, select the well containing the optimization sample 

(Figure 7-38).

Note: When optimizing reading height for a fluorescence protocol, 
make sure the optimization sample is the same fluorescent substance 
the detection method is configured to detect.
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6. Click Next to start the optimization. Optimization in Progress appears 
(Figure 7-39). The optimization may take several seconds or up to 
several minutes depending on the detection methods used. 

Figure 7-39 Read Height Optimization in Progress

7. When the read is finished, Optimization Complete appears, displaying 
the Optimized Read Height (Figure 7-40). While the optimization is in 
progress, click Cancel to stop the optimization read and close the 
wizard, if desired. 

Figure 7-40 Read Height Optimization Completed

8. In the Optimization Complete window the Optimized Read Height is 
displayed. As desired, modify the Custom Read Height.

9. Click Save to save the optimized read height in the protocol. The 
optimized read height is used for all subsequent runs of the protocol 
until reset by performing a new optimization or manually selecting a 
read height option.
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Optimizing Read Height (SpectraMax Paradigm 
Multi-Mode Detection Platform)

The SpectraMax Paradigm Multi-Mode Detection Platform features an objective 
lens that may be moved up and down to optimize the read height used in 
luminescence, fluorescence intensity top and bottom, fluorescence 
polarization, and time-resolved fluorescence protocols. Read height is the 
distance between the top or bottom (using bottom reading) surface of the 
microplate being read and the surface of the objective lens. Optimizing read 
height matches the focus of the optics with the sample volume. This 
maximizes the raw signal, which yields the highest precision and maximum 
sensitivity.
Read height is optimized using the Read Height Optimization Wizard 
(Figure 7-41). A single sample with a known maximum signal is placed on the 
same type of microplate used in the protocol. The sample is measured using 
the same, or very similar, detection method used in the protocol.
The optimized read height is saved in the protocol and is used for all 
subsequent runs of the protocol until reset by performing a new optimization 
or manually selecting a read height option.
To optimize read height:

1. In Run Protocol, select Optimize Read Height. When clicking on Run, the 
Read Height Optimization Wizard appears. 

2. Select the well measured to perform the optimization. Prepare Labware 
appears (Figure 7-41).

Figure 7-41 Selecting the Well Read in the Read Height Optimization

Note: SpectraMax Paradigm Multi-Mode Detection Platform only — 
Optimize Read Height is not available for Luminescence detection 
cartridges. For Luminescence detection cartridges the optimum read 
height is the closest distance between the read head and the 
microplate, as derived from the labware definition, and confirmed by 
the plate height detection.
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3. Use a standard or sample position with a good signal or pipette liquid 
with a known maximum signal to a single well on the microplate used in 
the optimization. The concentration of the optimization sample should 
be at least ten times greater than the detection limit. The sample 
volume should be the same as that of samples measured in the 
protocol. If using a layout with standards, the middle most standard 
well is pre-selected. If not using a layout with standards, the first 
sample is pre-selected. 

4. Load the plate into the instrument.
5. In Prepare Labware, select the well containing the optimization sample 

(Figure 7-41).
6. Click Next to start the optimization. Optimization in Progress appears 

(Figure 7-42). The optimization may take several seconds or up to 
several minutes depending on the detection methods used. 

Figure 7-42 Read Height Optimization in Progress

Note: When optimizing reading height for a fluorescence protocol, 
make sure the optimization sample is the same fluorescent substance 
the detection method is configured to detect.
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7. When the read is finished, Optimization Complete appears, displaying 
the Optimized Read Height (Figure 7-43). While the optimization is in 
progress, click Cancel to stop the optimization read and close the 
wizard, if desired. 

Figure 7-43 Read Height Optimization Completed

8. In Optimization Complete, click Save to save the optimized read height 
in the protocol. The optimized read height is used for all subsequent 
runs of the protocol until reset by performing a new optimization or 
manually selecting a read height option.
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Viewing the Run Protocol Runtime Display

Once a protocol run begins, the Run Protocol runtime display shows 
information about the status and results of the current run.

Figure 7-44 Run Protocol Runtime Display

Run Protocol displays the following information:
• Elapsed Time: how much time has elapsed since the protocol started, in 

HH:MM:SS format.
• Temperature: the current temperature inside the instrument, in ºC.
• Current Method: the current detection or preparation method that is 

being executed.
• Raw Data (tab): dynamically displays the raw data for the selected 

detection method as it is read.
• Graph (tab): dynamically graphs the raw data as it is read for Kinetic or 

Scan measurements.
The protocol run may be stopped at any time using the Stop button at the 
bottom right of the screen.
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During certain preparation methods, such as Wait and Pause, a Continue or 
Skip button appears. The Continue button functions as described below 
depending on the Current Method:

• Pause: the protocol run pauses and displays a message. The protocol 
remains paused until the user selects Continue to resume the protocol 
(Figure 7-45).

Figure 7-45 Pause During a Protocol Run

Note: In Quantitation protocols using Pre read low or Pre read high for 
blank correction, Pause is used to exchange the blank plate with the 
measurement plate.
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• Wait: the protocols waits a predefined length of time as specified in the 
protocol definition before continuing the protocol run. The user may 
choose to end the wait and continue before the full length of time 
passes by clicking Skip (Figure 7-46).

Figure 7-46 Wait During a Protocol Run
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• Set Temperature: if the protocol is configured to set the temperature 
and Wait is True, the protocol pauses until the Set Temperature is 
reached. The user may resume the protocol at any time by clicking 
Skip, and the protocol continues at the current temperature; that is, it 
does not reach the desired Set Temperature (Figure 7-47).

Figure 7-47 Set Temperature During a Protocol Run

Running a Protocol When Simulation Mode is Enabled
Running a protocol in simulation mode allows the protocol configuration to be 
tested using simulated data before performing the protocol on actual samples. 
Simulated data is either generated randomly or read from a data file.
Simulation mode is automatically enabled when the host computer is not 
connected to an instrument. When an instrument is connected, simulation 
mode may be enabled manually in Instruments. See Enabling Simulation Mode 
on page 56.
To run a protocol in simulation mode:

1. In the Protocol Selection List, select the protocol to run.
2. From the tool bar, click Run the selected protocol. 

OR
From the menu bar select Actions > Run the selected protocol.
OR
Right-click on the selected protocol and select Run the selected protocol.

3. Prepare to Run appears (Figure 7-48).

Note: When running an Analysis protocol with variables configured, 
Variables appears as the first screen in Run Protocol. Change the 
values of the variables, if desired, and click Next to continue. Prepare 
to Run appears.
5008530 A 209 



Creating and Running Protocols
Figure 7-48 Preparing to Run a Protocol in Simulation Mode

4. Enter a new unique Result Name, if desired.
5. Select Check to generate random data to run the protocol using random 

data generated by the software, if desired.
6. In Use this data simulation file for this read: 

 Leave the directory path of the simulated data path as configured to 
use the data file selected in Software Settings. See Selecting 
Simulated Data Files on page 35.

 Browse to the location where the desired data file is saved and 
select it.

7. Click Run or Next to run the selected protocol.

Note: Results from prior measurements saved in .dat format may be used as 
simulated data files. See Configuring Output Settings. Simulated data files are 
used when the number of measurement points in the simulated protocol run 
is the same as those present in the data file. When the number of 
measurement points is different, the software generates random data.

When a different simulated data file is selected in Prepare to Run Protocol, 
the file is used for the current simulated run only. After the simulated run has 
finished, the data file defaults to the file selected in Software Settings. See 
Selecting Simulated Data Files.
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Editing Protocols
Parameters configured in a protocol may be edited. When the GxP Permissions 
module is enabled on the system, signed protocols may not be edited.

To edit a protocol:
1. In the Protocol Selection List, select the protocol to edit.
2. From the tool bar, click Edit the selected protocol.

OR
From the menu bar select Actions > Edit the selected protocol.
OR
Right-click on the selected protocol and select Edit the selected protocol.
OR
Double-click on the selected protocol.

3. The Edit Protocol window appears (Figure 7-49).

Figure 7-49 Editing an Fluorescence Polarization Protocol

4. Edit the parameters in each Edit Protocol screen as desired. See 
Creating Protocols on page 146 for detailed information about 
configuring protocol parameters.

5. Click Save to close Edit Protocol and save the changes.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Edit permission may edit protocol definitions. See 
Configuring Roles for Multi-Mode Analysis Software User Accounts on page 76 
for more information about roles and permissions.
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Copying Protocols
Copies may be made of existing protocols. A copy of an existing protocol may 
be used as a template for a new protocol using the same technique.

To make a copy of a protocol:
1. In the Protocol Selection List, select the protocol to copy.
2. From the tool bar, click Make a copy of the selected protocol. A copy of the 

selected protocol appears in the Protocol Selection List.
OR
From the menu bar select Actions > Make a copy of the selected protocol.
OR
Right-click on the selected protocol and select Make a copy of the selected 
protocol. 

Deleting Protocols
Protocols that are no longer used to perform measurements may be deleted 
from the Protocol Selection List. When the optional GxP Permissions module is 
enabled on the system, signed protocols may not be deleted.

To delete a user-defined protocol:
1. In the Protocol Selection List, select the protocol to delete.
2. From the tool bar, click Delete the selected protocol.

OR
From the menu bar select Actions > Delete the selected protocol.
OR
Right-click on the selected protocol and select Delete the selected 
protocol.

3. The delete message dialog appears.
4. Click Yes to delete the selected protocol. The protocol is moved to the 

Trash list (to permanently remove the protocol from the database see 
Deleting and Restoring Items on page 48. 

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Copy permission may create copies of protocols. See 
Configuring Roles for Multi-Mode Analysis Software User Accounts on page 76 
for more information about roles and permissions.

Signed protocols may be copied. Copies of signed protocols are unsigned and 
may be edited.

Note: The default name format for copied protocols is Copy of 
OriginalName. To change the name, open the protocol for editing and 
enter the new protocol name. See Editing Protocols on page 211.

Note: When GxP Permissions is enabled on the system, only users assigned a 
role containing the Delete permission may delete protocols. See Configuring 
Roles for Multi-Mode Analysis Software User Accounts on page 76 for more 
information about roles and permissions.
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Printing Protocol Configuration Information
Information about the protocol configuration and sample layout may be 
printed separately from measurement results.
To print protocol configuration information:

1. In the Protocol Selection List, select the protocol to print.
2. From the tool bar, click Print.

OR
From the menu bar select Actions > Print the selected protocol.
OR
Right-click on the selected protocol and select Print the selected protocol. 

3. If Show Printer Settings and Print Preview are not enabled in Print 
Settings, no additional configuration is required.
OR
If the Print dialog appears, configure printing options as desired and 
click OK. 

OR
If the Print Preview dialog appears, use the tool bar controls to change 
the magnification, layout view, or pages displayed, if desired.

4. In the Print Preview dialog, click Print to print out the measurement 
results.

5. In the Print Preview dialog, click Close to close the window. 

Note: Multiple protocols may be selected by holding down the CTRL key 
while selecting each protocol desired.

Note: Depending on how Print Settings are configured, Print or Print 
Preview may display before the protocol configuration prints. See 
Configuring Print Settings on page 38 for more information about 
enabling and disabling Print and Print Preview.

Note: Print is the dialog box that appears when Show Printer Settings is 
selected.

Note: Clicking Close without first clicking Print cancels printing.
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Exporting and Importing Protocols
A protocol can be exported to an XML file, which may be imported at a later 
time to restore the configuration saved in the file or shared with a copy of 
Multi-Mode Analysis Software installed on another system. Detection methods 
and labware configurations used in the protocol are also saved in the export 
file.
Protocols that use default detection methods and labware installed with Multi-
Mode Analysis Software may be imported and exported; however, default 
methods and labware are not imported with the protocol because these items 
are present on all systems and may not be edited, deleted, or overwritten.

To export a protocol:
1. In the Protocol Selection List, select the protocol to export.
2. From the File menu, click Export > Protocol. The Browse for Folder dialog 

appears.
3. In the Browse for Folder dialog, browse to the folder where the 

exported protocol will be saved.
OR
Click Make New Folder to create a new folder where the exported 
protocol will be saved.

4. Click OK to export the protocol. The exported protocol is saved using 
the default file name format, Protocol_ProtocolName.xml. To import the 
file at a later date, the filename must not be changed.

To import a protocol from an exported XML file:
1. From the File menu, select Import > Protocol. The Open dialog appears.
2. In the Open dialog, browse to and select the desired XML file to import.
3. Click Open. The protocol, as well as detection methods and labware 

used in the protocol, are imported. Any default detection methods or 
labware used in the protocol are not imported because default methods 
and labware may not be edited, deleted, or overwritten. Instead, the 
imported protocol uses the same default methods and labware stored in 
the software.

Note: When GxP Permissions is enabled, signed protocols may be exported for 
use on another system; however, electronic signatures attached to the 
protocol are not retained, which allows the protocol to be edited. Importing a 
signed method to the system from which it was originally exported is not 
permitted because signed methods may not be deleted or overwritten.
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Viewing Measurement Results
Overview
Measurement results from each protocol run are stored in the Multi-Mode 
Analysis Software database and are accessed from the Results Selection List 
(Figure 8-1), which also provides access to result actions and the ability to 
search for specific results based on names and/or dates.

Figure 8-1 Accessing Measurement Result Actions

Measurement results selected from the list are viewed in the Result Viewer, 
which, depending on measurement type, displays raw data from each 
measurement technique, measurement cycle or point, reduced data, and 
graphs. Results calculated using a data reduction method may be reevaluated 
using different parameters.
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Results may be reevaluated by editing analysis parameters configured in the 
protocol.
Result actions covered in this section include:

• Viewing Measurement Results in the Result Viewer on page 217
• Viewing and Reevaluating Results from an Analysis Application on 

page 229
• Viewing Exported Measurement Results on page 235

• Signing Measurement Results on page 238
• Deleting Measurement Results on page 239
• Printing Measurement Results on page 239

To view measurement results:
1. From the navigation pane, click Results. The Results Selection List 

appears (Figure 8-1).
2. In the Results Selection List, select the desired results and from the 

tool bar, click View. The Result Viewer appears (Figure 8-2).
OR
Use the search options to locate specific results. Table 8-1 describes the 
search options available. Results matching the search parameters 
appear in the Results Selection List.

Note: This section includes viewing measurement results exported to 
Microsoft Excel from the Result Viewer and results exported to XML or 
data files at the completion of a protocol run.

Table8-1 Measurement Results Search Options

Search 
Option Description

Result Name Enter a partial or complete Result Name. Searching for result names 
may also be limited to specific dates configured in Date.

Date Select the desired range option: Less Than or Equal, Equal, Greater 
Than or Equal, or Between, then select the desired dates.

Protocol Name Enter a partial or complete Protocol Name. Searching for protocol 
names may also be limited to specific dates configured in Date.

Go Perform the search. Matching results appear in the Results Selection 
List.

Clear Clear search results and display all measurement results in the 
Results Selection List.
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Viewing Measurement Results in the Result Viewer
Measurement results accessed from the Results Selection List are viewed in 
the Result Viewer (Figure 8-2). Results are displayed in a series of tabs. The 
tabs displayed depend on the measurement types configured in the protocol; 
for example, reduced data is not displayed when data reduction is not 
configured.
Results may also be printed, saved, or exported to a Microsoft Excel 
spreadsheet using the Result Viewer actions. Results calculated using data 
reduction may be reevaluated by editing data reduction parameters or 
selecting a different method.

Figure 8-2 Viewing Raw Data

This section covers Result Viewer functionality provided in the Data screen, 
which is displayed for analysis applications, including:

• Viewing Raw Data on page 218
• Viewing Blanked Data on page 219
• Viewing Reduced Data on page 221
• Viewing Mean Data on page 223
• Viewing Graphs on page 224
• Recalculating Data Reduction on page 227
• Exporting Measurement Results to Microsoft Excel on page 228
• Saving Measurement Results on page 228

Note: The Result Viewer also appears transformed measurement results for 
analysis options configured in the protocol. See Viewing and Reevaluating 
Results from an Analysis Application on page 229.
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Viewing Raw Data
The Raw Data tab appears all data measured during the protocol run 
(Figure 8-3). Depending on the measurement types configured in the protocol, 
the left pane lists all detection methods, measurement cycles, or wells in a 
tree view. Selecting a method, cycle, or well displays measured values and 
status in the right panel. A result may be rejected as an outlier when the value 
falls outside of the expected result.

To view raw data:
1. Select the Raw Data tab, if necessary. 

Figure 8-3 Viewing Raw Data

Note: Results for single-point measurements are displayed in Raw Data.
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2. From the tree view in the left pane, select the detection method, 
measurement cycle, or well desired to view. Results and status appear 
in the right pane. Table 8-2 describes the status indicators that may be 
displayed.

Viewing Blanked Data
The Blanked Data tab displays the well identifier, and the blanked data for each 
well measured during the protocol run (Raw Data – Blank Data = Blanked 
Data). The Blanked Data tab displays this information in a matrix 
corresponding to the plate layout (Figure 8-4). Depending on the 
measurement types configured in the protocol, the left pane lists all detection 
methods, measurement cycles, or wells in a tree view. Selecting a method, 
cycle, or well displays measured values and status in the right panel.

Table8-2 Well Status Indicators

Status Description

OK The sample was measured successfully.

Error The sample was not measured because an instrument error 
occurred.

Overflow No result is available because the value exceeds the 
indication limit.

Underflow No result is available because reduced data could not be 
calculated.

Extrapolated The result fell within the extrapolation percentage set for a 
standard curve.

Not Evaluated The measurement result was not evaluated.

Rejected The sample was rejected as an outlier by a user. Samples 
may be rejected in any tab displaying a matrix view of 
measurement results.

Unused The sample was not selected for measurement in the 
protocol.

Note: The Blanked Data tab is only available if the plate layout has blank wells 
specified in the plate layout.
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To view blanked data:
1. Select the Blanked Data tab, if necessary. 

Figure 8-4 Viewing Blanked Data

2. From the tree view in the left pane, select the detection method, 
measurement cycle, or well desired to view. Blank results and the well 
status appear in the right pane. Table 8-3 describes the status 
indicators that may be displayed.

Table8-3 Well Status Indicators

Status Description

OK The sample was measured successfully.

Error The sample was not measured because an instrument error 
occurred.

Overflow No result is available because the value exceeds the 
indication limit.

Underflow No result is available because reduced data could not be 
calculated.

Extrapolated The result fell within the extrapolation percentage set for a 
standard curve.

Not Evaluated The measurement result was not evaluated.

Rejected The sample was rejected as an outlier by a user. Samples 
may be rejected in any tab displaying a matrix view of 
measurement results.

Unused The sample was not selected for measurement in the 
protocol.
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Viewing Reduced Data
The Reduced Data tab is displayed when the detection methods configured in 
the protocol use data reductions (Figure 8-5). You can view PathCheck® 
Pathlength Measurement Technology adjusted results in the Reduced Data tab. 
Wells may also be rejected as outliers when the calculated value falls outside 
of the expected result. Reduced data for the plate may be recalculated with 
outliers removed, if desired.

Figure 8-5 Viewing Reduced Data for a measurement Performed in a 
Multiwavelength Protocol

Note: Reduced data may be also shown as 2D or 3D graphic by clicking the 
graphic symbol at the top left corner of the plate grid.
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For a Quantitation protocol, each Quantitation application that was performed 
as part of the protocol is listed in Reduced Data. Results for each application 
type can be viewed by selecting the desired application.

Figure 8-6 Viewing Reduced Data for a Measurement Performed in a 
Quantitation protocol

To view reduced data, reject outliers, and recalculate reduced data:
1. Select the Reduced Data tab, if necessary.
2. If multiple detection methods with data reduction techniques are 

configured in the protocol, select the desired data reduction technique 
from the left pane. Reduced data for selected method appear in the 
right pane.
OR
For a Quantitation protocol, if multiple Quantitation applications are 
selected for the protocol, select the desired application. Reduced data 
for the selected Quantitation application is displayed.

3. To reject a well as an outlier, right-click on the desired well and select 
Reject Well. A red X appears over the well and the Reevaluate current 
measurement results button appears on the tool bar. 

4. From the tool bar, click Reevaluate current measurement results to 
recalculate the results with outliers removed. 

Note: Multiple wells may be rejected as outliers. Rejected wells may be 
included in the measurement results again by right-clicking on each 
well desired and selecting Accept Well.

Note: The Reevaluate button appears on the tool bar only when a 
parameter in the results, such as data reduction technique, has been 
edited.
222 5008530 A 



Multi-Mode Analysis Software User Guide
Viewing Mean Data
The Mean Data and Mean Data List tabs display the well identifier, mean 
(reduced) value, well status, coefficient of variation (CV%), and standard 
deviation for replicate groups. The Mean Data tab displays this information in a 
matrix corresponding to the plate layout (Figure 8-7); the Mean Data List tab 
displays the same information in a list. Mean data are calculated and displayed 
for each result of the data reduction.

Wells may be rejected as outliers when the calculated value falls outside the 
expected result. The results may be recalculated with outliers removed, if 
desired.

Figure 8-7 Viewing Mean Data

To view mean data:
1. Select the Mean Data tab, if necessary.
2. Select Show Status to show the measurement status for each well, if 

desired. Table 8-2 describes the status indicators that may be 
displayed.

3. Select Show Well Identifier to show identifiers for each well, if desired.
4. To reject a well as an outlier, right-click on the desired well and select 

Reject Well. A red X appears over the well and the Reevaluate current 
measurement results button activates on the tool bar.

Note: The Mean Data tab is only available if the protocol has replicates in the 
plate layout.

Note: Multiple wells may be rejected as outliers. Rejected wells may be 
included in the measurement results again by right-clicking on each 
well desired and selecting Accept Well.
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5. Click Reevaluate current measurement results to recalculate the results 
with outliers removed.

Viewing Graphs
The Graphs tab displays graphs for all measured wells on a plate (Figure 8-8). 
The detection methods configured in the protocol determine the types of 
graphs displayed.

Figure 8-8 Viewing Kinetic Measurement Graphs

Detailed graphs for individual samples, all samples in a column or row, or all 
samples on the plate may be viewed and printed. To view detailed graphs for:

• an individual sample: click in the desired well. Depending on 
measurement type, a two- or three-dimensional graph of the selected 
result appears. See Viewing Two-Dimensional Graphs on page 225 or 
Viewing Three-Dimensional Graphs on page 226.

Note: The Reevaluate button appears on the tool bar only when a 
parameter in the results, such as an outlier, has been changed.

Note: If Sample-ID was used on the run protocol screen, Sample-ID is 
also displayed here.

Note: Detailed graphs for individual samples may be viewed for all 
measurement types, even when the graphs displayed appear to be 
empty.
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• a row or column: click in the desired row or column header. A three-
dimensional graph of results for the row or column appears. See 
Viewing Three-Dimensional Graphs on page 226.

• all samples on the plate: click in the upper left corner of the plate layout 
(Figure 8-10). A three-dimensional graph of all results on the plate 
appears. See Viewing Three-Dimensional Graphs on page 226.

Viewing Two-Dimensional Graphs

Results for individual single-point, kinetic, and linear scan measurements are 
displayed in two-dimensional graphs (Figure 8-9). Two-dimensional graphs 
may be printed.

Figure 8-9 Viewing a Two-Dimensional Absorbance Graph

To print the graph:
1. From the File menu, select Print. 

Note: Rows and columns may not be selected for multiwavelength and 
area scan measurement results.

Note: All samples may not be selected for multiwavelength and area 
scan measurement results.

Note: Depending on how Print Settings are configured, Print and/or 
Print Preview may display before the protocol configuration prints. See 
Configuring Print Settings on page 38 for more information about 
enabling and disabling Print and Print Preview.
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2. If Show Printer Settings and Print Preview are not enabled in Print 
Settings, the graph prints automatically.
OR
If the Print dialog appears, configure printing options as desired and 
click OK. 

OR
If Print Preview appears, use the tool bar controls to change the 
magnification, layout view, or pages displayed, if desired. See Printing 
Measurement Results on page 239 for more information about Print 
Preview.

Viewing Three-Dimensional Graphs

Selecting an individual area scan graph, a row, column, or all samples in the 
Graph tab displays a three-dimensional graph (Figure 8-10). Three-
dimensional graphs may be rotated horizontally or vertically and printed.

Figure 8-10 Viewing a Three-Dimensional Area Scan Graph

To rotate the graph:
1. Use the vertical scroll bar to rotate the graph vertically.
2. Use the horizontal scroll bar to rotate the graph horizontally.
3. Double-click on the graph to start and stop a continuous animated 

horizontal rotation of the graph.

Note: Print is the dialog box that appears when Show Printer Settings is 
selected.
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To print the graph:
1. From the File menu, click Print.

OR
Right-click on the graph and select Export Dialog and then select Print. 

2. If Show Printer Settings and Print Preview are not enabled in Print 
Settings, the graph prints automatically.
OR
If the Print dialog appears, configure printing options as desired and 
click OK. 

OR
If the Print Preview dialog appears, use the tool bar controls to change 
the magnification, layout view, or pages displayed, if desired. See 
Printing Measurement Results on page 239 for more information about 
Print Preview.

Recalculating Data Reduction
The Edit tab allows reduced data to be recalculated by editing the parameters 
of the current data reduction method or by selecting a different data reduction 
method (Figure 8-11). Data reduction may be recalculated for any detection 
method configured with data reduction in the protocol.

Figure 8-11 Changing Data Reduction Parameters in the Results Viewer

Note: Depending on how Print Settings are configured, Print and/or 
Print Preview may display before the protocol configuration prints. See 
Configuring Print Settings on page 38 for more information about 
enabling and disabling Print and Print Preview.

Note: Print is the dialog box that appears when Show Printer Settings is 
selected.
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To change parameters:
1. Click the Edit tab, if necessary.

2. In the Edit tab, click Report Options and select the method information 
and measurement results data included in printouts:
 Method Information: details about the configured method, including 

technique type and filters used.
 Graph: graphs of results for all measured samples.
 Raw Data: results from each detection method, kinetic cycle, or well 

scanned.
3. Click Reevaluate current measurement results to recalculate the results 

using the new data reduction configuration. 

Exporting Measurement Results to Microsoft Excel
Results displayed in the Result Viewer may be exported to Microsoft Excel. 
Exported results are saved in the directory selected in Directory Settings. See 
Selecting a Directory for Saving Exported Measurement Results on page 37.
To export results to Excel:

1. From the tool bar, select Export the current measurement results to Excel. 
Excel opens automatically.

2. In Excel, note that exported results appear in multiple workbooks. A 
workbook may contain general information and raw data for a single 
detection method, or general information and reduced data. 

Saving Measurement Results
The measurement results currently being viewed may be saved to the 
database from within the Result Viewer, which allows results that have been 
reevaluated by editing data reduction or analysis parameters to be saved with 
a different name. Optionally, parameters edited in the Result Viewer may be 
saved in the original protocol definition.

Note: Refer to Data Reduction Techniques on page 241 for details about 
the data reduction methods available for different measurement types.

Note: The Reevaluate button appears on the tool bar only when a 
parameter in the results, such as a data reduction technique, has been 
edited.

Note: See Exporting Measurement Results to Microsoft Excel on 
page 228 for information about viewing exported results in Excel.
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To save measurement results:
1. From the tool bar, click Save the current measurement results to the 

database. The question dialog appears, asking if the existing results 
should be overwritten.

2. Click Yes to overwrite existing results. The results are overwritten and a 
message dialog appears, asking if parameters edited in the Result 
Viewer should also be saved to the protocol definition. Proceed to 
Step 3. 

OR
Click No to save the results with a different name. Result Name 
appears.

3. Enter a new name for the results and click OK. The results are saved to 
the database. The message dialog appears, asking if parameters edited 
in the Result Viewer should also be saved to the protocol definition.

4. Click Yes to save the new parameters to the protocol definition. 

OR
Click No to ignore any changes made and retain the original parameters 
configured in the protocol.

Viewing and Reevaluating Results from an 
Analysis Application

The Result Viewer appears measurement results, transformed data from the 
analysis options configured in the protocol, and the parameters currently 
configured for each analysis option.
Multiple “what if?” analyses on transformed data may be performed by editing 
the parameters configured for an analysis option and then reevaluating the 
data with the new parameters.
This section covers:

• Viewing Results From an Analysis Protocol on page 230
• Reevaluating Results from an Analysis Protocol on page 233

Note: When GxP Permissions is enabled on the system, measurement 
results that have been signed may not be overwritten. See Signing 
Measurement Results for more information about signing results.

Note: When GxP Permissions is enabled on the system, parameters 
changed in the Result Viewer may not be saved to protocols that have 
been signed.

Note: See Viewing Measurement Results in the Result Viewer on page 217 for 
information about viewing results reported in the Data screen, recalculating 
data reduction, and exporting and saving results.
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Viewing Results From an Analysis Protocol
All analysis options configured in the protocol appear in the navigation pane of 
the Result Viewer (Figure 8-12). Transformed data and parameters for the 
selected analysis option appear in a series of tabs.
To view analysis results and parameters:

1. In the navigation pane, select the desired analysis option. Only analysis 
options configured in the protocol are listed. A series of tabs with 
results from the selected analysis option appears (Figure 8-12).

Figure 8-12 Viewing Existing Transformation Parameters in the Results 
Viewer

2. Select the tab desired to view. Table 8-4 describes each tab and lists 
which analysis options display the tab.
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Changing the Standard Curve Graph View

The standard curve graph view may be changed by zooming in on a selected 
region or changing view options.
To zoom in on a region of the graph:

1. Position the cursor at the desired starting point for the region, then 
click and hold the mouse button down. The cursor icon changes to a 
magnifying glass.

2. Drag the mouse until the desired region is selected. The selected region 
is highlighted in black.

3. Release the mouse button. The selected region is displayed.
To zoom out and view the graph at the original size:

• Right-click on the graph and select Undo Zoom from the menu that 
appears.

Table8-4 Measurement Results Tabs Displayed for Analysis Options

Tab Description displays In

Layout View displays transformed results and 
measurement status for the selected 
analysis option in a matrix corresponding 
to the plate layout.

Note: Results may be rejected as 
outliers in any Layout View tab. To 
reject a result, right click on the 
desired sample and select Reject Well. 
Results may be reevaluated with 
outliers removed.

Transformation 
Concentration Cutoff

List View displays transformed results and 
measurement status for the selected 
analysis option in a list.

Transformation 
Concentration Cutoff

Standard Curve displays a graph of the standard curve. See 
Changing the Standard Curve Graph View 
on page 231 for information about 
customizing the graph display.

Concentration

Parameters displays the parameters used to calculate 
the transformed data currently displayed in 
the Layout View and List View tabs.

Variables 
Transformation 
Concentration Cutoff 
Validation

Edit Edit the parameters configured for the 
analysis option using the same 
configuration screen that appears in the 
Create Protocol wizard. See Reevaluating 
Results from an Analysis Protocol on 
page 233.

Variables 
Transformation 
Concentration Cutoff 
Validation
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To change view options:
• Right-click on the graph and select a view option from the menu that 

appears. Table 8-5 describes the view options available.
Table8-5 Standard Curve Graph View Options

View Option Description

Viewing Style Select how the graph is displayed: in Color, Monochrome, or 
Monochrome with symbols.

Numeric Precision Select the numeric precision of graph data displayed on the 
screen or exported to text files. Precision up to three decimal 
positions may be specified.

Plotting Method Select how the graph is plotted. Line is the default method.

Data Shadows Enable shadows that give the graph a 3-D appearance.

Grid Options Customize the grid display. Grid lines may be displayed, 
hidden, or changed to a different style, such as thick, thin, or 
dashed.

Include Data Labels Select to display labels for data points on the curve.

Mark Data Points Select to mark each data point with a small circular symbol.

Undo Zoom Select to display a zoomed graph at the original size. 
Available only when the graph is zoomed.

Maximize Select to display a full-screen version of the graph. Close the 
maximized view by pressing the Esc key or clicking on the 
title bar of the maximized window.

Customization Dialog Open the Customization dialog box. Customization options 
are grouped in a series of tabs:
• General: Enter a title for the graph, change the viewing 

style (color or monochrome), set the numeric precision 
up to 3 decimal positions, and change the grid 
appearance.

• Plot: Change the plotting method, and enable or disable 
3-D shadows and data point markers.

• Subsets: This tab contains no configurable options.
• Axis: Change the properties of the X- and Y-axes.
• Font: Change the font used for titles and labels.
• Color: Change the color of any graph attribute except 

data points and lines.
• Style: Change the colors and styles of data points and 

lines displayed in the graph.

Note: Many of the options available in Customization 
are the same as those in the menu that appears when 
right-clicking on the graph.

Export Dialog Open the Export dialog box.
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Reevaluating Results from an Analysis Protocol
Multiple “what if?” analyses on transformed data may be performed by editing 
the parameters configured for an analysis option and then reevaluating the 
data with the new parameters. The parameters used to calculate the 
transformed data currently displayed in the Result Viewer are viewed in the 
Parameters tab. Parameters are edited in the Edit tab.
To reevaluate measurement results:

1. In the left pane, select an analysis option to edit. Only analysis options 
configured in the protocol are listed. The selected analysis option 
appears (Figure 8-13).

Figure 8-13 Viewing Existing Transformation Parameters in the Results 
Viewer

2. Select the Layout View or List View tab to view the current transformed 
data. Layout View displays data in a matrix corresponding to the plate 
layout; List View displays the same data in a list.

3. Select the Parameters tab to view the parameters used to calculate the 
transformed data currently displayed; for example, Figure 8-13 shows 
transformation parameters.

Note: Select Data to view measurement results and edit data reduction 
parameters configured in the protocol. See Viewing Measurement 
Results in the Result Viewer on page 217 for more information.
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4. Select the Edit tab to edit parameters as desired (Figure 8-14). 
Parameters in the Edit tab are identical to those in the corresponding 
screen in the protocol configuration. Refer to the appropriate section for 
more information: 
 Configuring Variables on page 170
 Configuring a Transformation Formula on page 177
 Configuring Concentration on page 179
 Configuring Cutoff Values on page 183
 Configuring Validation Rules on page 185

Figure 8-14 Figure8.14Editing Transformation Parameters in the Results 
Viewer

5. Edit additional analysis options, if desired.
6. From the tool bar, click Reevaluate current measurement results to 

recalculate the results using the edited parameters. 

7. Optionally, save the reevaluated results with a different name to 
preserve a record of changes made to the parameters. See Saving 
Measurement Results on page 228.

Note: The Reevaluate button appears on the tool bar only when a 
parameter in the results, such as the transformation formula, has been 
changed.
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Viewing Exported Measurement Results
Measurement results may be exported manually from the Results Viewer or 
automatically at the end of a protocol run when export options are configured 
in Output Settings.
Two file export and save options are available:

• Export to Microsoft Excel: saves results in a format compatible with 
Microsoft Excel, and automatically opens Excel. See Viewing 
Measurement Results in Microsoft Excel on page 235 for more 
information about viewing exported results in Excel.

• Create XML and DAT data files: saves results in XML and tab-delimited 
data (.dat) files, which may be opened by compatible software 
applications.

To view saved measurement results:
1. Open the desired software application.
2. Browse to the directory where exported measurement results are 

stored, and open the desired file. Exported measurement results are 
stored in the data directory selected in Software Settings. See Selecting 
a Directory for Saving Exported Measurement Results on page 37.

Viewing Measurement Results in Microsoft Excel
When measurement results for a protocol run are exported to Excel, multiple 
workbooks (spreadsheets) are created. A workbook is created for the raw data 
read for each detection method configured in the protocol. Reduced and 
transformed data are included in a separate workbook.
This section covers:

• Viewing Protocol and Measurement Information on page 236
• Viewing Raw Data on page 237
• Viewing Reduced and Transformed Data on page 237

Note: Multi-Mode Analysis Software automatically determines the 
appropriate export method based on the version of Microsoft Office 
installed on the host computer. XML (.xml) files are exported when 
Office XP is installed. When Office 2000 installed, the measurement 
results are copied into a new spreadsheet which must be saved in 
Excel. Versions of Excel prior to Office 2000 are not supported by the 
Export to Microsoft Excel function, but can open measurement results 
stored in tab-delimited data (.dat) files.

Note: See Configuring Output Settings on page 187 for more 
information about configuring export and file options.
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Viewing Protocol and Measurement Information

Information about the system and parameters configured in the protocol is 
saved in the General worksheet. General is included in all worksheets exported 
from a set of measurement results (Figure 8-15).

Figure 8-15 Viewing Protocol Information in the General Worksheet (excerpt)

To view the General worksheet:
1. In Excel, access either workbook containing the desired results.
2. Select the General tab in the lower left corner of the window.
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Viewing Raw Data

Measurement results exported to Excel display raw data in matrices 
corresponding to the plate layout (Figure 8-16). Data from each measurement 
cycle or point is presented in a separate sheet within the workbook.

Figure 8-16 Viewing Reduced Data (excerpt)

To view raw data:
1. In Excel, access the workbook containing raw data for the desired 

measurement results. Titles of workbooks containing raw data always 
contain the name of a specific detection method configured in the 
protocol; for example, ABS340 (Figure 8-16).

2. In the worksheet, select the Cycle tab for the desired measurement 
cycle.

Viewing Reduced and Transformed Data

Reduced and transformed data are exported to a different Excel workbook 
than raw data. Reduced data generally appears in a sheet named 
Measurement; transformed data appears in sheets with names corresponding 
to the analysis options configured in the protocol.

Note: Results from protocols containing multiple detection methods export 
raw data from each detection method to a separate workbook. The title of 
workbooks containing raw data always includes the name of the detection 
method.

Note: Transformed data appears in results for protocols with analysis options 
configured.
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Figure 8-17 Viewing Reduced Data (excerpt)

To view reduced or transformed data:
1. In Excel, access the workbook containing reduced or transformed data 

for the desired measurement results. Workbooks containing reduced or 
transformed data always contain ResultData in the title.

2. In the worksheet, click the desired tab to view.

Signing Measurement Results
On systems with the GxP Permissions module enabled, measurement results 
may be signed to prevent them from being deleted or overwritten. Signed 
results from protocols configured with data reduction and/or analysis options 
may be reevaluated; however, reevaluated results must be saved using a 
different name. Reevaluated results are not signed by default.
Results may be signed at any time by users who are assigned a role containing 
the Sign permission. See Configuring Roles for Multi-Mode Analysis Software 
User Accounts on page 76 for more information about roles and permissions.
To sign measurement results:

1. In the Results Selection List, select the measurement results to sign.
2. From the tool bar, click Sign the selected result.

OR
From the menu bar select Actions | Sign the selected result.
OR
Right click on the desired results and select Sign the selected result.

3. The Sign the Selected Item dialog appears.
4. In Sign the Selected Item, add an electronic signature by following the 

instructions in Adding Electronic Signatures and Comments to Items on 
page 84.
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Deleting Measurement Results
Measurement results may be deleted from the Results Selection List. When the 
GxP Permissions module is enabled on the system, results that have been 
signed may not be deleted. See Signing Measurement Results on page 238.

To delete measurement results:
1. In the Results Selection List, select the results to delete.
2. From the tool bar, click Delete.

OR
From the menu bar select Actions > Delete the selected result.
OR
Right-click on the desired results and select Delete the selected result. 

3. The delete message dialog appears.
4. Click Yes to delete the selected results. The selected results are moved 

to the Trash list. To permanently remove the results from the database 
see Deleting and Restoring Items on page 48.

Printing Measurement Results
Measurement results may be printed from the Results Selection List or the 
Result Viewer. Printed reports include information about the protocol and all 
Report Options configured in the protocol.
Depending on how Print Settings are configured, Print and/or Print Preview 
may display before the measurement results print. See Configuring Print 
Settings on page 38 for information about enabling and disabling Print and 
Print Preview.
To print measurement results:

1. To print from the Results Selection List, select the results to print and 
click the print button on the tool bar.
OR
To print from the Result Viewer, click the print button on the tool bar.

2. If Print appears, configure printing options as desired and click OK.
OR
If the Print Preview dialog appears, use the tool bar controls to change 
the magnification, layout view, or pages displayed, if desired.

3. In the Print Preview dialog, click Print to print out the measurement 
results.

4. In the Print Preview dialog, click Close to close the window. 

Note: When GxP Permissions is enabled, only users assigned a role containing 
the Delete permission may delete measurement results. See Configuring 
Roles for Multi-Mode Analysis Software User Accounts on page 76.

Note: Multiple items may be selected for deletion by holding down the 
CTRL or SHIFT key while selecting each item desired.

Note: Clicking Close without first clicking Print cancels the printout.
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Data Reduction Techniques
Supported Data Reduction Techniques
The tables in this section describe the data reduction techniques supported by 
the software:

• Table A-1 describes the techniques available for scan measurements 
and measurement sequences configured in protocols.

• Table A-2 describes the techniques available for kinetic measurements.
• Table A-3 describes techniques available for fluorescence polarization 

measurements performed on a FilterMax 5 Multi-Mode Microplate 
Reader or a SpectraMax Paradigm Multi-Mode Detection Platform.

TableA-1 Scan Measurement Data Reduction Techniques

Data Reduction 
Technique Description Parameters

Delta Difference between the first and last 
points measured in a well.

N/A

Mean Determines the mean value per sample 
from the points measured.

N/A

Peak Value Used to detect the highest measured 
value per sample.

Smoothing Points

Standard Deviation Calculates the standard deviation for each 
well.

N/A

Coefficient of 
Variation

Calculates the coefficient of variation for 
each well.

N/A
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TableA-2 Kinetic Data Reduction Techniques

Data 
Reduction 
Technique

Description Parameters

Average Slope Determines the average slope of the reaction 
curve by calculating the average of all linear 
regressions calculated over each group of 
Smoothing Points in the kinetic reading 
sequence. A decreasing slope shows a decline.

Smoothing Points

Delta Difference between the first and last kinetic 
measurements in a protocol run.

N/A

Delta Max Slope Difference between the first measurement and 
the center point of the maximum slope.

Note: The center point of the maximum 
slope is calculated by determining the 
center point between the smoothing points 
of the regression line with the maximum 
slope.

Smoothing Points

Delta Time 
Absolute

Time elapsed from one preselected 
measurement value to another.

Lower Limit Upper 
Limit

Delta Time Max 
Slope

Time difference in seconds between the first 
measurement and the occurrence of the center 
point of the maximum slope.

Note: The center point of the maximum 
slope is calculated by determining the 
center point between the smoothing points 
of the regression line with the maximum 
slope.

Smoothing Points

Delta Time 
Relative

Time elapsed in seconds from the first 
measurement to reaching a set 
increase/decrease amount from the first 
measurement value.

In-/Decrease

Max Declining 
Slope

Determines the maximum declining rate of the 
reaction curve by calculating a linear regression 
over each group of Smoothing Points in the 
kinetic reading sequence.

Smoothing Points

Max Inclining 
Slope

Determines the maximum inclining rate of the 
reaction curve by calculating a linear regression 
over each group of Smoothing Points in the 
kinetic reading sequence.

Smoothing Points

Max Slope Maximum slope of the curve in measurement 
value/min. The line with the highest slope is 
calculated, along with maximum reaction speed.

Note: The accuracy of this calculation 
depends on the number of measurement 
cycles selected.

Smoothing Points

Mean Determines the mean value per sample within a 
sequence of measurements.

N/A

Time Peak Used to detect the time elapsed until the peak 
value is reached.

Smoothing Points

Peak Value Used to detect the highest value per sample 
within a sequence of measurements.

Smoothing Points
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a In polarization data reduction techniques, intensity defines sample raw data minus the 
average of blank replicate raw data.

b The G-factor factors out differences in detection efficiency between the polarization 
planes. The default G-factor is derived from fluorescein measurements performed on 
several instruments. If a more accurate G-factor has been determined for the connected 
instrument, it may be entered in the data reduction method configuration.

c Threshold defines the minimum number of counts; values measured below the threshold 
are noise.

TableA-3 Fluorescence Polarization Data Reduction Techniques (FilterMax 5 Multi-Mode 
Microplate Reader and SpectraMax Paradigm Multi-Mode Detection Platform)

Data Reduction 
Technique Description Parameters

Polarization Ratio of the difference between the parallel and the 
perpendicular polarization intensitya components divided by 
the sum of the two orthogonal fluorescence intensity 
components. Polarization is calculated according to the 
formula:

G-Factorb Thresholdc 

Total Intensity Provides raw fluorescence intensitya measurements in the 
parallel and the perpendicular polarization planes with respect 
to the plane of linearly polarized excitation light. Total intensity 
is calculated according to the formula:

G-Factorb 

Anisotropy The ratio of the difference between the parallel and 
perpendicular polarization intensitya components divided by 
the sum of the fluorescence intensity parallel to the excitation 
plane plus the fluorescence intensity perpendicular to the 
excitation plane multiplied by two. Anisotropy is calculated 
according to the formula:

G-Factorb Thresholdc 
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B
PathCheck® Pathlength Measurement 
Technology
Overview
(SpectraMax® Paradigm® Multi-Mode Detection Platform and FilterMax™F5 
Multi-Mode Microplate Reader only) 
The Beer–Lambert law states that absorbance is proportional to the distance 
that light travels through the sample:

where A is the absorbance,  is the molar absorbtivity of the sample, b is the 
pathlength and c is the concentration of the sample. In short, the longer the 
pathlength, the higher the absorbance.
Microplate readers use a vertical light path so the distance of the light through 
the sample depends on the volume. This variable pathlength makes it difficult 
to perform extinction-based assays and also makes it confusing to compare 
results between microplate readers and spectrophotometers reading cuvettes.
The standard pathlength of a cuvette is the conventional basis for quantifying 
the unique absorbtivity properties of compounds in solution. Quantitative 
analyses can be performed on the basis of extinction coefficients, without 
standard curves (for example, NADH-based enzyme assays). When using a 
cuvette, the pathlength is known and is independent of sample volume, so 
absorbance is proportional to concentration.
In a microplate, pathlength is dependent on the liquid volume, so absorbance 
is proportional to both the concentration and the pathlength of the sample. 
Standard curves are often used to determine analyte concentrations in 
vertical-beam photometry of unknowns, yet errors can still arise from pipetting 
the samples and standards. The PathCheck® Pathlength Measurement 
Technology feature automatically determines the pathlength of aqueous 
samples in the microplate and normalizes the absorbance in each well to a 
pathlength of 1 cm. This patented approach to correcting the microwell 
absorbance values is accurate to within 3% of the values obtained directly in a 
1 cm cuvette.

Figure B-1 Cuvette and Microwell light paths

Reference measurements made using factory-stored values derived from 
deionized water can be used to normalize the OD data for microplate wells. 
PathCheck Pathlength Measurement Technology is used to normalize the data 
acquired from absorbance endpoint microplate readings to a 1 cm pathlength, 
correcting the OD for each well to the value expected if the sample were read 
in a 1 cm cuvette.

cuvette microplate wells

vertical light path

horizontal 
light path
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The SpectraMax Paradigm Multi-Mode Detection Platform and FilterMax F5 
Multi-Mode Microplate Reader offer a water-constant method of pathlength 
correction. For the FilterMax F5 Multi-Mode Microplate Reader, the water 
constant is stored in the instrument. For the SpectraMax Paradigm Multi-Mode 
Detection Platform, the water constant is stored in the Absorbance Detection 
Cartridge.
The actual pathlength, d, of a solvent is found from the following equation:

When the water constant is used for pathlength correction, the value of k is 
obtained from the instrument or cartridge. This constant is saved in the 
instrument or cartridge in the factory and may differ slightly from instrument 
to instrument or cartridge to cartridge.
After the pathlength d is found, the following equation is used for the 
pathlength correction:

Using the PathCheck Pathlength Measurement Technology 
Water Constant

The PathCheck Pathlength Measurement Technology on the SpectraMax 
Paradigm Multi-Mode Detection Platform and FilterMax F5 Multi-Mode 
Microplate Reader uses a water constant reference. Be aware that if your 
sample matrix contains an organic solvent such as ethanol or methanol, the 
estimated pathlengths will be lower than the true values, and PathCheck 
Pathlength Measurement Technology normalized values will be higher than the 
corresponding 1 cm values.
The PathCheck Pathlength Measurement Technology measurement is based on 
the absorbance of water in the near infrared region (between 900 nm and 
1000 nm). If the sample is completely aqueous, has no turbidity and has a low 
salt concentration (less than 0.5 M), the water constant is adequate. The 
water constant is determined during manufacture and is stored in the 
instrument or cartridge.
To enable PathCheck for Absorbance readings, you must first set up a 
detection method with the PathCheck Pathlength Measurement Technology 
enabled. See Creating and Editing Detection Methods on page 87.
When you edit a protocol that uses PathCheck Pathlength Measurement 
Technology, and you have determined a plate background constant for your 
microplate, you can enter the value in the Plate Background field. See Use Plate 
Background Constant on page 247 and Creating Protocols on page 146.
After you have read a plate with the PathCheck Pathlength Measurement 
Technology enabled, PathCheck Pathlength Measurement Technology program 
information is stored permanently in the data file. You have the option of 
applying, or not applying, the PathCheck Pathlength Measurement Technology 
to the absorbance values as you choose. If you did not have PathCheck turned 
on during the plate read, you cannot apply the PathCheck Pathlength 
Measurement Technology after the read.
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Background Constant Subtraction and Blanking 
Considerations
Raw OD measurements of microplate samples include both pathlength-
dependent components (sample and solvent) and a pathlength-independent 
component (OD of microplate material). The pathlength-independent 
component must be eliminated from the PathCheck Pathlength Measurement 
Technology calculation in order to get valid results that have been normalized 
by PathCheck Pathlength Measurement Technology. You can accomplish this by 
using a plate background constant.

Use Plate Background Constant

To determine Plate Background Constants:
1. Fill a clean microplate with water.
2. Read at the wavelengths you will be reading your samples.
3. The average OD value is the Plate Background Constant. Enter it in the 

Plate Background field in the Method Selection step of editing a protocol.
4. If you intend to read your samples at more than one wavelength, there 

should be a corresponding number of Background Constants.
It is important that you put water in the wells and not read a dry plate for the 
Background Constant. Dry plates have a slightly higher OD value than a water-
filled plate because of differences in refractive indices. Using a dry plate results 
in PathCheck Pathlength Measurement Technology normalized values that are 
lower than 1 cm cuvette values. Omitting the Background Constant results in 
values that have been normalized by the PathCheck Pathlength Measurement 
Technology and are higher than 1 cm cuvette values.

PathCheck Pathlength Measurement Technology and 
Interfering Substances

Any material that absorbs in the 900 nm to 1000 nm spectral region could 
interfere with PathCheck Pathlength Measurement Technology. Fortunately, 
there are few materials that do interfere at the concentrations typically used.
Turbidity is the most common interference. If you can detect any turbidity in 
your sample, you should not use the PathCheck Pathlength Measurement 
Technology. Turbidity elevates the 900 nm measurement more than the 
1000 nm measurement and causes an erroneously low estimate of pathlength.
Samples that are highly colored in the upper visible spectrum can have 
absorbance extending into the near infrared (NIR) and can interfere with the 
PathCheck Pathlength Measurement Technology. Examples include Lowry 
assays, molybdate-based assays, and samples containing hemoglobins or 
porphyrins. In general, if the sample is distinctly red or purple, you should 
check for interference before using the PathCheck Pathlength Measurement 
Technology. See Determining Color Interference on page 248.
Organic solvents could interfere with the PathCheck Pathlength Measurement 
Technology if they have absorbance in the region of the NIR water peak. 
Solvents such as ethanol and methanol do not absorb in the NIR region, so 
they do not interfere, except for causing a decrease in the water absorbance to 
the extent of their presence in the solution. However, if the solvent absorbs 
between 900 nm and 1000 nm, the interference would be similar to the 
interference of highly colored samples. If you are considering adding an 
organic solvent other than ethanol or methanol with the SpectraMax Paradigm 
Multi-Mode Detection Platform, you are advised to run a Spectrum scan 
between 900 nm and 1000 nm to determine if the solvent would interfere with 
the PathCheck Pathlength Measurement Technology. Spectrum scan is not 
available with the FilterMax Multi-Mode Microplate Readers.
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Determining Color Interference
To determine possible color interference, do the following:

1. Measure the OD at 900 nm and 998 nm (both measured with air 
reference).

2. Subtract the 900 nm value from the 998 nm value.
3. Do the same for pure water.

If the delta OD for the sample differs significantly from the delta OD for water, 
then it is advisable not to use the PathCheck Pathlength Measurement 
Technology feature.
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Mathematical Operators and Functions
Supported Mathematical Operators and Functions
The tables in this section describe the mathematical operators and functions 
that may be used in formulas:

• Table C-1 describes the mathematical and logical operators supported.
• Table C-2 describes the mathematical functions supported.

Note: In formulas where multiple parameters are configured, separate 
parameters with a semicolon; for example, max(S3;S5).

TableC-1 Mathematical and Logical Operators Table

Operator Description

+ Sums two numbers.

= Compares two expressions to determine if they are equal.

/ Divides two numbers and returns a numeric result.

<> Compares two expressions to determine if they are not equal.

> Compares two expressions to determine if one is greater than the 
other.

³ Compares two expressions to determine if one is greater than or 
equal to the other.

< Compares two expressions to determine if one is less than another.

£ Compares two expressions to determine if one is less than or equal 
to another.

* Multiplies two numbers.

- Performs subtraction of two expressions.

- Unary negation operator indicating the negative value of a numeric 
expression

AND Logical AND operator. Performs a logical conjunction on two 
expressions.

NOT Logical NOT operator. Performs logical negation on an expression.

OR Logical OR operator. Performs logical disjunction on two 
expressions.
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TableC-2 Mathematical Functions

Function Description

abs(number) Returns the absolute value of a number.

acos(number) Returns the arccosine of a number.

asin(number) Returns the arcsine of a number.

atan(number) Returns the arctangent of a number.

cos(number) Returns the cosine of a number.

exp(number) Returns e (the base of natural logarithms) raised to a 
power.

log(number) Returns the natural logarithm of a number.

max(num1;num2) Returns the greater of two supplied numeric 
expressions.

min(num1;num2) Returns the lesser of two supplied numeric 
expressions.

pow(base, exponent) Returns the value of a base expression taken to a 
specified power.

sin(number) Returns the sine of a number.

sqrt(number) Returns the square root of a number.

tan(number) Returns the tangent of a number.
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